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1. On the message compose screen, press Menu (right 
softkey) and select Slides > Organize Slides.

2. Do any of the following:
� Move a slide: Highlight the slide, press Menu (right 

softkey), and select Move Forward or Move Backward.

� Change display time for slides: Tap a black arrow 
beneath a slide to increase or decrease the duration. 
(The minimum duration is 2 seconds.)

� Insert slides: Press Insert (left softkey).

� Remove slides: Press Menu (right softkey) and select Delete.

3. Press OK .

Receiving a Text Message
When your phone is on and you are in a wireless coverage area, you automatically receive 
new text messages.

When a new message notification appears, select one of the following options:

� Reply (left softkey): Opens the message in chat view so you can view its full contents and 
reply to the sender (see “Using Messaging to Chat” on page 168).

� Menu (right softkey) > Delete: Deletes the new message.
� Menu (right softkey) > Call sender: Dials the sender’s phone number.
� Menu (right softkey) > Save as read: Puts the message in your SMS\MMS Inbox as read.
� Menu (right softkey) > Dismiss: Dismisses the notification and puts the message into your 

SMS\MMS Inbox as unread.

If you have multiple messages, the notification includes the number of messages. 
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Viewing a Text Message
To open a text message, do one of the following:

� Press Messaging  and select SMS\MMS. From the Inbox, select the message you want 
to view. 

� From a notification, select Reply. The message opens in chat view so you can view its full 
contents and reply to the sender (see “Using Messaging to Chat” on page 168).

� On the Today screen, select the SMS\MMS status line indicating an unread message.

Receiving a Multimedia Message
You can set your device to automatically download new multimedia messages or to notify 
you that messages are ready to download.

When a new message notification appears, select one of the following options:
� Dismiss (left softkey): Dismisses the notification and puts the message in your SMS\MMS 

Inbox as unread.
� View (right softkey): Opens the message in chat view so you can view its full contents and 

reply to the sender (see “Using Messaging to Chat” on page 168).

If you have multiple messages, the notification includes the number of messages. 

Viewing a Multimedia Message
1. To open a multimedia message, do one of the following:

� Press Messaging , select SMS\MMS, and then in the Inbox select Video Message 
(SMS\MMS) or Picture Message (SMS\MMS). The message opens in chat view, 
displaying the sender and subject.

� From a notification, select View (left softkey).
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� On the Today screen, select the SMS\MMS status line indicating an unread 
message, and then from the Inbox, select Video Message (SMS\MMS) or Picture 
Message (SMS\MMS). (The message opens in chat view, displaying the sender and 
subject.)

2. Select the message in chat view to view the full message with inserted images or files. 

3. With the message open, do any of the following:
� Forward the message: Press Menu (right softkey) and 

select Forward.

� Reply to the message: Press Menu (right softkey), 
select Reply, and then select a reply method: via 
Pics/Video or via SMS.

� View detailed information about the message: Press 
Menu (right softkey) and select Show > Message Detail.

� View detailed information about a recipient who is in 
your Contacts list: Press Menu (right softkey) and select Show > Contact Details.

� View detailed information about the attached file: Press Contents (left softkey), and 
then press Properties (left softkey). 

4. Press OK .

Tip Press Menu (right softkey) when you have a contact’s details displayed to 
see other options, like blocking future messages from this contact.

Tip Press Menu (right softkey) when you are viewing a message’s contents to 
see several other options, like saving the attached file with a new name

Did you know? When viewing a multimedia message containing multiple slides, you can 
press Right or Left on the 5-way to move to the next or previous slide.
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Using Messaging to Chat
When you exchange more than one message with a single contact, the messages you 
exchange with that person are grouped into a chat session. When you select a chat session 
from your message list, the upper part of the screen displays all messages you’ve exchanged 
with the contact, and the lower part provides a text entry area. 

1. Press Messaging .

2. Select SMS\MMS.

3. To start a new chat or continue an existing chat, select the 
message to which you want to reply. (The message opens 
in chat view.)

4. Enter your message. (You can use any of the menu 
commands described in “Creating and Sending a Text 
Message” on page 158.)

5. Press Send (left softkey).

6. If an incoming message has a file attached, it appears in 
the chat list with this icon: . (Select the message to open 
it and view the attachment.)

7. To close the chat session and return to the Inbox, press OK .

Note In the Inbox, all messages from a chat session are displayed as one item: a 
single conversation. To view individual messages within the conversation, 
select it to reopen the chat session.

Did you know? While chat view remains open, any new messages you receive from your 
chat partner appear directly on the screen; you do not get a new message 
notification.
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Using Links in Messages
When you receive a text message that contains a telephone number, email address, or URL, 
you can dial the number, send an email message, or go to the Web page immediately. Your 
device automatically opens the appropriate application from the link.

1. Open a message in the Inbox or another folder.

2. Use the 5-way to select the phone number, email address, or URL (appears as 
underlined blue text).

3. For phone numbers, confirm or change the number and press Call (left softkey).

If you receive a multimedia message that contains a phone number, email address, or URL, 
tap the item to open a menu of actions you can perform.

Adding a Contact From a Message
You can add a contact name, phone number, or email address to your Contacts list directly 
from a received message. You can either create a new contact or add the information to an 
existing contact.

1. In an open message or chat session, select the name, 
phone number, or address of the contact you want to add. 

2. Select Yes. 

3. Select <New Contact> to create a new contact entry for this 
name or address, or select an existing contact to add the 
name or address to that entry. 

4. Enter or edit the contact information. 

5. Press Save (left softkey). 
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Managing Your Messages

Message Status Icons
The status icons that appear next to each message in the Inbox and Outbox indicate 
the following: 

Deleting Messages
1. Go to the Inbox or other folder containing the message you want to delete.

2. Select one or more messages:
� To select one message: Press Up  or Down  to highlight it.

� To select all messages: Press Menu (right softkey) > Select Messages > All.

An SMS message, unread and read.

A high-priority SMS message (appears on right of screen).

Your reply to an SMS message.

An MMS message, unread and read. 

A high-priority MMS message, unread and read.

A low-priority MMS message, unread and read.

Tip Unread messages appear in bold. Messages you’ve read appear in 
plain text. 

Note If you highlight a conversation containing multiple messages, all of the chat 
messages are marked for deletion.
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� To select multiple consecutive messages: Press Up  or Down  to highlight the 
first message, and then press Menu (right softkey) > Select Messages > All Below.

� To select multiple messages: Press Up  or Down  to highlight the first message, 
press Menu (right softkey) > Select Messages > Several, and then select each 
message you want to delete.

3. Press Delete (left softkey).

4. Select Yes to confirm the deletion.

Messages you delete are moved to the Deleted Items folder. To remove these items from your 
device completely, press Menu (right softkey) and select Tools > Empty Deleted Items.

Sorting Your Messages
You can sort the messages in any folder. 

1. Go to the Inbox or other folder you want to sort.

2. Press Menu (right softkey) and select Tools > Sort By.

3. Select Message Type, From (sender), Received (date received), or Subject.

Customizing Your Messaging Settings

You can set options for both text and multimedia messages in the Messaging application. You 
can set options for all messages and for multimedia messages only.

Including a Callback Number With SMS Messages
1. Press Messaging .

2. Do one of the following:
� If the list of accounts is displayed: Highlight SMS\MMS and select Menu (right 

softkey) > Options.

� If the message list for a specific account is displayed: Press Menu (right softkey) 
and select Tools > Options.
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3. Highlight SMS\MMS and press Center .

4. Check the Always send a callback number box if you want 
text, picture, and video messages to automatically include 
your phone number. (The number of your phone is entered 
by default. You can enter another number.)

5. Press OK . 

Setting Picture and Video Message Options
1. Press Messaging .

2. Select SMS\MMS.

3. Press Menu (right softkey) and select Pics/Video Options.

4. On the Preferences tab, select any of the following:
� Disconnect from network after sending/receiving 

messages: Disconnecting from the network except 
when you are sending and receiving can reduce data 
service charges.

� Retrieval mode: Set whether to receive messages 

automatically or manually.

� Photo resolution: You can receive pictures at the 
resolution at which they are sent (original) or you can 
specify the resolution.

5. Select the Blacklist tab to view names and phone numbers that you have blocked. (To 
remove an entry from the blacklist, tap and hold on the entry with the stylus and select 
Delete.)

6. Press OK .
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Using Windows LiveTM

Windows Live is a set of services that combines online search features, email, and instant 
messaging:

� Live Search for Windows Mobile®: A search application that enables you to find local 
information such as movie times and traffic conditions (see “Searching the Web From 
Your Today Screen” on page 197).

� Windows Live Mail: The next generation of the Hotmail Web-based email application. 
Windows Live Mail offers more storage, greater message security, and easier filing of 
messages.

� Windows Live Messenger: An instant messaging application that enables you to see 
who’s online, to exchange instant messages (IM), to make calls to phones and computers 
(including video calls), and to exchange pictures and other files.

Setting Up Windows Live Mail

1. Press Start  and select Programs.

2. Select Windows Live .

3. Select Sign in to Windows Live.

4. The first time you sign in to Windows Live, press Accept (left 
softkey).

5. Enter your Windows Live, MSN, or Hotmail email address 
and password. (Check the Save password box if you want 
to have your password entered automatically every time 
you log in.)

Before You 
Begin

You must have an existing Windows Live, MSN, or Hotmail account to use 
Windows Live Mail. If you do not have an account, use the Web browser on 
your Treo Pro smartphone to go to mobile.live.com and follow the steps to 
set up an account.

http://www.mobile.live.com/hm
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6. Press Next (left softkey).

7. Set the following options:
� Uncheck the Live Search bar box to remove the Live 

Search bar from your Today screen. (It is present by 
default.)

� Check the Windows Live services box to have Windows 
Live Email, Windows Live Messenger, and Windows 
Live Sync appear on your Today screen.

8. Press Next (left softkey).

9. Select any of the following:

� Store Windows Live contacts in your mobile phone’s 
contact list: Sets whether you want your Windows Live 
contacts to appear in Contacts. (If you do not check this 
box, only your Windows Live email messages are 
synchronized with your device.)

� Merge duplicate contacts: Sets whether you want to 
merge any synchronized Windows Live contact with any 
duplicate contact that’s already in Contacts, so that 
there is only one entry for this contact. (If you leave the 
box unchecked, two entries appear for any duplicate 
entry in Contacts.)

� Sync e-mail: Sets whether you want to download your Windows Live Mail messages 
to your device (see “Using Windows Live Mail” on page 175).

10. Press Next (left softkey). (Synchronization of Windows Live Mail and contacts, if selected, 
takes place.)

11. After synchronization finishes, press Done (left softkey). (Your most recently received 
email message is displayed.)



Section 3C: Using Messaging 175

M
essaging

Using Windows Live Mail

1. Press Start  and select Programs.

2. Select Windows Live .

3. To synchronize email, contacts, and/or Windows Live Messenger information, press 
Right  or Left  until Sync is highlighted, and then press Center . (Information is 
synchronized for the applications you selected during setup.)

4. To read your email, do the following:

� With the same field highlighted, press Right  or Left  until Windows Live Hotmail 
appears.

� Press Center . (The Messaging application opens, displaying your Windows Live 
Hotmail Inbox. You can view, send, and work with messages in your Windows Live 
Hotmail account in the same way as with messages for any other account.)

Tip You can later change your Windows Live setup selections. Open Windows 
Live, press Menu (right softkey), and then select Options. Change which 
items appear on the Today screen or which applications sync, set up a sync 
schedule, and more.

Before You 
Begin

Make sure that your phone is on and that you’re inside a coverage area (see 
“Turning Your Phone On and Off” on page 34).

Did you know? You can also access your Windows Live Hotmail Inbox by opening the 
Messaging application and selecting your Windows Live Hotmail email 
account.

Tip You can set an option to have messages pushed to Windows Live Mail on 
your device as they arrive on the server. Open Windows Live, press Menu 
(right softkey), and select Options. Select Sync schedule, select the Sync 
frequency list, and then select As items arrive.
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Using Windows Live Messenger

1. Press Start  and select Programs.

2. Select Windows Live .

3. Highlight Messenger by pressing Right  or Left , and then press Center .

4. Press Sign in (left softkey).

5. If you have not already set up a Windows Live Mail 
account (see “Setting Up Windows Live Mail” on 
page 173), the first time you sign in to Windows Live 
Messenger, press Accept (left softkey).

6. If prompted, enter your Windows Live, MSN, or Hotmail 
email address and password.

7. To send an instant message to a contact who is 
online, highlight the contact name and press Send IM (left 
softkey).

Before You 
Begin

You must have an existing Windows Live, MSN, or Hotmail account to use 
Windows Live Messenger. If you do not have an account, use the Web 
browser on your Treo Pro smartphone to go to mobile.live.com and follow 
the steps to set up an account. Make sure that your phone is on and that 
you’re inside a coverage area (see “Turning Your Phone On and Off” on 
page 34).

http://www.mobile.live.com/hm
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8. Do any of the following: 
� Enter text: Highlight the text entry bar and enter your message text.

� Record a voice note: Press Voice clip (left softkey) and record a voice note by 
speaking clearly with your smartphone held up and facing you.

� Add an emoticon to your message: Press Menu (right softkey), select Add emoticon, 
and then select the emoticon you want.

� Add a picture or other file: Press Menu (right softkey), select Send, select the type of 
file you want to send, and then capture or select the picture or other file you want.

9. Press Send (left softkey).

10. (Optional) To exchange messages with more than one person, press Menu 
(right softkey), select Options > Add participant, and then select the participant you 
want to add.

11. To end the messaging session, press Menu (right softkey) and select End conversation. 
(If you are exchanging messages with more than one person, select End all 
conversations to stop all the sessions at once.)

Tip If the contact you want is offline, send an email message instead. Highlight 
the contact name and press Send e-mail (left softkey). Enter a subject and 
body text for the email message, and then press Send (left softkey).

Tip From the Messenger contacts list screen, press Menu (right softkey) and 
select options to add, block, or remove a contact; change your status to 
Busy, Away, and so on; add a display picture or personal message; and 
more.
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Setting Up and Using Instant Messaging

You can use the Instant Messaging application to set up your Treo Pro smartphone to work 
with multiple IM accounts at the same time. You can be online with and exchange instant 
messages with AOL, Yahoo, and Windows Live contacts without having to switch to different 
application screens. A tabbed interface makes it easy for you to switch between 
conversations.

Installing the Instant Messaging Application 
Before you can set up and use the Instant Messaging application, you must install it from the 
Web.

1. Press Start  and select Programs.

2. Select Instant Messaging .

3. Note the file name that appears on the next screen, and 
then select Save (left softkey).

4. Accept the defaults in the Name, Folder, and Type fields on 
the Save As screen. 

5. In the Location field, select Main memory.

6. Select Save. (The file is saved to the My Documents folder 
on your device.)

7. Press Option  + Start  to open the File Explorer application.

Before You 
Begin

Be sure your phone is on and you are in a coverage area (see “Turning Your 
Treo Pro Smartphone On and Off” on page 32).

Your account must include data services (see “Getting Started With Data 
Services” on page 114).
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8. Use the 5-way to scroll to the file named in step 3 and press Center . (The Instant 
Messaging application is installed, or if you have an expansion card in your device, you 
are prompted to choose an installation location.)

9. (Optional) Select Device if you are asked to choose a location to which to install Instant 
Messaging. 

10. Press OK  when you see the successful installation message. (The application is 
installed and starts automatically the next time you select Instant Messaging .)

Setting Up Your Instant Messaging Accounts
1. Press Start  and select Programs.

2. Select Instant Messaging .

3. Select Settings.

4. For each messaging service you want to use—America 
Online , Windows Live , or Yahoo —select the 
tab and enter the following information. (The Windows Live 
account screen appears first by default.)

� Your user name and password. (Your user name may 
be an email address, ID, or screen name, depending 
on the IM service.)
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� Check the Save Password box if you want to have your password entered 
automatically every time you sign in.

� Check the Auto Sign In box if you want to be signed in automatically every time you 
select the instant messaging account after you open Instant Messaging.

� Check the Enable Community box if you want to use the IM account at the same 
time as another account you set up. (At least one account must have Enable 
Community selected.)

� Check or uncheck the Auto Save Conversations box. (Press Down  to see this 
option.)

5. Press Menu (right softkey) and select Save.

6. When you have entered all your account information, press 
Back (left softkey).

7. Press Menu (right softkey) and select Settings or 
Preferences > Global Settings. (The menu may say 
Preferences instead of Settings, depending on which 
account you selected.)

8. For all IM accounts, enable or disable sounds and 
background IM alerts and select the network to connect 
with.

9. Press Back (left softkey).

10. Press OK .
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Signing In To and Using Instant Messaging Accounts
1. Press Start  and select Programs.

2. Select Instant Messaging .

3. Select an instant messaging service for which you have set 
up an account: America Online , Windows Live , or 
Yahoo . (If you selected Automatic Sign-In during setup, 
the sign-in process continues automatically.)

4. Enter your user name and password, if required.

5. (Optional) Check the Save Password box if you do not want 
to enter your password each time you sign in.

6. (Optional) Check the Automatic Sign-In box if you want to sign in automatically every 
time you select the instant messaging account.

7. Press Sign In (left softkey).

8. If you set up more than one instant messaging account, 
select the tab for each account you want to sign in to, enter 
your user name and password, and press Sign In (left 
softkey).

9. Press Menu (right softkey) and select menu items to 
perform IM functions in the account you are using. (The 
menu items vary slightly from one account type to the next.)

10. Press Menu (right softkey) and select Help to get 
information about using the Instant Messaging application.

11. To switch between accounts, press Left  and Right  on 
the 5-way.

12. To sign out, press Menu (right softkey) and select Sign Out or Sign Out all and exit.
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Changing Instant Messaging Community and Global Settings 
1. Press Start  and select Programs.

2. Select Instant Messaging .

3. Select an instant messaging service for which you have set 
up an account: America Online , Windows Live , or 
Yahoo .

4. Press Menu (right softkey) and select Settings or 
Preferences > Community Settings. (The menu may say 
Preferences instead of Settings, depending on which 
account you selected.)

5. Change settings as required and press Back (left softkey). Select Yes to confirm your 
changes. (Press Down  to see the Auto Save Conversations option.)

6. Press Menu (right softkey) and select Settings or Preferences > Global Settings.

7. Change any of the settings as required and press Back (left softkey). (Select Yes to 
confirm your changes.)
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Browsing the Web

Sect ion 3D

In This Section

� Viewing a Web Page

� Working With Favorites

� Working With Web Pages

� Customizing Your Internet Explorer® Mobile Settings

� Using WorldMate Pro

� Using Kinoma FreePlay

� Searching the Web From Your Today Screen

To browse the Web, you must activate data services (see “Enabling Data Services” on 
page 114), or you must establish a connection to a Wi-Fi network (see “Connecting to a Wi-Fi 
Network” on page 204).

Internet Explorer® Mobile provides quick and easy access to Web pages. You can view most 
of the sites you use on your computer, including those with security and advanced features, 
such as JavaScript and frames. Internet Explorer Mobile supports JavaScript, Secure Sockets 
Layer (SSL), and cookies, but does not support plug-ins such as Shockwave or Java applets.
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Viewing a Web Page

By default, Internet Explorer Mobile scales Web page content to fit your smartphone screen so 
that you can view most of the information without scrolling left or right.

1. Make sure that your phone is on (see “Turning Your Phone 
On and Off” on page 34).

2. Press Start  and select Internet Explorer. (If your Today 
screen is displayed, press Internet [right softkey] to open 
Internet Explorer).

3. Highlight the address line, enter the address of the 
Web page you want to view, and then press Center . 
(If you browse to a secure Web page, the Lock icon in 
the address line appears closed instead of open.)

Note For additional information on features supported by Internet Explorer 
Mobile, visit microsoft com.

Did you know? You can start a Web search from your Today screen by selecting the Live 
Search field, entering the item you want to find, and then pressing Center 
on the 5-way. In Internet Explorer Mobile, you can start a search by 
entering an item in the address bar and pressing Center.

http://www.microsoft.com
http://www.microsoft.com
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4. Press Menu (right softkey) and select Zoom Out to view the 
entire Web page in zoom view and choose the area you 
want to view on your Treo screen:

� Press Zoom Out (left softkey) and Zoom In (right softkey) 
to change the zoom as necessary.

� Press Up , Down , Left , and Right  in zoom 
view to move the rectangle around the screen. (It shows 
how much you can see on your Treo screen in the 
default reading view.)

� Press Center  to return to reading view showing the area you have defined. (You 
can also tap the screen with the stylus to return to the default view.) 

5. Press Menu (right softkey), select View, and then select any of the following:
� Text Size: Set the size of the text displayed for Web pages.

� Full Screen: Hide the title bar and toolbar and fill the entire screen with the contents 
of the Web page. 

� Mobile: Your smartphone tells the Web server that it is a mobile device so that the 
Web server provides content that is more suitable for display on a mobile device. 

� Desktop: Keeps the same layout and size as on a desktop computer, which requires 
both horizontal and vertical scrolling.

6. Do any of the following to move between Web pages:

� To view the previous page, press Back (left softkey) or Backspace .

Tip To exit full screen, tap and hold the stylus on the screen to display the 
menu, and then select Full Screen again to turn it off.

Tip Use Desktop view for Web sites that contain video and Flash content.
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� To move forward a page, press Menu and select Forward.

� To refresh the page with the latest content from the Internet, press Menu (right 
softkey) and select Refresh.

7. Do either of the following to scroll or pan within a Web page:

� Press and hold Up  or Down , Left , and Right  to scroll in all directions.

� Touch the stylus to the screen and drag it in any direction to reposition the page 
view. (You may find that you can do this just as easily by dragging your thumb 
around the screen.)

8. To follow a link to another Web page, press Up  or Down  to highlight the link, and 
then press Center  to go to the selected page. (You can also tap the link on the 
screen with your stylus.)

9. To send a link, press Up  or Down  to highlight the link, select Menu (right softkey) 
and select Tools > Send Link. (Select the account you want to use to send it. A new 
message opens containing the link. Simply address the message and send.) 

10. To view a Web page’s properties, press Menu (right softkey) and select 
Tools > Properties.

11. To view each item in a list, tap the list with your stylus. In a list, press Down  or Left  
to cycle between items, and press Center  to make a selection.

Tip An arrow cursor appears on the screen when you are scrolling. It changes 
to a hand when it moves over a hyperlink.

Did you know? You can send email from a Web page. Email addresses appear as links on 
Web pages. After you configure an email application on your Treo Pro 
smartphone, you can select an email link to create a message to send to 
that address.
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12. In a form, such as a browser search field, press Center  to interact with the form, and 
then press Center  to stop interacting with the form.

13. Press OK  to close Internet Explorer Mobile.

Working With Favorites

Favorites lets you bookmark a Web page so that you can instantly access it without entering 
the Web address. If you set up synchronization with the desktop sync software, your favorites 
synchronize by default. 

Tip To return to a recently viewed page, select the address line list, press Down 
to the address you want, and then press Center to select it.

Did you know? The security certificates and 128-bit SSL strong encryption let you browse 
secure sites, such as online shopping, banking, and email. Remember that 
some secure sites also require specific browsers and may not work with 
Internet Explorer Mobile. Ask the organization for an alternate Web address 
(URL) that is compatible with Internet Explorer Mobile.

Did you know? To get favorites from the Web browser on your computer into the Web 
browser on your Treo™ Pro smartphone by Palm, just add them to the 
Mobile Favorites folder, which shows up in your computer’s browser. When 
you sync, they become available on your smartphone as well. Backup 
copies of any favorites that you add on the smartphone browser are also 
stored in the Mobile Favorites folder.
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Creating a Favorite

1. Go to the page you want to mark as a favorite. 

2. Press Menu (right softkey) and select Add to Favorites.

3. (Optional) Select Name and enter a different description.

4. (Optional) Select Create in and select the folder where you 
want to create the favorite.

5. Press Add (left softkey).

Viewing a Favorite
1. Press Start  and select Internet Explorer.

2. Press Favorites (left softkey).

3. Press Down  to highlight the page you want to view in the list, and then press 
Center .

Organizing Your Favorites
You can create folders for organizing your favorites. For example, you can store travel links in 
one folder, stock links in another, and business links in a third folder.

Before You 
Begin

Create the folders where you want to store your favorites. Once you create a 
favorite, you can’t move it to another folder.

Note If Internet Explorer is already running and you have visited Web pages, the 
left softkey may say Back, not Favorites. In this case, to view favorites, press 
Menu (right softkey) and select Favorites.
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1. Press Start  and select Internet Explorer.

2. Press Favorites (left softkey).

3. Press Menu (right softkey) and select New Folder.

4. Enter a name for the folder and press Add (left softkey). 

The new folder appears at the top of your Favorites list. When you create a new favorite, the 
folder is available in the Folder list on the Add Favorite screen. You cannot move existing 
favorites into a new folder.

Working With Web Pages

Downloading Files and Images From a Web Page
You can download files that are usable on your Treo Pro smartphone, such as new 
applications, MIDI ringtones, or pictures that are specifically tagged for download. 

1. Go to the page that contains the link to the item you want to download.

2. Do either of the following: 

� To download a file, highlight the link to the file, press Center , and then select 
Save Target As.

� To download an image, tap and hold the image and select Save Image As.

3. Fill in the fields of the Save As screen.

4. Select Save.

Note If Internet Explorer is already running and you have visited Web pages, the 
left softkey may say Back, not Favorites. In this case, to view favorites, press 
Menu (right softkey) and select Favorites.
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Copying Text From a Web Page
You can copy text from a Web page and paste it into Office Mobile applications. 

1. Press Menu (right softkey), select Copy/Paste, and then select Make Selection.

2. Use the stylus to highlight the text you want to copy.

3. Press Copy (left softkey).

4. Open an Office Mobile file into which you want to paste the text.

5. Select the location for the text, press Menu (right softkey), and select Paste. 

Using the History List
The History list stores the addresses of the pages you visited recently.

1. Press Menu (right softkey) and select History. 

2. Select the Web page you want to view, or press Cancel (right softkey) to close the 
History list. 

Customizing Your Internet Explorer® Mobile Settings

1. Press Menu (right softkey) and select Tools > Options. 

2. On the Options screen, select the option category you want to change.

3. Select Home Page and set any of the following: 
� Default Home page: Sets the home page to the Internet Explorer Mobile 6 home 

page.

� Current page: Sets the home page to the page currently displayed in Internet 
Explorer Mobile.

Tip For information on clearing the History list, see the next section, 
“Customizing Your Internet Explorer® Mobile Settings.”
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� Custom page: Enter the address of the page you want to be your home page.

4. Select Privacy and Security and set any of the following 
options. (Press Done [left softkey] when you have finished.)

� Enable scripts: Sets whether Internet Explorer Mobile 
runs scripts on the pages you visit.

� Enable cookies: Sets whether Internet Explorer Mobile 
accepts cookies.

� Warn when changing to an unsecured page: Sets 
whether a message appears when you switch from a 
secure page to one that is not secure.

5. Select Languages and set any of the following options. 
(Press Done [left softkey] when you have finished.)

� Preferred language to read websites: Sets the 
language used to display Web pages and address bar 
text. 

� Encoding: Defines the character set to be used to 
display Web pages.

� Auto-Select: Enables Internet Explorer Mobile to try to 
determine language encoding information when a Web 
site does not include it.
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6. Select Other and set any of the following options. (Press 
Done [left softkey] when you have finished.)

� Mobile Device: Your smartphone tells the Web server 
that it is a mobile device so that the Web server 
provides content that is more suitable for display on a 
mobile device.

� Desktop Computer: Web sites are displayed as created 
for viewing with a desktop computer.

� Play Sounds: Allow Web sites you visit to play sounds.

� Show Pictures: Display pictures on Web sites. (Web 
pages will display faster if this option is turned off.)

7. Press Close (right softkey).

Tip Most of the time you can use Auto-Select and let Internet Explorer Mobile 
determine a Web site’s language and character set encoding. If it does not 
and you know the language, use the Preferred language and Encoding 
options to set them manually.

To change the language of menus and buttons, you need to install a version 
of Internet Explorer Mobile written in the language you prefer.
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Clearing Internet Explorer Mobile Files

1. Press Menu (right softkey) and select Tools > Options. 

2. On the Options screen, select Browsing History.

3. Select one of the following types of files and press Clear 
(right softkey). (Press Done [left softkey] when you have 
finished.) 

� Temporary Files: Removes saved pages and Web files 
that you viewed or synchronized with your computer.

� Cookies: Deletes stored cookies. (Cookies are small 
files containing information about your identity and 
preferences. A Web page sends the file and stores it on 
your smartphone.)

� History: Empties the History list.

4. Press Close (right softkey).

Using WorldMate Pro

With WorldMate Pro, you can gain access to your travel itinerary details, global weather 
forecasts, world clocks, currency, clothing size and measurement converters, a tip and tax 
calculator, and more. 

Before You 
Begin

Be sure your phone is on and you are in a coverage area (see “Turning Your 
Treo Pro Smartphone On and Off” on page 32).

Your account must include data services (see “Getting Started With Data 
Services” on page 114).



194 Section 3D: Browsing the Web

Installing WorldMate Pro
Before you can set up and use WorldMate Pro, you must install it from the Web:

1. Press Start  and select Programs.

2. Select Get WorldMate .

3. Follow the onscreen instructions to download and install the software.

Using WorldMate Pro Travel Information and Tools
1. Press Start  and select Programs.

2. Select WorldMate Pro .

3. Press Next (left softkey).

4. The first time you open the application, press Accept (left 
softkey).

5. Enter your email address, and then enter it again to confirm 
it.

6. Make up and enter a password of your choice. (This does 
not need to be your email account password.)

7. Press Submit (left softkey).

8. Select the city nearest to your home city.

9. Press Next (left softkey).

10. Select any of the WorldMate features: Weather Center, Flight Center, My Itinerary, Travel 
Tools, or Converters. 

Note For each feature, some options are available to WorldMate Professional 
subscribers only. WorldMate Professional is a paid service. To subscribe, 
select Go Pro.
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Using Kinoma FreePlay

Kinoma FreePlay is a mobile media browser that you can use to find and play video, audio, 
and pictures on your Treo Pro smartphone. You can use Kinoma FreePlay to share YouTube 
clips, catch breaking news updates from Reuters, view hundreds of webcams and traffic 
cameras built into Kinoma Guide, or tune into your own kid-cam or pet-cam. 

Kinoma Guide is a constantly updated guide to mobile-ready content on the Web. You’ll have 
on-demand access to thousands of podcasts, music, audiobooks, and more. There is no 
monthly subscription fee for Kinoma FreePlay, but you must activate Kinoma FreePlay before 
you can use it. Kinoma Freeplay must be activated before you can view YouTube Videos  or 
listen to the audio version of the Wall Street Journal , both available under Programs.

You can purchase Kinoma Play to get additional features such as support for iTunes and 
automatic uploads to YouTube. Check out kinoma.com for more information.

Tip From any screen, press Menu (right softkey) and select Options to set the 
interval for automatically updating weather and other information, set the 
temperature display format, and set whether to automatically preview your 
itinerary.

http://www.kinoma.com/play
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To activate Kinoma FreePlay:

1. Press Start  and select Programs.

2. Select Kinoma FreePlay .

3. Enter the email address you want to associate with the 
account.

4. (Optional) Select View to read the license agreement. 

5. Check the I accept the License Agreement box.

6. Select Activate. A message informs you that an email has 
been sent to the address you entered.

7. Select Exit.

8. When the email arrives, open it and click the link indicated to activate your account.

9. Open Kinoma FreePlay again. 

Note Each time you open Kinoma FreePlay, it scans your smartphone to index 
your media files. You can view any of your media files by selecting My 
Media Files. Kinoma Guide is also continually updated.
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Searching the Web From Your Today Screen

Use the Live Search bar to search the Internet for images, news articles, maps, and other 
specific types of content related to the search topic. The Live Search bar appears on the 
Today screen.

1. Make sure your that your phone is turned on and you are 
inside a coverage area (see “Turning Your Phone On and 
Off” on page 34).

2. Go to your Today screen. 

3. Select the Live Search field and enter the word or phrase 
you want to find.

4. Press Search (left softkey).

5. Use the 5-way to scroll through the results and do any of 
the following:

� To see images related to the text that you entered, scroll to and select Images.

� To search the Internet for the text that you entered, scroll to and select Web.

� To see news articles related to the text that you entered, scroll to and select News.

� To see a list of Windows Mobile Spaces that contain information related to the text 
that you entered, select Spaces.

� To see a map of the area related to the text that you entered, scroll to and select 
Map.
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Using GPS Navigation

Sect ion 3E

In This Section

� Using Sprint Navigation

� Setting Up an External GPS Device
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Using Sprint Navigation

Sprint Navigation is a GPS navigation system that gives you turn-by-turn directions by map 
and by voice right from your Treo™ Pro smartphone by Palm. Get audible GPS directions for 
an appointment, a sales call, or even a coffee shop close by. If Sprint Navigation is not 
included in your service plan, contact Sprint for information about daily or monthly 
subscription rates for the service. 

1. Press Start  and select Programs.

2. Select Sprint Navigation .

3. Follow the onscreen prompts to download the software and establish a subscription.

4. After you set up a subscription, and your account is verified, press Go (right softkey) to 
continue. 

5. Use the 5-way to select the icon that best describes what 
you want to do:

� Drive To: Get turn-by-turn driving instructions to a 
specific location.

� Maps & Traffic: View a map and traffic information for 
your current location or another location of your choice.

� Search: Locate nearby services, such as the least 
expensive gas station in the area or the closest bank or 
ATM. 

Before You 
Begin

Make sure that your phone is on and you are inside a coverage area (see 
“Turning Your Phone On and Off” on page 34). 

Make sure that location privacy is on (see “Selecting Your Location Privacy 
Setting” on page 99).
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� Tools & Extras: Set Sprint Navigation options and access other tools. For example, 
you can view a compass and assign your current location a name, such as Home.

Setting Up an External GPS Device

If you have a global positioning system (GPS) receiver, your Treo Pro smartphone can show 
your exact location on a map. (See palm.com for compatible GPS receivers.) The External 
GPS settings do not affect the built-in GPS features of your device. Refer to the documentation 
that came with your GPS receiver for detailed setup instructions, which may include installing 
software on your smartphone. The following steps describe how to set up your smartphone to 
work with an external GPS device. 

1. Press Start  and select Settings.

2. Select the System tab, and then select External GPS .

3. On the Programs tab, select the GPS program port list, and then select the port for 
applications to use to access GPS information. (This port must also be selected in your 
GPS application’s configuration settings.)

4. Select the Hardware tab.

5. Select the GPS hardware port list, and then select the port to which your GPS receiver is 
connected. (This must be a different port from the one you set in step 3 as your program 
port. To connect to the GPS device using Bluetooth® wireless technology, you must first 
set up a partnership between the two devices. See “Setting Up a Bluetooth Connection” 
on page 214.)

Tip Sprint Navigation requires signals from GPS satellites. For optimum 
performance, use Sprint Navigation outdoors or close to a window. The 
satellite signal is diminished when your Treo Pro smartphone is indoors. 
Also, hold the bottom portion of your device to avoid blocking the internal 
antenna, which is located in the upper third of the device.

http://www.palm.com
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6. Select the Access tab and check the Manage GPS automatically box. (This setting lets 
more than one application simultaneously access your GPS information.)

7. Press OK .

Note The External GPS settings described in this procedure do not affect Sprint 
Navigation.
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Using Wireless Connections

Sect ion 3F

In This Section

� Connecting to a Wi-Fi Network

� Connecting to Devices With Bluetooth® WirelessTechnology

� Beaming Information

� Using Comm Manager to Turn Wireless Services On and Off
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Connecting to a Wi-Fi Network

Many environments, such as corporate offices, coffee shops, airports, and libraries, offer 
access to a Wi-Fi network. A Wi-Fi network is a wireless local area network (WLAN) that is 
based on the 802.11b/g standard. When you’re within range of an accessible Wi-FI network, 
you can use the Wi-Fi feature of your Treo™ Pro smartphone by Palm to connect to that 
network and access the Web.

Why Use a Wi-Fi Connection?
A Wi-Fi connection is especially helpful in the following situations:

� You’re outside a coverage area and you want to access the Web.
� Your Sprint service plan incurs additional charges for data services and you 

want to minimize data service charges by using a Wi-Fi connection instead. 
� You’re inside a coverage area but outside a Sprint Mobile Broadband Network. 

(A Wi-Fi connection may provide faster throughput than a 1xRTT data connection.)
� You want to maintain a Web connection while talking on the phone.

Note You can use a Wi-Fi connection for scheduled synchronization with an 
Exchange server, taking advantage of Microsoft Direct Push technology for 
wireless synchronization.
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Are There Different Types of Wi-Fi Networks?
There are two types of Wi-Fi networks:

� Open networks: These networks broadcast their name (SSID) and do not require you to 
enter a password or other settings. To learn how to connect to an open network, see 
“Connecting to an Open Network” on page 206.

� Secure networks: These networks may broadcast their name, but at the very least, they 
may also require you to enter a password that you get from a system administrator. 
Secure networks may also require you to get other network settings from the system 
administrator and enter them during setup. To learn how to connect to a secure network, 
see “Connecting to a Secure Network” on page 207. If you’ve already set up a connection 
to a secure network and want to reconnect to it, see “Connecting to an Open Network” on 
page 206.

Turning the Wi-Fi Feature On and Off
� To turn Wi-Fi on, press Wi-Fi  (on the side of your smartphone near the stylus slot). 
� To turn Wi-Fi off, press and hold Wi-Fi .

When Wi-Fi is on, your Today screen displays Wi-Fi: On.

Key term Wi-Fi access point Also called a hotspot. A network device with an antenna 
that provides wireless connections to a larger network.

Tip By default, when your screen turns off, the Wi-Fi feature turns off to save 
power. Wi-Fi does not turn back on automatically when your screen turns 
back on. You can adjust the Wi-Fi settings to keep Wi-Fi on all the time. See 
“Customizing Wi-Fi Settings” on page 211.
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Wi-Fi Status Icons
The Wi-Fi icon on your Today screen indicates the status of the Wi-Fi feature.

Connecting to an Open Network
You can connect to an open network or to a secure network for which you have already set 
up a connection. If you have access to multiple Wi-Fi networks, you can select which network 
you want to connect to.

1. Press Wi-Fi  on the side of your smartphone. What 
happens next depends on the state of Wi-Fi before you 
pressed the button: 

� Wi-Fi was already on: Your smartphone scans for 
available networks and automatically connects when 
possible. If your device does not automatically connect 
and the Configure Wireless Networks screen appears, 
highlight the network you want, and press Connect (left 
softkey).

The Wi-Fi feature on your smartphone is turned on, but you are not connected to a 
Wi-Fi network.

You have a Wi-Fi notification waiting. For example, if Wi-Fi is turned on and you are 
not within range of a preferred network, you can tap this icon to view available 
networks.

Your smartphone is connected to a Wi-Fi network, and you are actively in the 
process of connecting or you are connected and are transmitting data. 

Note The WEP (wired equivalent privacy) encryption method is enabled by default 
and may interfere with your ability to connect to a network that broadcasts 
its name. See “Connecting to a Secure Network” on page 207 to learn how 
to disable WEP encryption.
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� Wi-Fi was off: A notification appears, listing up to three available networks. If the 
network you want appears, highlight it and press OK (left softkey) to connect. If the 
network you want does not appear, select Show all networks, highlight the network 
you want, and press Connect (left softkey).

2. When the connection message appears, press Dismiss (right softkey).

Some locations, such as airports and coffee shops, provide an open network but charge a 
fee to use it. After you connect your smartphone to the network, you need to open Internet 
Explorer Mobile and register with the Wi-Fi service provider before you can check email or 
browse the Web.

Connecting to a Secure Network
To set up a connection to a secure network, do the following:

1. Press Wi-Fi  on the side of your smartphone. What happens next depends on the 
state of Wi-Fi before you pressed the button: 

� Wi-Fi was already on: Your smartphone scans for available networks and 
automatically connects when possible. If your device does not automatically 
connect and the Configure Wireless Networks screen appears, highlight the network 
you want, and press Connect (left softkey), or select Add New.

Tip To dismiss the notification without connecting to a network, press Menu 
(right softkey) and select Dismiss. To turn off the notification feature, press 
Menu (right softkey) and select Don’t show this message again. You can 
turn the feature back on later (see “Customizing Advanced Wi-Fi Settings” 
on page 213).

Tip Narrow the list of networks that appear on the Configure Wireless 
Networks screen by selecting Networks to access and then selecting Only 
access points or Only computer-to-computer.
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� Wi-Fi was off: A notification appears, listing up to three available networks. If the 
network you want appears, select it and press OK (left softkey) to connect. If the 
network you want does not appear, select Show all networks, highlight the network 
you want, and press Connect.

2. On the Configure Wireless Networks screen, enter the following settings, and then press 
Next (right softkey):

� Network name: If this field is blank, enter the SSID 
provided by the system administrator. (This field is case 
sensitive.)

� Connects to: Set whether this network connects to the 
Internet or to Work. (You may need to select Work to 
access a corporate intranet.)

� This is a hidden network: If you had to enter the 
network name, this is a hidden network. (Check this 
box to connect to this network now and in the future.)

� This is a device-to-device (ad-hoc) connection: Leave 
this box unchecked if you’re connecting to a network (Wi-Fi access point). (Check 
this box only if you’re connecting to another device.)

Note As you continue with this procedure, depending on the selections you 
make, some screens are not displayed, and you can skip those steps.
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3. Enter the following settings, and then press Next (right softkey):
� Authentication: Set the method used to identify 

devices that connect to the network:

� Open: The network uses open authentication.

� Shared: The network uses shared authentication.

� WPA: The network is a WPA network that uses 
802.1x protocols.

� WPA-PSK: The network is a WPA network that 
requires a password that is shared between the 
network and your Treo Pro smartphone. (This 
password is also known as a pre-shared key [PSK].)

� WPA2: The network provides government grade security with an AES 
encryption algorithm.

� WPA2-PSK: The network is a WPA2 network that requires a pre-shared key.

� Data Encryption: Set the encryption method. (The options in this list vary based on 
your Authentication setting.)

� Disabled: Turn data encryption off.

� WEP: Turn on the Wired Equivalent Privacy encryption method.

� TKIP: Turn on the Temporal Key Integrity Protocol encryption method. (This 
method is often used to encrypt WPA and WPA-PSK connections.)

� AES: Turn on the Advanced Encryption Standard protocol. (This method is often 
used to encrypt WPA, WPA-PSK, WPA2, and WPA2-PSK connections.)

� The key is automatically provided: Set whether you need to specify the network key 
and key index provided by your system administrator, or whether the network 
provides this information. (The availability of these options varies based on your 
Authentication and Data Encryption settings.)
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� Network key: Enter the Network key provided by your system administrator, if it is not 
automatically provided by the network. (The availability of this option varies based 
on your Authentication and Data Encryption settings.)

� Key index: Enter the Key index provided by your system 
administrator, if it is not automatically provided by the 
network. The availability of this option varies based on 
your Authentication and Data Encryption settings.

4. Enter the following settings, and then press Finish 
(right softkey):

� Use IEEE 802.1x network access control: Set these 
parameters if required by the network.

� EAP type: Set the Extensible Authentication Protocol 
type.

5. Press OK .

Disconnecting From a Wi-Fi Network
To disconnect from a Wi-Fi network, do one of the following: 

� To save any settings you entered, press and hold Wi-Fi  to disconnect from the Wi-Fi 
network. (The next time you’re within range and the Wi-Fi feature is turned on, your 
Treo Pro smartphone automatically connects to this network.)

� To save any settings you entered, you can also tap the Wi-Fi  icon, select Comm 
Manager, and tap Wi-Fi OFF.

� Press Start , select Settings, select the Connections tab, and then select Wi-Fi . 
Highlight the network from which you want to disconnect, and then press Menu (right 
softkey) and select Turn Off Wi-Fi.

Note If you also need to create a custom security certificate, see “Customizing 
Wi-Fi Settings” on page 211 for instructions.
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� To remove the network settings from memory, from the Configure Wireless Networks 
screen, press Menu (right softkey) and select Remove Settings. (The next time you’re within 
range and the Wi-Fi feature is turned on, you must re-create the connection to connect to 
this network.)

Customizing Wi-Fi Settings
1. Press Start  and select Settings.

2. Select the Connections tab, and then select Wi-Fi Prefs . (The Main and Advanced 
tabs show the status of the Wi-Fi feature and display information about an active Wi-Fi 
connection.)

3. Select the Power Mode tab and set any of the following:
� Power Save Mode: Adjusts power consumption 

between maximizing network connection performance 
and maximizing battery life.

� Connection: Sets when the Wi-Fi feature is on and 
when your device attempts to search for networks.

� On button press: Leaves the Wi-Fi feature off until 
you press Wi-Fi  to turn it on. (After you turn the 
Wi-Fi feature on, your smartphone searches for 
available networks. If a network to which you previously connected is available, 
your smartphone automatically connects to that network.)

� Always On: Leaves the Wi-Fi feature on, and your smartphone searches for 
available networks whenever the screen is awake. (If a network to which you 
previously connected is available, your smartphone automatically connects to 
that network. When this mode is enabled, you can prevent your device from 
searching for networks by pressing and holding Wi-Fi  to turn the Wi-Fi 
feature off.)
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4. Select the LEAP tab and do any of the following:
� Create a new LEAP entry: Select New. (A LEAP entry is 

a security feature that protects the WEP key.)

� Modify an existing entry: Highlight the entry and select 
Modify. (Enter the new information.)

� Delete an entry: Highlight the entry and select Delete.

5. Select the Enroll tab and set any of the following:
� User: Specifies your user name for this Wi-Fi network.

� Password: Specifies the password associated with the 
user name you specified on this screen.

� Server: Specifies the name of the Internet Information 
Server (IIS) that stores the security certificate 
information for this Wi-Fi network. 

� Retrieve Certificate: Obtains a certificate based on the 
information you entered.

6. Press OK .

Note Ask your network administrator for the user name, password, and server 
name for the Wi-Fi network you want to access.
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Customizing Advanced Wi-Fi Settings
1. Press Start  and select Settings.

2. Select the Connections tab, and then select Wi-Fi .

3. On the Wireless tab, press Menu (right softkey) and select 
Advanced.

4. Select either of the following:
� Turn on available network notification: Sets whether a 

list of networks appears when you turn on the Wi-Fi 
feature.

� Turn off Wi-Fi if not connected in: Sets the time interval 
for turning off the Wi-Fi feature if your device does not 
connect to a network.

5. Press Save (right softkey).

6. Press OK .

Customizing Network Adapter Settings
1. Press Start  and select Settings.

2. Select the Connections tab, and then select Wi-Fi .

3. Select the Network Adapters tab and set any of the 
following:

� My network card connects to: Sets the default network 
connection type for your device: Work or The Internet.
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� Tap an adapter to modify settings: Lets you edit network adapter information. Select 
the adapter you want, and then select either of the following tabs:

� IP Address: Sets whether the server assigns an IP 
address, or whether you enter a specific IP 
address. 

� Name Servers: Lets you enter the addresses of 
primary and alternate DNS and WINS servers.

4. Press OK .

Connecting to Devices With Bluetooth® WirelessTechnology

With the Bluetooth® wireless technology feature of your Treo Pro smartphone, you can 
connect to a number of Bluetooth devices, such as a headset, printer, other phones and 
handhelds, and more. For a list of hands-free devices with Bluetooth wireless technology that 
are compatible with your smartphone, go to palm.com/support.

If your computer is enabled with Bluetooth wireless technology, you can also synchronize 
wirelessly.

Setting Up a Bluetooth Connection
After you set up a connection with a Bluetooth device, you can communicate with that device 
whenever it is within range and the Bluetooth feature on your smartphone is turned on. 
Bluetooth range is up to 30 feet (10 meters). Performance and range are affected by physical 
obstacles, radio interference from nearby electronic equipment, and other factors. 

http://www.palm.com/support
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1. If necessary, prepare the device you want to connect with to 
accept a new connection. (Check the device’s 
documentation for details.)

2. Go to your Today screen.

3. Press Start  and select Settings.

4. Select the Connections tab and then select Bluetooth .

5. Select the Mode tab and check the Turn on Bluetooth box to 
turn on the Bluetooth feature on your Treo Pro smartphone. 
(Wait about 10 seconds for the Bluetooth feature to 
activate.)

6. If you’re setting up a connection with a computer, check the Make this device visible to 
other devices box.

7. Select the Devices tab, and then select Add new device.

8. Wait for your Treo Pro smartphone to search for devices and to display the device list.

9. Select the device you want to connect with, and then press Next (right softkey). (If the 
device you want does not appear, select Refresh.)

Did you know? You can also turn the Bluetooth feature on and off from your Today screen. 
Select Sprint or Phone off to open Comm Manager, select Bluetooth, and 
then press Exit (left softkey).

Tip To prevent unwanted devices from connecting to your Treo Pro smartphone, 
leave the Make the device visible to other devices box unchecked except 
when you’re connecting with a computer or receiving information from 
another device.
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10. If you’re prompted to enter a passkey, enter the same passkey on your smartphone and 
on the other Bluetooth device, and then press Next (right softkey).

11. Press Done (left softkey), and then press OK .

You can now communicate with this device whenever it is within range and the Bluetooth 
feature on your smartphone is turned on. The range varies greatly, depending on 
environmental factors. The maximum is about 30 feet (10 meters).

Important Some Bluetooth devices have a predefined passkey. If your Bluetooth 
device has a predefined passkey, your Treo Pro smartphone attempts to 
enter the passkey for you. If the attempt is unsuccessful, you can find the 
predefined passkey in the documentation for your Bluetooth device. Many 
Bluetooth headsets use the default passkey 0000.

Other Bluetooth devices provide a screen where you enter a passkey that 
you make up. In either case, you must use the same passkey on both your 
Treo Pro smartphone and the Bluetooth device. We recommend that, where 
possible, you make up a passkey of 16 alphanumeric characters (letters and 
numerals only) to improve the security of your smartphone. The longer the 
passkey, the more difficult it is for the passkey to be deciphered.

Tip To modify or delete an established partnership with a device, go to the 
Bluetooth Settings screen and select Devices. Highlight the connection 
you want to change or remove, press and hold Center on the 5-way, and 
then select Edit or Delete. A deleted device can no longer automatically 
connect with your Treo Pro smartphone.
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Sending Information Over a Bluetooth Connection
You can send an individual entry or file.

1. Make sure the receiving device is ready to receive a 
Bluetooth connection.

2. Highlight the entry or file you want to send.

3. Press Menu (right softkey) and select Beam. (If you don’t 
see a Beam command, select Send… > Beam instead. 
The Beam and Send menu items change names based on 
the type of item you highlighted.)

4. Select the receiving device in the list.

When the transmission is complete, Done appears next to the name of the receiving device.

Receiving Information Over a Bluetooth Connection 
1. Go to your Today screen.

2. Press Start  and select Settings.

3. Select the Connections tab and then select Bluetooth .

4. Select the Mode tab and check the Turn on Bluetooth box to turn on the Bluetooth 
feature on your smartphone. (Wait about 10 seconds for the Bluetooth feature to 
activate.)

Tip Check your battery level before establishing a Bluetooth connection. If the 
battery level is low, you can’t make a Bluetooth connection.

Did you know? You can synchronize using a Bluetooth connection (see “Synchronizing 
Over a Bluetooth® Wireless Technology Connection” on page 336).
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5. If you haven’t already set up a partnership with the transmitting device, check the Make 
this device visible to other devices box to let the device find your Treo Pro smartphone 
and request a connection.

6. Press OK .

7. When your smartphone is receiving information, a notification tells you that a 
transmission is in progress and asks you if you want to receive the transmitted data. 
Press Yes (left softkey) or No (right softkey).

Beaming Information

Your device is equipped with an IR (infrared) port that enables you to beam information to 
another device with an IR port. The IR port is located on the side of your device closest to the 
stylus, next to the Wi-Fi  button. You can also beam using the Bluetooth wireless 
technology on your device. The normal range for beaming with IR is about 8 inches 
(20 centimeters). The maximum range for beaming with Bluetooth technology is about 
30 feet (10 meters). Performance and range are affected by physical obstacles, radio 
interference from nearby electronic equipment, and other factors.

Tip If you have trouble receiving information over a Bluetooth connection, press 
Start and select Settings. Select the Connections tab, and then select 
Beam. Make sure the Receive all incoming beams box is checked.

Remember to uncheck the Make the device visible to other devices box 
when you have finished receiving information from the other device. 
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Tip For best results, the path between the two devices must be clear of 
obstacles and both devices must be kept stationary. If you have difficulty 
beaming, shorten the distance and avoid bright sunlight.

The type of information you can beam depends on the type of device you 
are beaming to. Other Windows Mobile® 6.1 Professional devices are 
compatible with your Treo Pro smartphone.

Did you know? You can synchronize using an infrared connection (see “Synchronizing Over 
an Infrared Connection” on page 337).



220 Section 3F: Using Wireless Connections

Beaming a Record
1. Highlight the entry or file you want to beam.

2. Press Menu (right softkey) and select Beam. (If you don’t 
see a Beam command, select Send… > Beam instead. 
The Beam and Send menu items change names based on 
the type of item you highlighted.)

3. When the name of the receiving device appears, select it to 
begin the transfer. Do one of the following:

� Bluetooth: When the name of the receiving device 
appears, select it to begin the transfer. (A blue icon 
indicates a Bluetooth connection.)

� IR: Select Infrared. Point the IR port on your device 
directly at the IR port of the receiving device. (A red icon indicates an IR connection.)

4. Wait for Done to appear next to the name of the receiving device before you continue 
using your smartphone.

Receiving Beamed Information
1. Press End  to turn on your screen if it is not already on.

2. If you are beaming over an IR port, point the IR port on your on your smartphone directly 
at the IR port on the transmitting device.

3. When the Receiving Data message appears, select Yes to receive the beam.

Tip The regional setting determines the list of characters that can be used when 
info is beamed between devices. If you try to send or receive a character 
that is not on the list, it appears as a question mark.
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Using Comm Manager to Turn Wireless Services On and Off

To quickly turn all wireless services on or off, press and hold Power . Use Comm 
Manager to turn individual wireless features on or off.

� To open Comm Manager, tap near the top of the Today screen anywhere at the level of 
Sprint or Phone off.

You can also do any of the following:
� On the Today screen, select Sprint or Phone off.
� On the Today screen, tap the signal-strength  icon at the top of the screen and then 

select Comm Manager.
� If Bluetooth is on, tap the Bluetooth  icon on the Today screen.

To manage wireless services with Comm Manager:

1. Open Comm Manager.

2. Highlight a wireless service using Up  and Down  on 
the 5-way, and then press Center  to toggle the setting. 
(You can also tap the ON or OFF button for a service.)

� Airplane Mode: Turns off all wireless services that are 
on.

� Phone: Enables or disables the phone application on 
your device. (Press Settings [right softkey] and select 
Phone to configure your phone settings.)

Tip If you can’t receive beamed information, press Start and select Settings. 
Select the Connections tab, and then select Beam. Make sure the Receive 
all incoming beams box is checked. If you still can’t receive information, try 
a soft reset (see “Resetting Your Treo™ Pro Smartphone by Palm” on 
page 375).
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� Bluetooth: Toggles Bluetooth on and off. (Press Settings [right softkey] and select 
Bluetooth to configure Bluetooth on your device.)

� Wi-Fi: Turns Wi-Fi on and off. (If you are connected to a wireless network, you can 
press Settings [right softkey] and select Wireless LAN to review your wireless 
network settings, adjust how Wi-Fi uses power, etc. If both the ON and OFF buttons 
are gray, Wi-Fi is off. You cannot turn Wi-Fi on with Comm Manager. You must use 
the Wi-Fi button on the side of your Treo. See “Turning the Wi-Fi Feature On and Off” 
on page 205.)

� Microsoft Direct Push: Toggles between receiving Outlook email automatically via 
Direct Push technology or manually when you initiate a sync (see “Setting the 
Synchronization Schedule” on page 334).

� Data Connection: Disconnects active data services (for example, EVDO and Direct 
Push). (If both the ON and OFF buttons are gray, you are not connected to a data 
service. You cannot connect to a data service in Comm Manager.)

3. Press Exit (left softkey).
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� Synchronizing Pictures, Videos, and Music: Windows Vista®
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Synchronizing Your Pictures, Videos, and Music

You can synchronize pictures, videos, and music files between your Treo™ Pro smartphone by 
Palm and your computer. How synchronization happens, however, depends on two 
conditions:

� Sync direction: Are you transferring the files from your smartphone to your computer or 
from your computer to your smartphone?

� Operating system: Do you use Windows XP or Windows Vista®?

Synchronizing Pictures, Videos, and Music: Windows XP

Do the following to synchronize pictures, videos, and music files that you capture on or copy to 
your Treo Pro smartphone.

1. Sync as you normally would with the ActiveSync desktop software (see “Using the 
Desktop Sync Software” on page 47 for details).

2. To find synchronized pictures and videos on your computer, go to: C:\Documents and 
Settings\<Username>\My Documents\<device name>My Documents. (This folder has 
subfolders for My Music, My Pictures, and My Videos.)

Note These procedures do not apply to files in your Windows Media® Player 
library. See “Synchronizing Windows Media® Player Library Files” on 
page 247 for details on synchronizing your library files.

Tip For best results, use Windows Media Player to sync your music files—for 
both Windows XP and Windows Vista computers.

Before You 
Begin

Install Microsoft ActiveSync desktop software (see “Installing Desktop Sync 
Software: Windows XP and Windows Vista” on page 44). 
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Do the following to sync pictures, videos, and music files that originate on your computer.

1. Connect your smartphone to your computer with the USB cable.

2. On your computer, double-click the 
ActiveSync  icon in the taskbar in the 
lower-right corner of your computer screen to 
open the ActiveSync desktop software window. (If 
you don’t see the ActiveSync icon in the taskbar, 
click Start > All Programs > Microsoft ActiveSync 
to open the ActiveSync window.)

3. Under Information Type, double-click Files to view 
a list of the files in the Files sync folder. (If you 
don’t see the Files option, open the Tools menu, 
select Options, and make sure the Files box is 
checked.)

4. Do any of the following:
� To copy a file from your computer to your smartphone, click Add, browse to and 

highlight the file, and then click Open.

� To delete a file from the Files sync folder on your computer and from your 
smartphone, highlight the file name and click Remove.

Note Most ActiveSync desktop software options are available only when your 
Treo Pro smartphone is connected to your computer.

Tip If you receive an error while synchronizing files, make sure that all of the files 
you’re trying to sync are closed on both your computer and your Treo Pro 
smartphone.

If a Treo Pro smartphone My Documents sync folder has been created on 
your computer, you can also sync by dragging files into the appropriate 
subfolder under that folder.
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Synchronizing Pictures, Videos, and Music: Windows Vista®

Do the following to synchronize pictures, videos, and music files that you capture on or copy to 
your Treo Pro smartphone.

1. Connect your smartphone to your computer with the USB cable.

2. If Windows Mobile Device Center does not open automatically, on your computer, click 
Start > All Programs > Windows Mobile Device Center.

3. Select Connect without setting up your device.

4. Select Pictures, Music and Video.

5. Select X new pictures/video clips are available for import. 

6. (Optional) Add a tag name for the pictures and videos you are importing.

7. Click Import.

8. To find all synchronized (imported) pictures and videos on your computer, click Start > 
Pictures, or go to: C:\Users\<Username>\Pictures. 

To synchronize music files that originate on your Treo Pro smartphone, and pictures, videos, 
and music files that originate on your computer, use Windows Media Player (see 
“Synchronizing Windows Media® Player Library Files” on page 247).

Before You 
Begin

Make sure Windows Mobile Device Center is installed on your computer 
(see “Installing Desktop Sync Software: Windows XP and Windows Vista” on 
page 44). 

Note Each time you import pictures and videos from your Treo Pro smartphone, 
Windows Mobile Device Center creates a subfolder in the Pictures folder 
based on the current date and any tag you select during the import 
process.
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About Your Camera

Your Treo™ Pro smartphone by Palm comes with an easy-to-use, built-in, 2.0-megapixel 
camera with up to 8x digital zoom. You can use the camera to take and view pictures and 
videos and send them to your friends and family. To add a personal touch to your 
smartphone, use your pictures as your Today screen background and as caller ID images.

Taking Pictures and Videos

Selecting Camera Modes
By default, the camera on your device is in picture  mode, to capture standard still images 
(see “Taking a Picture” on page 231). You can change modes to any of the following:

Video: Captures video clips.

MMS video: Captures video clips suitable for sending as attachments to 
multimedia messages.

Contacts picture: Captures still images and immediately gives you the option 
to assign them to a contact.

Panorama: Captures a sequence of still images continuously and allows you 
to combine them into a panoramic view.

Sports: Captures a sequence of 3, 5, 7, or 10 still images with a single button 
press.

Burst: Captures a sequence of up to 30 still images while Center  is held 
down.
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To switch camera modes, do the following:

1. Press and hold the Side button.

2. Press Left  or Right  until the Mode icon for the mode you want appears in the 
upper-left corner of the screen.

* Mode icon

Taking a Picture
By default, pictures are stored in the My Pictures folder on your Treo Pro smartphone. If you 
want to store your pictures on an expansion card (sold separately), you can change where 
pictures are stored (see “Organizing Pictures and Videos” on page 240). For information on 
accessing your pictures on your computer, see “Synchronizing Your Media Files” on 
page 225.

Did you know? Pictures are captured and stored in 16-bit color, JPG format. Resolution 
settings range from a low end of 160x120 pixels to a high end of 1600x1200 
pixels. You can change the default setting. See “Customizing Your Camera 
Settings” on page 235 for details.

*
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1. Press and hold the Side button. (If you see the Video  
or MMS Video  icon in the upper-left corner of the 
screen, press Left  or Right  on the 5-way until one of 
the camera icons appears.) 

2. Aim your smartphone, as you would any camera, to frame 
the subject in the device’s screen.

3. (Optional) If the onscreen controls are not displayed, press 
Up  to display the controls and tap the screen with the 
stylus to open the Quick Settings. Tap any of the following 
settings repeatedly to toggle among the options for that 
item:

� Resolution: Sets the image quality.

� White balance: Specifies the light conditions.

� Brightness: Sets the brightness level. (When the Quick 

Settings are open, press Left  or Right  to adjust the 
brightness setting. If you use the stylus, tap the + or - 
icon to increase or decrease the brightness setting.)

� Storage: Specifies whether to save the picture to your 
device or to an expansion card (sold separately) 
inserted into your device. The expansion card option 
appears only if you have an expansion card inserted into your device.

� Self-timer: Lets you set a self-timer with a delay of 2 seconds or 10 seconds.

4. (Optional) With the controls displayed, press Up  or Down  to change the zoom 
level. (The zoom indicator appears on the left side of the screen.)

Note In picture mode, zoom works only when the resolution is less than 2M.
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5. Do the following for the mode you are using:

� Picture or Contacts picture: Press Center  to capture the picture or start the 
self-timer.

� Panorama: Press Center  for each picture you want to take.

� Sports: Press and hold Center  while following the movement of your subject.

� Burst: Press and hold Center  while the camera takes consecutive shots.

6. Hold your device still until the picture renders. After the picture has been captured, it 
appears on the Review screen. Select one of the following:

Recording a Video
Videos can be any length, provided you have enough storage space available. By default, 
videos are stored in the My Pictures folder on your device. If you want to store your videos on 
an expansion card or capture longer videos (provided you have ample storage space), see 
“Organizing Pictures and Videos” on page 240 to change your video settings. For information 
on transferring your videos to your computer, see “Synchronizing Your Media Files” on 
page 225.

1. Press and hold the Side button.

2. Press Left  or Right  until the Video  or MMS video  icon appears in the 
upper-left corner of the screen.

3. Adjust the position of your device until you see the subject you want to record on the 
screen. 

Go back to the Camera screen to take another picture.

Delete the picture.

Send the picture as an attachment to a multimedia or email 
message.

View the picture in the Pictures & Videos application (see “Viewing 
Pictures and Videos” on page 237).
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4. (Optional) If the onscreen controls are not displayed, press Up  to display the controls 
and tap the screen to open the Quick Settings. Tap any of the following settings 
repeatedly to toggle among the options for that item:

� Resolution: Sets the image quality.

� White balance: Specifies the light conditions.

� Brightness: Sets the brightness level.

� Storage: Specifies whether to save the video to your 
device or to an expansion card (sold separately) 
inserted into your device. The expansion card option 
appears only if you have an expansion card inserted 
into your device.

5. (Optional) With the controls displayed, press Up  or 
Down  to change the zoom level. The zoom indicator 
appears on the left side of the screen.

6. Press Center  to start recording.

7. When you’ve finished recording, press Center  to stop recording.

8. After the video has been captured, it appears on the Review screen. Select one of the 
following icons:

Tip When the Quick Settings are open, press Left or Right on the 5-way to 
adjust the brightness setting. If you use the stylus, first tap the + or - icon to 
specify whether you want to increase or decrease the brightness setting. 

Go back to the Camera screen to take another video.
Delete the video.
Send the video as an attachment to a multimedia or email 
message.
View the video in Windows Media Player Mobile (see “Playing Media 
Files” on page 249).
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Customizing Your Camera Settings

1. Press and hold the Side button.

2. Tap the Menu  icon.

3. On the Capture Settings tab, set any of the following options. (Not all options appear in 
all camera modes.)

� Effect: Sets a special effect such as grayscale or sepia.

� Time Stamp (camera, sports, and burst modes only): Sets whether the date and 
time are displayed on your captured pictures.

� Direction (panorama mode only): Sets the direction in which images are to be 
combined into a panorama.

� Stitch Count (panorama mode only): Sets the number of pictures that you want to 
be combined.

� Capture Speed (sports and burst modes only): Sets the speed for capturing still 

pictures.

� Snapshots (sports mode only): Sets the number of shots to be captured with each 
press of Center .

� Quality: Sets the JPG image quality for still pictures.

� Metering Mode: Sets whether the camera measures the amount of light around the 
center of the image or the average amount of light around the entire image to 
determine the best exposure value.

� Storage: Sets whether to save items to your device or to an expansion card (sold 
separately).

4. Select the Advanced tab and set any of the following options. (Not all options appear in 
all camera modes.)

� Capture Format: Sets the format you want for captured still images.
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� Shutter Sound: Sets whether the camera makes a sound when you press 
Center .

� Grid (camera mode only): Sets whether an onscreen grid appears to help position 
the subjects of still pictures.

� Keep Backlight: Sets whether to turn the backlight on or off when using the camera. 
This overrides your device backlight settings when you are using the camera.

� Review Duration: Sets the time length that a captured picture or image is displayed 
before it is automatically saved and you return to the camera screen. (Select No 
Limit if you don’t want a time limit. Select No Review if you want captured items to be 
saved immediately.)

� Flicker Adjustment: Sets the rate to reduce flicker on the camera screen.

� Record with Audio (video and MMS video modes only): Sets whether to include 
audio when recording.

� Prefix: Sets whether to include the date or the date and time as the prefix in 
captured item file names. (When Default is selected, the prefix for pictures is IMAGE 
and the prefix for videos is VIDEO.)

� Counter: Resets the file-naming counter to 1.

� Image Properties: Adjusts properties such as contrast, saturation, hue, and 
sharpness for captured images. After you select the property you want, press Right 

 or Left  to increase or decrease the value.

� Show Reminder (Contacts picture mode only): Sets whether an alert appears, 
asking whether you want to assign the captured picture to a contact.

5. Press OK .

Note If you save pictures to an expansion card (sold separately), you cannot 
select a prefix. Pictures saved to a card are always given the IMAGE prefix.
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Viewing Pictures and Videos

Viewing a Picture
In addition to viewing the pictures you capture with the built-in camera, you can view pictures 
that are captured on many popular digital cameras or downloaded from the Internet. Your 
Treo Pro smartphone supports the following picture formats: JPG (JPEG, JPE), GIF, BMP, 
WBMP, PNG.

1. Press Start  and select Pictures & Videos.

2. If your pictures are not displayed in Thumbnail View, tap the Show list in the upper-left 
corner, select My Documents, and then select My Pictures.

3. Select the picture you want to view.

4. Press OK  to return to Thumbnail View.

Viewing a Video
In addition to viewing the videos you capture with the built-in camera, you can view videos 
captured on many popular digital cameras. Your Treo Pro smartphone supports the following 
types of video files: MPEG-4, 3GPP2, 3GPP, WMV, WMA, AVI.

1. Press Start  and select Pictures & Videos.

2. If your pictures are not displayed in Thumbnail View, tap the Show list in the upper-left 
corner, select My Documents, and then select My Videos.

3. Select the video you want to view. (For more information on viewing videos, see “Playing 
Media Files” on page 249.)

Tip To view pictures that are stored in a different folder, select the list in the 
upper-left corner, and then select the album you want to view. 
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4. Press OK  to return to Thumbnail View.

Viewing a Slide Show
You can view your pictures as a slide show on your smartphone. Each picture is displayed for 
5 seconds before changing to the next slide.

1. Press Start  and select Pictures & Videos.

2. Select the list in the upper-left corner and select the folder containing the pictures you 
want to view as a slide show.

3. Press Menu (right softkey) and select Play Slide Show.

4. Press Center  to display the slide show toolbar.

5. Use any of the following icons to control the slide show: Rotate , Play , Pause , 
Reverse , Forward , and Stop .

Tip To view videos that are stored in a different folder, select the list in the 
upper-left corner, and then select the album you want to view.

Tip You can also press Right and Left on the 5-way to move forward or 
backward through the pictures.
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Customizing Picture Playback Settings
1. Press Start  and select Pictures & Videos. 

2. Press Menu (right softkey) and select Tools > Options.

3. On the General tab, set the following options:
� Use this picture size: Set the size of pictures you send 

via email.

� When rotating a picture, rotate 90 degrees: Set the 
direction in which pictures rotate.

4. Select the Slide Show tab and set the following options:
� During slide shows, optimize for viewing: Set whether 

pictures are optimized for portrait or landscape format 
during slide shows.

� Play screensaver when connected to my PC and idle 
for 2 minutes: Set whether the pictures in your My 
Pictures folder are used as a screen saver on your 
Treo Pro smartphone when your smartphone is 
connected to your computer and the desktop 
synchronization software is not running.

5. Press OK  to return to Thumbnail View.

Sending Pictures and Videos

You can send a picture or video to other picture-enabled wireless devices or to an 
email address.

Did you know? You cannot send copyrighted pictures or videos that appear with a Lock 
icon in Thumbnail View.
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1. Press Start  and select Pictures & Videos.

2. Highlight the picture you want to send, or tap the Show list in the upper-left and navigate 
to another folder such as My Documents > My Videos to select a file.

3. Press Menu (right softkey) and select Send.

4. Select the option you want to use to send the picture or video: an email account, or as a 
picture or video message.

5. When the Messaging application opens, address and send the message. 
(See “Creating and Sending an Email Message” on page 137 and “Creating and 
Sending a Multimedia Message” on page 161 for details.)

Organizing Pictures and Videos

You can move or copy pictures and videos to other folders or between your Treo Pro 
smartphone and an expansion card.

1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to move or copy. 

3. Do one of the following:
� To move the picture or video, press Menu (right softkey) and select Edit > Cut.

� To copy the picture or video, press Menu (right softkey) and select Edit > Copy.

Tip You can also beam an item to a nearby device. Press Menu (right softkey) 
and select Beam.

If you have set up Windows Live on your device (see “Using Windows LiveTM” 
on page 173), you can send a picture to the Web storage space of your 
Windows Live account. From there, you can share the picture with other 
Web users. Highlight the picture, press Menu (right softkey), and select 
Send to your space.
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4. Select the list in the upper-left corner, and select the location where you want to place 
the picture or video you selected in step 2.

5. Press Menu (right softkey) and select Edit > Paste.

You can also view a specific folder or expansion card and arrange the pictures and videos by 
name, date, or size.

1. Press Start  and select Pictures & Videos.

2. Select the list in the upper-left corner, and then select the folder you want to view.

3. Select the list in the upper-right corner, and then select the sort method: Name, Date, or 
Size.

Using a Picture as the Today Screen Background

1. Press Start  and select Pictures & Videos.

2. Highlight the picture you want to use.

3. Press Menu (right softkey) and select Set as Today Background.

4. Select the Transparency Level list and select the appropriate level. (Use a higher 
percentage for a more transparent picture or a lower percentage for a more 
opaque picture.)

5. Press OK  to return to Thumbnail View.

Tip When you capture new pictures and videos, they appear as the last items in 
Thumbnail View. To place the new items in the appropriate sort order, 
refresh the screen by selecting a different sort method or closing and 
reopening Pictures & Videos.

Tip You can also use the Today Settings screen to set the Today screen 
background. See “Selecting Your Today Screen Background” on page 342 
for details.
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Adding a Picture to a Contact Entry

1. Press Start  and select Pictures & Videos.

2. Highlight the picture you want to use.

3. Press Menu (right softkey) and select Save to Contact.

4. Select the contact you want to add the picture to.

Editing Pictures

1. Press Start  and select Pictures & Videos.

2. Open the picture you want to edit.

3. Press Menu (right softkey) and select Edit.

4. Do any of the following: 
� To rotate a picture 90 degrees counterclockwise, press Rotate (left softkey). 

� To crop a picture, press Menu (right softkey), select Crop, and then tap and drag the 
stylus to highlight the area to crop. (Tap inside the cropped area to accept the crop. 
Tap outside the box to cancel the crop.)

� To adjust the brightness and contrast levels of a picture, press Menu  (right softkey) 
and select Auto Correct. 

� To undo an edit, press Menu (right softkey) and select Undo.

� To cancel all unsaved edits you made to the picture, press Menu (right softkey) and 
select Revert to Saved.

5. To keep both your original image and the revised image, press Menu (right softkey) and 
select Save As.

6. Enter a new name for the picture and press OK  to save your changes.
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Deleting a Picture or Video
1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to delete. 

3. Press Menu (right softkey) and select Delete.

4. Select Yes to confirm the deletion. 

Renaming a Picture or Video
1. Press Start  and select Pictures & Videos.

2. Highlight the picture or video you want to rename.

3. Press Menu (right softkey) and select Tools > Properties.

4. Enter a new name for the picture or video.

5.  Press OK  to return to Thumbnail View.

Tip For more extensive edits, sync your picture or video to your computer and 
edit it in your favorite graphics program. Then sync the picture or video back 
to your Treo Pro smartphone.
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Windows Media® Player Mobile can play music, audio, and video files that are stored on your 
Treo™ Pro smartphone by Palm or on an expansion card (sold separately) in any of the 
following file formats:

� WMA 
� WMV 
� MP3
� 3GP
� AAC
� AAC+
� MPEG-4

Because music, audio, and video files are so large, we recommend that you use a microSD 
expansion card (sold separately) to store the files you want to play on your smartphone. You 
can listen to these music, audio, and video files through the speaker on the back of your 
smartphone or through a stereo headset (sold separately).

Before You 
Begin

Do the following:

• Make sure you have Windows Media Player 10 or later installed on 
your computer. See “My Windows Media® Player Library Won’t Sync” 
on page 392.

• (Optional) Obtain an expansion card to store your media files.

Note On a Windows XP computer, Windows Media Player 10 or later must be 
installed on your computer before you install Microsoft® ActiveSync® 
desktop software. ActiveSync desktop software is installed from your device 
during setup. Windows Media Player 11 is already installed on Windows 
Vista® computers.

You must have QuickTime Player version 6.5 or later installed on your 
computer to play videos recorded by your device. You can download the 
videos from an expansion card or you can click the video thumbnail after 
synchronizing the files.
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Synchronizing Windows Media® Player Library Files

Use the Sync feature in the desktop version of Windows Media Player to transfer your 
Windows Media Player library files from your computer to an expansion card or your Treo Pro 
smartphone. Your library can include digital music, audio, video, and playlist files. Using Sync 
ensures that your Windows Media Player library files transfer correctly.

During setup, Windows Media Player selects the sync method (automatic or manual) that 
works best for your Treo Pro smartphone:

� Automatic: If you’re using an expansion card that is larger than 4GB and your entire 
library can fit on the card, Windows Media Player automatically syncs your entire library 
when you connect your smartphone to your computer or when you change sync settings. 
You can also choose which playlists you want to sync automatically.

� Manual: You indicate which files or playlists you want to transfer each time you update the 
digital media files on your smartphone. To remove files from your smartphone, you must 
delete them manually.

After you complete initial setup, you can switch between automatic and manual sync.

Before You 
Begin

To sync Windows Media Player files with your computer, set the Media sync 
option on your device (see “Changing Which Applications Synchronize” on 
page 338).

Note The pictures and videos you create with the camera on your Treo Pro 
smartphone are not part of your Windows Media Player library. See 
“Synchronizing Your Media Files” on page 225 for information on 
transferring pictures and videos from the built-in camera to your computer. 

Note The following steps are for Windows Media Player 11. If you’re using another 
version of Windows Media Player, the steps may vary.
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1. On your computer, open Windows Media Player.

2. (Optional) Insert an expansion card into your smartphone (see “Using Expansion Cards” 
on page 323).

3. Connect your smartphone to your computer with the USB cable. 

4. Wait for the Device Setup wizard to open on your computer, and then click Finish. 

5. In Windows Media Player on your computer, click the Sync tab and select Portable 
media device > Set Up Sync. (To sync with an expansion card, select Storage Card > Set 
Up Sync.)

6. Check the Sync this device automatically box. 

7. Select the playlists and files you want to sync. (On a Windows Vista computer, select the 
All Photos and All Videos playlists to synchronize pictures and videos between your 
device and your computer.)

8. Click Finish to begin the transfer. 

Be patient; transferring media files to an expansion card can take several minutes. To find 
your synchronized files, update the library in Windows Media Player (see “Working With 
Libraries” on page 251). The transferred files appear in the updated libraries.

Note You may see a name for your device instead of Portable media device.

Note If the playlist you want does not appear, the items you want to synchronize 
may reside in a folder that does not sync with Windows Media Player. Sync 
those items by following the correct sync procedure described in 
“Synchronizing Your Pictures, Videos, and Music” on page 226.

Tip For tips on using the desktop version of Windows Media Player, go to the 
Help menu in Windows Media Player on your computer.
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Playing Media Files

1. Press Start  and select Windows Media.

2. If you don’t see Library in the upper-left corner, press Menu (right softkey) and select 
Library.

3. Select the folder that contains the item you want to play (such as a video, song, album, 
or artist name), and if necessary select a subfolder to select a specific item.

4. Press Play (left softkey).

5. Use any of the following onscreen and keyboard controls 
during playback:

 or Center : Play the current file.

 or Center : Pause the current file.

 or Left : Skip to the beginning of the current file or to 

the previous file. (Press and hold Left  to rewind.)

 or Right : Skip to the next file. (Press and hold Right  
to fast forward.)

: Set the point from which playback begins. (Tap and drag the slider to change the 
current position.)

Tip To play a file that is not in a library, go to the Library screen, press Menu 
(right softkey), and select Open File. 

Tip To repeat the current video or song, press Menu (right softkey) and select 
Shuffle/Repeat.
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 or Volume button: Increase the volume level.

 or Volume button: Decrease the volume level.

: Turn the sound on or off.

: Display a video using the full screen.

: Display a Web site where you can find music and videos to play.

: Set your rating of the current file. (Select the stars in the upper-right corner to change 
the rating.)

6. Press Menu (right softkey) and select any of the following during playback:
� Library: Display the Library screen so you can select a different video or song to 

play.

� Play/Pause: Stop playback temporarily and restarts playback.

� Shuffle/Repeat > Shuffle: Play the Now Playing playlist in random order.

� Shuffle/Repeat > Repeat: Play the Now Playing playlist repeatedly.

� Stop: End playback.

Did you know? If you close the Windows Media Player Mobile window, your music 
continues to play in the background. Your music pauses automatically when 
you receive a call. To stop the music, slide the Ringer switch to Sound Off, 
or open Windows Media Player Mobile and press Center on the 5-way.

Tip To play a file from the Web, press Menu on the Library screen, and then 
select Open URL. Select URL and enter the Web site address, or select 
History and select a site you’ve visited before.
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Working With Libraries

A library represents each of the storage locations available to Windows Media Player Mobile, 
such as your Treo Pro smartphone (My Device) or an optional expansion card, sold separately 
(My Storage Card). Each library contains links to the media files in that location. Windows 
Media Player Mobile usually updates the My Device library automatically, but you must 
manually update the My Storage Card library. For example, when you add media files to your 
smartphone, the My Device library is created. When you insert an expansion card containing 
media files, the My Storage Card library is created.

1. Press Start  and select Windows Media.

2. If you’re not on the Library screen, press Menu (right softkey) and select Library to go to 
the Library screen.

3. Press Menu (right softkey) and select Update Library.

4. Wait for the files to be added, and then select Done.

Tip If you don’t see a media file that you added, update the library.

Tip To delete an item from a library: Highlight the item and then press and hold 
Center on the 5-way to open the shortcut menu. Then select Delete from 
Library. Select Yes to delete the item from the library and also from your 
device. Select No to delete it from the library but leave the file on your 
device.

Did you know? If you move files between your Treo Pro smartphone and an expansion card, 
be sure to update your libraries, or you won’t be able to see the files in their 
new location.
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Working With Playlists

A playlist is a list of media files that play in a specific order. You can use playlists to group 
audio files together or video files together for convenient playback. For example, in the 
desktop player, you can create a playlist of upbeat songs for when you exercise and a playlist 
of soothing songs for a long flight. When you synchronize, your favorite playlists are 
automatically copied to your Treo Pro smartphone. Your playlists appear in your libraries (in 
the My Playlists category). 

A temporary playlist, called Now Playing, appears on the Now Playing menu. It lists the 
currently playing file, as well as any files that are queued up to play next. You can add to, 
modify, or clear the files on the Now Playing playlist.

1. Go to the Now Playing screen: 
� If you are on the Library screen, select the Now Playing 

category. 

� If you are on the Playback screen, press Now Playing 
(left softkey).

2. Do any of the following:
� Move a file up or down one slot: Highlight the file and 

then select Move Up  or Move Down .

� Add a file to the playlist: Select Add  to go to your 
Library list, highlight the file you want to add, press Menu (right softkey), and then 
select Queue Up. (To return to your playlist, press Menu [right softkey] and select 
Now Playing.)

� Delete a file from the playlist: Highlight the file and then select Remove .

� View more information about a file: Highlight the file and select Properties .

� Remove all items from the Now Playing playlist: Press Menu (right softkey) and 
select Clear Now Playing.
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� Keep the playlist so you can play it later: Press Menu (right softkey), select Save 
Playlist, and then enter a name for the playlist.

Customizing Windows Media Player Mobile

1. If necessary, go to the Playback screen by pressing OK  to close the current screen.

2. Press Menu (right softkey) and select Options.

3. On the Playback tab, select Elapsed or Remaining to 
indicate how you want to see time on the Playback screen.

4. Select the Video tab and select either of the following 
options:

� Play video in full screen: Set whether videos 
automatically play in full-screen format.

� Scale to fit window: Set whether videos are 
automatically scaled to fit the Playback screen.

5. Select the Network tab and set the following options:
� Protocol: Set the available protocols. (You must select at least one protocol. You can 

also set a UDP port.)

� Internet Connection Speed: Set the speed of your network connection and whether 
you want the device to detect connection speed.

6. Select the Library tab and set whether the Library screen or the Playback screen 
appears when you open Windows Media Player Mobile.

7. Select the Skins tab and select Previous or Next until you display the skin you want as 
the player’s background.

Did you know? You can also move a file on the Now Playing playlist by tapping and 
dragging it to a new position.
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8. Select the Buttons tab and do any of the following to 
change any of the available button settings:

� Assign a button: Highlight the item you want to set, 
select Assign, and then press the button you want to 
use for that item.

� Restore an item’s factory setting: Highlight the item 
and select Reset.

� Unassign an item: Highlight the item and select None.

9. Press OK .

Did you know? You can preserve battery life by assigning a button to toggle the screen off 
and on during playback. On the Buttons tab, set the Toggle Screen option, 
and then press the assigned key (for instance, S) to turn the screen on and 
off during playback.

Tip You can also use Kimona FreePlay to view media files (see “Using Kinoma 
FreePlay” on page 195).
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Using the Organizer Features

Sect ion 5A

In This Section

� Contacts

� Calendar

� Tasks

� Notes

� Calculator

Note If you are using Exchange Server 2007, or Exchange Server 2003 that has 
been upgraded to Service Pack 2, you may be able to take advantage of the 
additional features of Microsoft Direct Push. Microsoft Direct Push is a 
two-way wireless delivery method that keeps your Outlook information 
always up-to-date and provides more efficient communication between the 
server and your device. It includes features like Global Address List, Tasks 
Over The Air (OTA), and IP-based push updating of Calendar and 
Messaging.
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Contacts

Adding a Contact

1. Go to your Today screen.

2. Press Contacts (left softkey) and press New (left softkey).

3. If prompted, indicate whether this is an Outlook contact or 
a Windows Live contact.

4. Use the 5-way navigator to move between fields as you 
enter information.

5. To enter complete name or address (work, home, or other) 
information, move the cursor to the appropriate field (such 
as Work addr or Home addr), press Center  or tap the 
arrow on the right side of the line, and enter the information 
in the box that appears. (To accept the information and 
close the box, tap outside the box.)

6. To add a caller ID picture that appears when that person calls, select Picture, select 
Camera, and then take a picture, or select an existing picture from Thumbnail View. 

7. To assign the entry to one or more categories, select Categories and then check the 
categories under which you want this entry to appear. (To add a new category, press 
New [left softkey], enter the category name, and then press OK .)

8. To assign a ringtone to the entry, select Ring tone and select a tone.

9. To add a note to an entry, select the Notes tab.

10. After you enter all the information, press OK . 

Tip If you have many contacts to enter, it’s best to enter them in Microsoft® 
Outlook® on your computer and then sync. See “Connecting to Your 
Computer” on page 39 for details.



Section 5A: Using the Organizer Features 259

S
taying O

rganized

Viewing or Changing Contact Information
1. Go to your Today screen and press Contacts.

2. In the Contacts list (viewed by name), begin entering any combination of letters from the 
contact’s first and/or last name. If you use both first- and last-name letters, separate 
them by a space.

3. Select the entry you want to open.

Tip Be sure to enter wireless numbers and email addresses in the correct fields 
so that Messaging can find this information when you address a message, 
and Calendar can find your contacts when you want to invite them to 
meetings.

To enter an international phone number, enter a + (plus sign) in front of the 
country code (see “Setting Your Long Distance Dialing Preferences” on 
page 101).

Tip You can type letters from the last name first. For example, entering SM finds 
both Smilla Anderson and John Smith. Entering SM AN finds both Smilla 
Anderson and Ann Smith.

Tip You can also find a contact by tapping the first letter of the first or last name 
in the alphabetical index at the top of the Contacts list screen.

Did you know? When you select a contact entry, you are presented with several options for 
contacting the person, depending on what information you have entered for 
the contact. For example, you may see options for calling a number 
associated with the contact, sending an email to the contact’s email 
address, or calling the last number you dialed to call the contact. Select a 
phone number to dial, or select a messaging option to create a new 
message addressed to the contact.
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4. Press Menu (right softkey) and select Edit.

5. Make changes to the entry as necessary.

6. Press OK .

Viewing a Map of a Contact’s Address
1. Make sure that your phone is turned on and that you are inside a coverage area (see 

“Turning Your Phone On and Off” on page 34).

2. Go to your Today screen. 

3. Using the keyboard, begin entering one of the following for the contact you want to map:
� First name.

� Last name.

� First initial and last initial separated by a space.

� First and last name.

4. Highlight the contact’s name and press Center .

5. Select Menu and then select Show On Map to see a Live Search map of the contact’s 
address. (You can also get directions to the location.)

Did you know? You can find a contact by company name. From your Today screen, press 
Contacts (left softkey), press Menu (right softkey), and select View By > 
Company. Select a company name to see the contacts who work there.

Tip To view a particular group of contacts, press Menu (right softkey), select 
Filter, and then select the category you want to view.



Section 5A: Using the Organizer Features 261

S
taying O

rganized

Deleting a Contact
1. Go to your Today screen and press Contacts (left softkey).

2. In the Contacts list, highlight the contact you want to delete.

3. Press Menu (right softkey) and select Delete Contact.

4. Select Yes to confirm the deletion.

Customizing Contacts
1. Go to your Today screen and press Contacts (left softkey).

2. Press Menu (right softkey) and select Options.

3. Set any of the following options:
� Show alphabetical index: Display the alphabet at the top of the Contacts list. (Select 

a letter range to jump to that part of the alphabet.)

� Show contact names only: Hide everything but the contact’s name, which enables 
you to fit more names on the screen when viewing your Contacts list.

� Area code: Set the default area code for new contact entries.

4. Press OK .

Finding a Contact in an Online Address Book
In addition to having contacts on your Treo™ Pro smartphone by Palm, you can also access 
contact information from your organization’s online address book or Global Address List 
(GAL).

Tip You can also press Menu and select Map It to open Sprint Navigation (see 
“Using Sprint Navigation” on page 200).
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1. Go to your Today screen and press Contacts (left softkey).

2. Press Menu (right softkey) and select Company Directory. 

3. Enter the contact’s name (in part or in full), and then select Search. (You must spell the 
contact’s name correctly to find it in the online address book.)

Sending a contact
Your device provides multiple options for sending a contact’s information to someone else.

1. Go to your Today screen and press Contacts (left softkey).

2. In the Contacts list, highlight the contact you want to send.

3. Press Menu (right softkey) and select one of the following options:
� Beam a contact to a nearby device: Select Send Contact > Beam, and then select 

the receiving device.

� Send a multimedia message containing the contact information: Select Send as 
vCard(Video) or VCard(Picture), address the multimedia message, and press Send 
(left softkey).

Before You 
Begin

Do the following:

• Make sure you are accessing Microsoft® Exchange Server 2007 or 
Exchange Server 2003 upgraded to Service Pack 2. 

• Add access to the online address book (see “Adding an Online 
Address Book” on page 143 for details).

• Synchronize with the Exchange server after you add the online 
address book (see “Getting Information From a Microsoft® Exchange 
Server” on page 125). (Otherwise the Company Directory option 
does not appear.) 

Tip You can also send a message to the highlighted contact. Press Menu (right 
softkey) and select Send video message by email or Send picture 
message by email.
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Calendar

Displaying Your Calendar
1. Press Calendar .

2. Press Menu (right softkey) and select View.

3. Select one of the following views:
� Agenda: View your daily schedule in list format. (Upcoming appointments are bold; 

past appointments are dimmed.)

� Day: View your daily schedule in day-planner format.

� Week: View your schedule for an entire week.

� Month: View your schedule for a whole month. 

 A morning appointment.

 An afternoon or evening appointment.

 Both morning and afternoon or evening appointments. 

 An all-day event.

� Year: View the first nine months of the current year. (Press Down  to see the next 
set of months, or press Up  to see the previous set.)

4. Use the 5-way to move to another day, week, month, or year (based on the current 
view).

Tip To switch views, press the left softkey. Don’t confuse the view name 
displayed above the left softkey with the current view. The left softkey 
displays the name of the next view you see when you press the key.



264 Section 5A: Using the Organizer Features

Creating an Appointment

1. Press Calendar .

2. Press Menu (right softkey) and select New Appointment.

3. Enter a Subject (description) and a Location.

4. Select Starts and select the starting date and time.

5. Select Ends and select the ending date and time.

6. Press OK 

Creating an Untimed Event
An untimed event, such as a birthday, anniversary, or vacation, 
does not occur at a particular time. These events appear as 
banners at the top of your calendar; they don’t occupy blocks of 
time. For example, in the illustration shown here, “Submit Final 
Draft” is an untimed event.

Tip If you have several appointments to enter, it’s most efficient to enter them in 
Microsoft Office Outlook on your computer and then synchronize your 
Treo Pro smartphone with your computer. For more information, see 
“Connecting to Your Computer” on page 39.

Tip To pencil in an appointment, open the appointment, press Menu (right 
softkey), and select Edit. Select Status and then select Tentative.
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1. Press Calendar .

2. Press Menu (right softkey) and select New Appointment.

3. Enter a Subject (description).

4. Select the starting and ending dates.

5. Select All Day and then select Yes.

6. Press OK . 

Scheduling a Repeating Appointment
1. Create an appointment or untimed event, and then select it.

2. Press Menu (right softkey) and select Edit. 

3. Select Occurs and then select a repeat pattern. (To create a repeat pattern, select Edit 
pattern and follow the onscreen instructions.) 

4. Press OK .

Adding an Alarm Reminder to an Event
1. Create an event, and then select it.

2. Press Menu (right softkey) and select Edit. 

3. Select Reminder and then select Remind Me.

4. Enter the number of minutes, hours, days, or weeks before the event that you want to 
receive the alarm.

Tip To enter a birthday or an anniversary, create an untimed event that repeats 
every year.
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5. Press OK .

1 Number of Time Units
2 Type of Time Units

Sending a Meeting Request

1. Create an event, and then select it.

2. Press Menu (right softkey) and select Edit. 

3. Select Attendees and then select Add Required Attendee. 

4. Select the contact you want to invite. 

5. To invite more attendees, select Add Required Attendee and select the names.

6. To invite optional attendees, select Add Optional Attendee and select the names.

7. Press OK .

Before You 
Begin

Create contact entries with email addresses for the people you want to invite 
to a meeting (see “Adding a Contact” on page 258). You can’t invite 
someone to a meeting unless you have an email address for them in the 
Contacts application.

1

2
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The next time synchronization occurs, the meeting request is sent to the attendees. 
When attendees using Outlook accept your meeting request, the meeting is 
automatically added to their Calendar schedules. As you receive each response, your 
Outlook Calendar schedule is updated as well.

Sending an Appointment
1. Press Calendar .

2. Highlight the appointment you want to send.

3. Select one of the following: 
� Beam an appointment to a nearby device: Press Menu (right softkey), select Beam 

Appointment, and select the receiving device.

� Send a multimedia message containing the appointment: Press Menu (right 
softkey), select Send as vCalendar, address the multimedia message, and press 
Send (left softkey). 

Marking an Event as Sensitive
If other people have access to your Microsoft Office Outlook calendar on your computer and 
you don’t want them to see an appointment, you can mark that appointment as private to hide 
it from other Microsoft Office Outlook users.

1. Create an event and then open it.

2. Press Menu (right softkey) and select Edit. 

Did you know? If you are using Microsoft Exchange Server 2003 upgraded Service Pack 2, 
you can use your corporate Global Address List to find contact information 
for an attendee. Select Attendees and select Add Required Attendee or 
Add Optional Attendee. Press Menu (right softkey), and select Company 
Directory. Enter the name of the attendee and select Find.
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3. Select Sensitivity and then select one of the following:
� Normal: The event is displayed without any notation.

� Personal: People viewing your calendar see “Please treat this as Personal” near the 
top of an open appointment.

� Private: People viewing your calendar see “Please treat this as Private” near the top 
of an open appointment. (If you sync with an Exchange server, other users who can 
access your folders can’t see your private events; private events appear as 
unavailable time slots.)

� Confidential: People viewing your calendar see “Please treat this as Confidential” 
near the top of an open appointment.

4. Press OK .

Organizing Your Schedule
Use categories to view various types of events. 

1. Create an event and then select it.

2. Press Menu (right softkey) and select Edit. 

3. Select Categories and then check the categories that apply 
to this event. (To add a new category, press New [left 
softkey], enter the category name, and then press OK .)

4. Press OK  two more times.

5. After you assign events to categories, press Menu (right 
softkey) and select Filter.

Tip If you don’t see an option on the screen, press Down on the 5-way to scroll 
to other options. For example, when editing an event, you don’t see the 
Sensitivity option until you scroll toward the bottom of the entry.

To remove sensitivity status from an item, select Normal from the Sensitivity 
list.
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6. Select the category of events you want to view.

Deleting an Event
1. Highlight the event you want to delete.

2. Press Menu (right softkey) and select Delete Appointment.

3. Select Yes.

Customizing Calendar
1. Press Menu (right softkey) and select Tools > Options.

2. On the General tab, set any of the following options:
� Start in: Set which view appears when you open the 

Calendar application.

� 1st day of week: Set Sunday or Monday as the first day 
of the week for all Calendar views.

� Week view: Set whether five, six, or seven days appear 
in Week view.

� Show half hour slots: Set whether time slots appear in 
one-hour or half-hour increments in Day view and Week view.

� Show week numbers: Set whether week numbers (1–52) appear in Week view.

3. Select the Appointments tab and set any of the following options:
� Set reminders for new items: Set whether a reminder 

is automatically added to new events and how long 
before the event the reminder appears. (You can 
override this setting for individual events.)

� Show icons: Set which icons appear next to events. 

 The event has a reminder.

 The event repeats in a specified pattern.
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 The event has a note attached.

 The event has an assigned location.

 The event is a meeting.

 The event is marked private.

� Send meeting requests via: Set the method used to send meeting requests.

4. Press OK .

Tasks

You can use Tasks to help you remember tasks you need to complete and to keep a record of 
completed tasks. 

Adding a Task
1. Press Start  and select Programs.

2. Select Tasks .

Tip Not all icons appear in all Calendar views.

Did you know? If you want to use Tasks Over The Air (OTA) synchronization, install the 
desktop sync software (see “Installing Desktop Sync Software: Windows XP 
and Windows Vista” on page 44). OTA features also require Microsoft 
Exchange Server 2007 or Exchange Server 2003 upgraded to Service Pack 
2. The option to synchronize tasks wirelessly in the ActiveSync® application 
appears only if you have the appropriate server.
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3. Press Menu (right softkey) and select New Task.

4. Enter a description of the task in the Subject field.

5. Set any of the following: 
� Priority: Set the priority level for this task. (Later you can 

arrange your tasks based on the importance of each 
task.)

� Status: Set whether the task is now completed.

� Starts: Set when the task begins.

� Due: Set the due date for the task.

� Occurs: Set whether the task repeats at regular 
intervals and how often it repeats.

� Reminder: Set an alarm for this task and indicate when you want to be reminded.

� Categories: Assign the task to one or more categories.

� Sensitivity: Mark this task as Normal, Personal, Private, or Confidential. (See 
“Marking an Event as Sensitive” on page 267 for descriptions of these terms.)

6. (Optional) Select the Notes tab and enter additional text for the task.

7. Press OK .

Tip You can also add a task by selecting the Tasks entry bar at the top of the 
screen.

You can display your tasks on your Today screen (see “Selecting Which 
Items Appear on Your Today Screen” on page 343).
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Checking Off a Task
1. From the Tasks list, highlight the task you want to check off. 

(Overdue tasks appear in red.)

2. Press Complete (left softkey).

Organizing Your Tasks
1. In the Tasks list, press Menu (right softkey) and select Filter.

2. Select which tasks you want to view: All Tasks, Recently Viewed, No Categories, 
Active Tasks, Completed Tasks, or a specific category, such as Business or Personal.

3. Press Menu (right softkey) and select Sort By.

4. Select the sort method: Status, Priority, Subject, Start Date, or Due Date.

Deleting a Task
1. Highlight the task you want to delete.

2. Press Menu (right softkey) and select Delete Task.

3. Select Yes.

Customizing Tasks
1. Go to the Tasks list.

2. Press Menu (right softkey) and select Options.

Tip You can also mark a task as completed by tapping the check box next to 
the task on the Tasks list. If you need to mark a completed task as 
incomplete, highlight it and press Activate (left softkey).
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3. Set any of the following options:
� Set reminders for new items: Automatically add a reminder to new tasks. (The 

default reminder is set to 8:00 on the morning the task is due. You can override this 
setting for individual tasks.)

� Show start and due dates: Display the task start and due dates in the Tasks list.

� Show Tasks entry bar: Display the Tasks entry bar at the top of the Tasks list.

4. Press OK .

Notes

Notes are a great way to capture thoughts, questions, and meeting notes on your Treo Pro 
smartphone. 

Creating a Note
1. Press Start  and select Programs. 

2. Select Notes .

3. Press New (left softkey).

4. Do one of the following:
� Type the text, using the keyboard. 

� Write the text with the stylus.

� Enter the text by tapping the onscreen keyboard.

Before You 
Begin

To take advantage of all the sync features available in the Notes application, 
make sure the desktop synchronization software is installed on your 
computer. See “Setting Up Your Computer for Synchronization” on page 44 
for details.
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� Press Menu (right softkey), select Draw, and then draw a sketch with the stylus, 
crossing at least three ruled lines.

5. Press OK .

Recording a Voice Note

You can create a new voice note or add a recording to an existing note. 

1. Press Start  and select Programs.

2. Select Notes .

3. Do either of the following:
� To add a recording to a note, open the note to which you want to add the recording.

� To create a new voice note, press New (left softkey).

4. If the recording toolbar is not visible at the bottom of the 
screen, press Menu (right softkey) and select View 
Recording Toolbar.

5. Select Record  to begin recording. 

6. Speak into the microphone on your smartphone, or hold it 
close to another sound source.

7. After you finish recording, select Stop  to stop recording. 
(A Recording  icon appears in the note or in the Notes 
list, depending on where you recorded the note.) 

8. Press OK .

Did you know? You can add several voice notes within a single note.

Tip To play a recording, select the voice note in the Notes list or open the note 
containing the recording and select the Recording icon.
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Creating a Note From a Template
1. Go to the Notes list. 

2. Tap the list in the upper-left corner, and select More Folders > Templates.

3. Open the template you want to use.

4. Enter the information.

5. Press OK .

6. Rename the note and move it to the appropriate folder. (See the next section, 
“Organizing Your Notes,” for details.)

Organizing Your Notes
You can rename your notes, move notes to another folder, and move notes between your 
Treo Pro smartphone and an expansion (storage) card.

1. Go to the Notes list and highlight a note you want to move.

2. Press Menu (right softkey) and select Rename/Move.

3. Select Name and then enter a new name for the note.

4. Select Folder and then select the folder in which you want to store the note.

5. Select Location and then select Main memory or Storage Card.

6. Press OK .

Tip To create a new template, highlight the note you want to save as a template. 
Press Menu (right softkey) and select Rename/Move. Select Name and 
then enter a name for the template. Select the Folder list and select 
Templates. Press OK.

Tip To create a new folder, go to the Notes list, select the list in the upper-left 
corner, and then select Add/Delete. Select New, enter a name for 
the folder, and then press OK.
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7. Select the list in the upper-left corner, and then select the folder you want to view.

8. Select the list in the upper-right corner, and then select whether you want to sort your 
notes by Name, Date, Size, or Type.

Deleting a Note
1. Go to the Notes list and highlight the note you want to delete.

2. Press Menu (right softkey) and select Delete.

3. Select Yes.

Customizing Notes
1. Go to the Notes list.

2. Press Menu (right softkey) and select Options.

3. Set any of the following options:
� Default mode: Set the default entry mode to Writing or Typing.

� Default template: Set the default template for new notes.

� Save to: Set the default location where new notes are stored.

� Record button action: This option does not apply to the Treo Pro smartphone.

4. Press OK .

Calculator

You can use Calculator for basic arithmetic calculations, such as addition, subtraction, 
multiplication, and division. 

You can tap the screen or use the keyboard to input numbers.

Tip Tap Global Input Options to set options for entering text in any application 
(see “Setting Onscreen Input Options” on page 352). 



Section 5A: Using the Organizer Features 277

S
taying O

rganized

Performing Calculations
1. Press Start  and select Calculator .

2. Enter numbers and perform calculations, including 
the following:

 Clear the last digit.

 Clear the current calculation or the displayed number.

 Calculate the reciprocal of a number.

 Calculate a percentage.

 Calculate the square root of a number.

 Switch a number between negative and positive.

Using the Calculator Memory
� To store a number, select the box to the left of the entry box. (An M appears in the box.) 
� To add the displayed number to the number stored in memory, select . 
� To display the number stored in memory, select . 
� To clear the memory, select . 
� When you store a number in memory, it replaces the number that was previously stored.

Tip To copy a number, press Edit (left softkey) and select Copy. You can paste 
the copied number into another application. To paste a copied number into 
another application, press Edit (left softkey) and select Paste.

Tip For more advanced calculations, use Excel® Mobile. See “Excel® Mobile” on 
page 292 for details.
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� OneNote® Mobile

� Adobe® Reader® LE
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Synchronizing Microsoft® Office and Other Files

You can create and edit Microsoft® Office files on your computer or on your Treo™ Pro 
smartphone by Palm and then synchronize the files so that changes you make show up on 
both your computer and your smartphone. You can use the same method to synchronize files 
from other applications that do not appear in the sync list, such as Microsoft® Outlook® Notes. 
(To learn about synchronizing pictures, videos, and music, see “Synchronizing Your Media 
Files” on page 225.) How synchronization happens, however, depends on whether you use 
Windows XP or Windows Vista®.

Synchronizing Files: Windows XP

1. Connect your smartphone to your computer with the USB cable.

2. On your computer, double-click the ActiveSync  icon in the taskbar in the lower-right 
corner of your computer screen to open the ActiveSync desktop software window. (If 
you don’t see the ActiveSync icon in the taskbar, click Start > All Programs > Microsoft 
ActiveSync to open the ActiveSync window.)

Before You 
Begin

Install Microsoft® ActiveSync® desktop software (see “Installing Desktop 
Sync Software: Windows XP and Windows Vista” on page 44). 

Note Most ActiveSync desktop software options are available only when your 
Treo Pro smartphone is connected to your computer.
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3. Under Information Type, double-click Files to view 
a list of the files in the Files sync folder. (If you 
don’t see the Files option, open the Tools menu, 
select Options, and make sure the Files box is 
checked.)

4. Do any of the following:
� To copy a file from your computer to your 

smartphone, click Add, browse to and 
highlight the file, and then click Open.

� To delete a file from the Files sync folder on 
your computer and from your smartphone, 
highlight the file name and click Remove.

� Click OK to synchronize.

5. On your smartphone, to copy a file from your device to your computer, place the file in 
the My Device > My Documents folder on your device, and then sync.

Note If you receive an error message while synchronizing files, make sure that all 
the files you’re trying to sync are closed on both your computer and your 
Treo Pro smartphone.
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Synchronizing Files: Windows Vista®

1. Do any of the following:
� To copy a file from your computer to your device, copy or save the file in the 

Documents\Documents on <device name’s> Device folder on your computer.

� To copy a file from your device to your computer, copy or save the file in the 
My Device > My Documents folder on your device.

2. Connect your smartphone to your computer with the USB cable. (Synchronization takes 
place automatically.)

Where Are the Changes I Made to My File?
Don’t look for the changed file in its original location on your computer. Only the synchronized 
version of the file contains the changes. To find the synchronized file, do one of the following:

Windows XP: Do either of the following:
� On your computer desktop, double-click the <device name> My Documents icon. (This is 

a shortcut to the Files sync folder.)
� In ActiveSync desktop software, double-click Files. The location of the Files sync folder 

appears in the File Synchronization Settings dialog box (under “On this computer, 
synchronize the files in this folder”).

Windows Vista: Open the Documents\ Documents on <device name’s> Device folder.

On your Treo, you can find the synchronized file by doing either of the following:
� Press Start  and select Office Mobile. Select the application that opens the file: Word 

Mobile, Excel Mobile, PowerPoint Mobile, or OneNote Mobile.
� Press Start , select Programs, and then select File Explorer. Select the list in the 

upper-left corner and select My Device > My Documents.

Did you know? The Documents on <device name’s> Device folder is created when you 
select the option to sync files.
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Word Mobile

You can create and edit documents and templates and save them on your Treo Pro 
smartphone. You can also edit Microsoft® Office Word® documents and templates that you 
create on your computer. However, keep in mind that some of the information and formatting 
may be lost when you save the document on your smartphone.

The following features are not supported in Word Mobile:
� Backgrounds.
� Bidirectional text.
� Document protection.
� Metafiles.
� Artistic page borders. Lined page borders are supported.
� Password-protected files. Remove password protection on your computer before opening 

the file on your device.
� Shapes and text boxes.
� Smart tags.

The following features are partially supported in Word Mobile: 
� Picture bullets: Regular bullets are supported.
� Revision marks: Documents appear as though all revisions were accepted; if the 

document is saved, revision marks are lost.
� Table styles: Some or all of the formatting is lost if the document is saved.
� Underline styles: Unsupported styles are mapped to one of the four supported styles: 

regular, dotted, wavy, or thick/bold/wide.
� Legacy Pocket Word files: You can open PSW files, but if you edit a file, you need to save 

it in DOC, RTF, TXT, or DOT format.
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The following features are not supported on your Treo Pro smartphone, but they remain in the 
file so that when you open the file on your computer, they appear as expected: 

� Fonts and font sizes: Original fonts are listed on your device and are mapped to the 
closest font available.

� Footnotes, endnotes, headers, and footers.
� Lists: Indented lists are mapped to the closest indentation level supported by Word 

Mobile.
� Page breaks: Although not displayed, all page breaks, except a break placed at the end 

of a document, are retained in the document.

Creating a Document
1. Press Start  and select Office Mobile.

2. Select Word Mobile .

3. If an empty document appears onscreen, go to step 4; if the document list appears 
onscreen, press New (left softkey).

4. Enter the text of the document.

5. Press OK  to save the file.

Tip To copy a file from your computer to your Treo Pro smartphone, open My 
Computer or Windows Explorer on your computer, copy the file into the 
Mobile Device folder. You can also use the Files sync folder to copy files 
from your computer to your smartphone as described in “Synchronizing 
Microsoft® Office and Other Files” on page 280.

Did you know? By default, files you create and edit in Word Mobile are saved in DOCX, RTF, 
TXT, or DOTX format. However, you can change the settings to save files in 
DOC, RTF, TXT, or DOT format. 

Did you know? When you save a new document, it is automatically named after the first 
several words in the file.
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Opening an Existing Document
1. Press Start  and select Office Mobile.

2. Select Word Mobile .

3. In the document list, select the document you want to open.

Creating a Document From a Template
1. Go to the document list. 

2. Tap the list in the upper-left corner, and select More Folders >Templates.

3. Open the template you want to use, and enter the information.

4. Press Menu (right softkey) and select File > Save As.

5. Select Name and enter a new name for the file.

6. Select the Folder list, and then select the folder where you want to save the file.

7. Select the Type list, and then select the format in which you want to save the file.

8. Select the Location list, and then select Main Memory or Storage Card.

9. Select Save.

Finding or Replacing Text in a Document
1. Open the document containing the text you want to find.

2. Press Menu (right softkey) and select Edit > Find/Replace.

3. Select Find what and enter the text you want to find.

4. (Optional) Check the Match case box to find text that matches the capitalization in the 
text you entered in step 3.

Tip To create a new template from a document, open the document you want 
to save as a template. Press Menu (right softkey) and select File > Save As. 
Select Name and then enter a name for the template. Select the Folder list 
and select Templates. Select the Type list, and then select Word Template. 
Press OK.



286 Section 5B: Increasing Your Productivity

5. (Optional) Check the Match whole words only box to find only full words that match the 
text you entered in step 3.

6. Select Find to locate the first instance of the text you entered in step 3, or select Replace 
and enter the replacement text.

7. Select Next to find the next instance of the text, or select Replace to replace it. 
(To replace all instances of the text, select Replace All.) 

8. When you see a message indicating that the search is done, press OK .

Moving or Copying Text
1. Open the document containing the text you want to move or copy.

2. Highlight the text you want to move or copy.

3. Press Menu (right softkey) and select Copy to copy the text, or select Cut to move 
the text.

4. Open the document where you want to insert the text, and position the insertion point 
where you want the text to appear.

5. Press Menu (right softkey) and select Paste.

Saving a Copy of a Document
1. Open the document you want to copy.

2. Press Menu (right softkey) and select File > Save As.

3. Select Name and enter a new name for the file.

4. Select the Folder list, and then select the folder where you want to save the file.

5. Select the Type list, and then select the format in which you want to save the file.

Tip To zoom in or out, open a document, press View, select Zoom, and then 
select the zoom level.
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6. Select the Location list, and then select whether you want to store the file on your 
Treo Pro smartphone or on an expansion card.

7. Select Save.

Formatting Text
1. Open the document and highlight the text you want to format.

2. Press Menu (right softkey) and select Format > Font.

3. Select any of the following formatting options: Font, Font color, Size, Bold, Italic, 
Underline, Highlight, or Strikethrough.

4. Press OK  to return to the document.

Formatting Paragraphs and Lists
1. Open the document you want to format.

2. Position the insertion point in the paragraph you want to format.

3. Press Menu (right softkey) and select Format > Paragraph.

4. Set any of the following options:
� Alignment: Align the text with the left, right, or center of the paragraph.

� List: Create a bulleted or numbered list.

� Indentation: Change the paragraph margins. 

� Left: Set the left margin for the entire paragraph.

� Right: Set the right margin for the entire paragraph.

� Special: Indent the first line or set a hanging indent.

� By: Set the size of the Special indentation. 

5. Press OK  to return to the document.

Note If a document was previously saved on a computer, any unsupported 
formatting may be lost when you save the file.
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Checking Spelling in a Document
1. Open the document you want to check.

2. Press Menu (right softkey) and select Tools > Spelling.

3. If an unknown or misspelled word is encountered, do one of the following:
� Select the correct word in the list if the word is spelled incorrectly. 

� Select Ignore if the word is spelled correctly. 

� Select Add to add a new word to the spelling dictionary.

Organizing Your Documents
You can rename your documents, move your documents to another folder, and move your 
documents between your Treo Pro smartphone and an expansion (storage) card.

1. Go to the documents list.

2. Highlight a file.

3. Press Menu (right softkey) and select Rename/Move.

4. Select Name and then enter a new name for the document.

5. Select the Folder list, and then select the folder you want to move the document to.

Tip You can also use the Formatting toolbar to create a list and to align text. To 
indent text in lists, you must use the Formatting toolbar. 

Tip To check the spelling of specific text, highlight it before you select the 
Spelling command.

Tip To create a new folder, go to the documents list, select the list in the 
upper-left corner, and then select Add/Delete. Select New, enter a name for 
the folder, and then press OK.
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6. Select the Location list, and then select Main memory or Storage card.

7. Press OK .

8. Select the list in the upper-left corner, and then select the folder you want to view.

9. Select the list in the upper-right corner, and then select the sort method.

Deleting a Document
1. Go to the documents list.

2. Highlight the document you want to delete.

3. Press Menu (right softkey) and select Delete.

4. Select Yes.

Customizing Word Mobile
1. Go to the document list.

2. Press Menu (right softkey) and select Options.

3. Set any of the following options:
� Default template: Set the default template for new documents.

� Save to: Set the default location where new documents are stored.

� Display in list view: Set the types of files that appear in the documents list.

4. Press OK .

Tip When you go to a folder, you can easily search your documents by sorting 
by type. 



290 Section 5B: Increasing Your Productivity

PowerPoint® Mobile

With Microsoft® PowerPoint® Mobile, you can open and view slide show presentations created 
on your computer. Many presentation elements such as slide transitions, animations, and URL 
links are also supported. Microsoft® PowerPoint® features that are not supported on your 
Treo Pro smartphone include the following: 

� Notes written for slides. 
� Rearrangement or editing of slides.
� Files created in PPT format earlier than Microsoft PowerPoint 97.
� HTML files in HTM and MHT formats.

Playing a Presentation
1. Press Start  and select Office Mobile.

2. Select PowerPoint Mobile .

3. In the presentation list, highlight the presentation you want to play.

4. Press Center  and do any of the following:

� Press Right  to advance to the next slide, or Left  to view the previous slide. 

� Press Menu (right softkey), select Go to Slide, and then select the slide you want to 
view.

� Press Menu (right softkey), and select Next or Previous to play animations.

Tip To copy a file from your computer to your Treo Pro smartphone, open My 
Computer or Windows Explorer on your computer, copy the file into the 
Mobile Device folder, and then sync.
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� Press Menu (right softkey), select Zoom In, and then select  to zoom in or  to 
zoom out. (To scroll within the current slide, tap and drag the slide. To return to the 
slide show, select .)

� Press Menu (right softkey), and select End Show.

Setting Presentation Playback Options
1. Open the presentation for which you want to change the settings.

2. Press Center  and select Show Options.

3. On the Orientation tab, select the orientation you want. (To select the orientation that 
best fits the screen on your smartphone, select Default.)

4. Select the Playback tab, and check the Override playback options for all files box.

5. Set any of the following options:
� Show without animation: Turn off builds and other animations.

� Show without slide transition: Turn off transition effects between slides. 

� Use timings, if present: Enable the timings recorded with each slide in a 
presentation. 

� Loop continuously: Advance to the first slide after playing the last slide in a 
presentation. 

� Show without media: Turn off sound and other media effects.

6. Press OK .

Tip If a presentation is set up as a timed slide show, the slides advance 
automatically. Presentations pause during zooming.

Tip To turn the presentation into a continuously looping slide show, check both 
the Use timings, if present, and the Loop continuously boxes.
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Excel® Mobile

With Microsoft® Excel® Mobile you can create and edit workbooks and templates on your 
Treo Pro smartphone. You can also edit workbooks and templates that you create on your 
computer. However, keep in mind that you may lose some of the information and formatting 
when you save the workbook on your smartphone.

Note the following formatting considerations: 
� Alignment: Vertical text appears horizontal. 
� Artistic borders: Appear as a single line. 
� Cell patterns: Patterns applied to cells are removed. 
� Fonts and font sizes: The original font is listed on your Treo Pro smartphone and is 

mapped to the closest font available. Original fonts reappear on your computer.
� Number formats: Microsoft® Excel® 97 conditional formatting is displayed in number 

format. 
� Formulas and functions: Unsupported functions are removed, and only the returned value 

of the function appears. Formulas containing the following are also converted to values: 
� More than 512 bytes

� An array or array argument, for example, =SUM({1;2;3;4}).

� External link references or an intersection range reference.

� References past row 16384 are replaced with #REF!.

Tip To copy a file from your computer to your Treo Pro smartphone, open My 
Computer or Windows Explorer on your computer, copy the file into the 
Mobile Device folder, and then sync.

Tip For simple calculations, use the Calculator (see “Calculator” on page 276). 
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� Protection settings: Most protection features are disabled but are not removed. You must 
remove the password protection in Microsoft® Office Excel® on your computer before 
editing the file on your smartphone. Rights-managed and password-protected files must 
be saved only in their original file format.

� Zoom settings: Worksheet-specific zoom settings are not retained. The zoom setting 
applies to the entire workbook. 

� Worksheet names: Names that refer to other workbooks, arrays, array formulas, or 
intersection ranges are removed from the name list, causing those formulas to be 
resolved as “#NAME?” All hidden names are not hidden. 

� AutoFilter Settings: AutoFilters that cause rows to be hidden are supported. Use the 
Unhide command to display hidden rows. Other AutoFilters are removed, but you can use 
the AutoFilter command in Excel Mobile to perform similar functions.

� Chart Formatting: All charts are saved as they appear in Excel Mobile. Unsupported chart 
types are changed to one of these supported types: Column, Bar, Line, Pie, Scatter, and 
Area. Background colors, grid lines, data labels, trend lines, shadows, 3D effects, 
secondary axes, and logarithmic scales are turned off.

� Hidden sheets. Hidden worksheets are displayed.
� Excel 2007 Binary workbooks. You cannot open XLSB workbooks.
� Legacy files. PXL and PXT files can be opened, but must be saved in XLS or XLT format.
� File conversions. You cannot save a file with an XLS or XLT extension as an XLSX or XLTX 

file, respectively, and vice versa. 

The following features are not supported in Excel Mobile and are removed or modified when 
you open a workbook on your Treo Pro smartphone:

� Dialog sheets and macro sheets. 
� VBA modules. 
� Text boxes.
� Drawing objects and pictures.
� Lists.
� Conditional formats and controls. 
� Pivot table data (is converted to values). 
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Creating a Workbook
1. Press Start  and select Office Mobile.

2. Select Excel Mobile .

3. If an empty workbook appears onscreen, go to step 4; if the workbook list appears 
onscreen, press New (left softkey).

4. Highlight a cell where you want to enter text or other information. 

5. Enter the information in the cell, and then press Return .

6. Repeat steps 4 and 5 to enter the remaining information.

7. Press OK  to save the file.

Creating a Workbook From a Template
1. Go to the workbook list. 

2. Select the list in the upper-left corner, and then select More Folders > Templates.

3. Open the template you want to use, and enter the information you want to include in the 
template.

4. Press Menu (right softkey) and select File > Save As.

5. Select Name and enter a new name for the workbook.

6. Select the Folder list, and then select the folder where you want to save the workbook.

7. Select the Type list, and select Excel 2007 Workbook.

8. Select Save.

Tip When you save a new workbook, it is automatically named BookX (where X 
is the next number in a sequence) and then placed in the workbook list.

To insert a symbol, place the insertion point where you want the symbol. 
Press Menu (right softkey) and select Insert > Symbol. Highlight the 
symbol you want to insert, and then select Insert.



Section 5B: Increasing Your Productivity 295

P
roductivityViewing a Workbook

1. Press Start  and select Office Mobile.

2. Select Excel Mobile .

3. In the workbook list, select the workbook you want to view.

4. Press View (left softkey) and then select any of the following:
� Full Screen: View as much data as possible on the screen. To return to the normal 

view, select Restore in the upper-right corner. 

� Zoom: Set the magnification level so that you can easily read the worksheet.

� Sheet: Switch to a different worksheet.

� Split: Divide the window into two scrollable areas. To move the split bar, tap and 
drag it. To remove the split bar, select View > Remove Split.

� Freeze Panes: Lock rows or columns so that they remain visible while you scroll. 
Highlight the cell at the juncture you want to lock before you select this command. 
To unlock the rows or columns, select View > Unfreeze Panes. 

� Toolbar: Set whether the toolbar appears onscreen.

� Status Bar: Set whether the status bar appears onscreen.

� Show: Set whether headings and scroll bars appear onscreen.

Tip To create a new template from a workbook, open the workbook you want to 
save as a template. Press Menu (right softkey) and select File > Save As. 
Select Name and then enter a name for the template. Select the Folders list 
and select Templates. Select Type and select Excel 2007 Template. Press 
OK.

Tip To jump to a cell or region, press Menu (right softkey) and select Edit > Go 
To. Select Cell reference or name and enter the target cell information or 
select Current region. Select OK.
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Calculating a Sum
1. Press View (left softkey) and select Toolbar.

2. Highlight the cell where you want to insert the sum.

3. Select Sum . 

4. Tap and drag the stylus across the cells you want to add. 

5. Press Return .

Entering a Formula
1. Highlight the cell where you want to enter the formula.

2. Enter an equal (=) sign followed by any values, cell references, name references, 
operators, and functions. Example: =(B4/25)+100=Revenue-Expenses 

3. Press Return . 

Referring to a Cell or Range in a Formula
1. Open the workbook where you want to refer to a cell or range in a formula.

2. Begin entering a formula in a cell.

3. Navigate to the cell you want to refer to in the formula. To refer to a range, tap and drag 
the stylus over the cells you want to include in the range.

4. Finish entering the formula and press OK .

Did you know? You can switch worksheets by selecting the sheet list at the bottom of the 
screen.
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Inserting a Function
1. Highlight the cell where you want to insert the function.

2. Press Menu (right softkey) and select Insert > Function.

3. Select the Category list, and then select the type of function 
you want to insert.

4. Select the Function list, and then select the specific function 
you want to insert.

5. Select OK.

Tip To refer to a cell from another worksheet in your formula, enter the 
worksheet name followed by an exclamation point (!) and the cell, range, or 
name reference. 
Example: =Sheet1!Earnings.

To create a 3-D reference in your formula, specify two or more sheets in a 
workbook. Use a colon between the first and last worksheet names.
Example: =SUM(Sheet2:Sheet6!$A$2:$C$5)

Did you know? To enter symbols that are not on the keyboard, such as the = sign, press Alt 
and select the symbol from the list.
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Entering a Sequence Automatically
1. Highlight both the cells containing the information you want 

to automate and the adjacent destination cells. 

2. Press Menu (right softkey) and select Edit > Fill. 

3. Select the Direction list, and then select the direction you 
want to populate.

4. Select the Fill type list, and then select Series. 

5. Select the Series type list, and then select the type of series 
you want. If you select Date or Number, enter a Step value 
increment. 

6. Select OK. 

Adding Cells, Rows, and Columns
1. Open the workbook you want to add to.

2. Highlight the area where you want to insert elements.

3. Press Menu (right softkey) and select Insert > Cells.

4. Select how you want to insert the elements:
� Shift cells right: Insert a new cell. The highlighted cell and all cells on the right move 

one column to the right.

� Shift cells down: Insert a new cell. The highlighted cell and all cells below it move 
down. 

� Entire row: Insert a new row. The entire row in which the highlighted cell is located 
and all rows below it move down.

Tip Select Autofill as the series type to quickly fill cells with repetitive data such 
as numbers or repeated text. Autofill takes the content of the first cell in the 
highlighted row or column and copies it down or across the rest of the 
selection.
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� Entire column: Insert a new column. The entire column in which the highlighted 
cells are located and all columns to the right move one column to the right.

5. Select OK.

Formatting Cells
1. Open the workbook you want to format.

2. Highlight the cells you want to format.

3. Press Menu (right softkey) and select Format > Cells.

4. Select any of the following:
� Size: Set the row height and column width.

� Number: Set the format for the numbers in the cells.

� Align: Set whether text wraps within the highlighted cells, and set the horizontal and 
vertical alignment position.

� Font: Set the typeface, color, size, and style attributes.

� Borders: Turn borders on and off for various cell edges, and set the border and 
background colors.

5. Press OK .

Tip To add a new worksheet, press Menu (right softkey) and select Format > 
Modify Sheets. Select Insert, enter a name for the worksheet, and then 
press OK. To change the order of the worksheets, highlight a worksheet 
you want to move, and then select Move Up or Move Down. Press OK.

Tip To name the highlighted cell or range of cells, press Menu (right softkey) 
and select Insert > Define Name. Enter the name and select Add. Press 
OK.
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Formatting Rows and Columns
1. Open the workbook you want to format.

2. Highlight the rows or columns you want to format.

3. Press Menu (right softkey) and then select Format > Row or Format > Column.

4. Select any of the following:
� AutoFit: Adjust the size of the highlighted rows or columns to their contents.

� Hide: Hide the highlighted rows or columns.

� Unhide: Display hidden rows or columns in the highlighted area.

Renaming a Worksheet
1. Open the workbook containing the worksheet you want to rename.

2. Press Menu (right softkey) and select Format > Modify Sheets.

3. In the Sheets list, highlight the worksheet you want to rename.

4. Select Rename, enter a new name for the worksheet, and then press OK  twice.

Sorting Information in a Worksheet
1. Highlight the cells you want to sort.

2. Press Menu (right softkey) and select Tools > Sort.

3. Select the Sort by list, and then select the primary sort column.

4. Check or uncheck the Ascending box to indicate whether you want to sort in ascending 
or descending order.

5. (Optional) Select the Then by lists, and then select second- and third-level sorting 
options.

Did you know? You can adjust the column or row size by tapping and dragging the right 
edge of the column header or the bottom edge of the row header. To 
automatically fit rows and columns to their contents, double-tap the lower 
edge of the row heading or the right edge of the column heading.
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6. Check or uncheck the Exclude header row from sort box to indicate if you want to sort 
the header row.

7. Select OK.

Filtering Information in a Worksheet
1. Highlight the cells that contain the information you want to filter.

2. Press Menu (right softkey) and select Tools > AutoFilter. (A list appears at the top of 
each related column.)

3. Select one of the new lists, and then select a filter. (This hides all rows that do not 
include the selected filter.) 

4. (Optional) Select the other lists, and then select other filters.

Creating a Chart
1. Open the workbook you want to create a chart from.

2. Highlight the cells you want to include in the chart.

3. Press Menu (right softkey) and select Insert > Chart.

4. Select the type of chart, and then press Next (right softkey).

5. Confirm the data range you want to chart, and then press Next (right softkey).

6. Select the data layout, and then press Next (right softkey).

7. Check the boxes to indicate whether the first row and column of the data range 
represent labels.

Tip To display all rows again, select the filter list and then select All. To turn off 
filtering, press Menu (right softkey) and select Tools > AutoFilter again.

Did you know? You can also create custom filters where you specify comparisons. Select 
the filter list, and then select Custom.
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8. Select whether you want the chart to appear as a separate worksheet within the current 
workbook, or as part of the current worksheet. 

9. Press Finish (right softkey).

Formatting or Changing a Chart
1. Open the workbook that contains the chart you want to format.

2. Open the chart.

3. Press Menu (right softkey) and select Format > Chart.

4. Select any of the following:
� Titles: Set the title of the chart and the headings, whether a legend appears, and the 

placement of the legend.

� Scale: Set the minimum and maximum scales for charts with an x or y axis.

� Type: Set the chart style. You can use this setting to convert your chart to a different 
format.

� Series: Add, modify, format, or delete related data points without affecting the 
information in your worksheet.

5. Press OK .

Finding or Replacing Information in a Workbook
1. Open the workbook containing the information you want to find.

2. Press Menu (right softkey) and select Edit > Find/Replace.

3. Select Find what and enter the information you want to find.

4. (Optional) Check the Match case box to find text that matches the capitalization in any 
text you entered.

5. (Optional) Check the Match entire cells box to find only full words that match any text 
you entered.

6. Select Find to locate the first instance of the information you entered, or select Replace 
and enter the replacement information.



Section 5B: Increasing Your Productivity 303

P
roductivity

7. Select Next to find the next instance of the information, or select Replace to replace it. 
(To replace all instances of the information, select Replace All.) 

8. When you see a message indicating that the search is done, press OK .

Organizing Your Workbooks
You can rename your workbooks and move them to another folder and between your 
Treo Pro smartphone and an expansion (storage) card.

1. Go to the workbook list.

2. Highlight a file.

3. Press Menu (right softkey) and select Rename/Move.

4. Select Name and then enter a new name for the workbook.

5. Select the Folder list, and then select the folder you want to move the workbook to.

6. Select the Location list, and then select Main memory or Storage card.

7. Press OK .

8. Select the list in the upper-left corner, and then select the folder you want to view.

9. Select the list in the upper-right corner, and then select the sort method.

Deleting Cells, Rows, and Columns
1. Open the workbook containing the elements you want to delete.

2. Highlight the area you want to delete.

3. Press Menu (right softkey) and select Edit > Delete Cells.

4. Select how you want to remove the elements:
� Shift cells left: Delete the highlighted cells and moves all cells on the right one 

column to the left. 

Tip When you go to a folder, you can easily search your documents by sorting 
by type. 
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� Shift cells up: Delete the highlighted cells and moves all cells below them up. 

� Entire row: Delete the entire row in which the highlighted cells are located, and 
moves all rows below it up. 

� Entire column: Delete the entire column in which the highlighted cells are located, 
and moves all columns on the right one column to the left. 

5. Press OK .

Customizing Excel Mobile
1. Go to the workbook list.

2. Press Menu (right softkey) and select Options.

3. Set any of the following options:
� Template for new workbook: Set the default template for new workbooks.

� Save new workbooks to: Set where new workbooks are stored.

� Files to display in list view: Set which types of files appear in the workbook list.

4. Press OK .

Did you know? Excel Mobile adjusts formulas to reflect the new cell locations. However, a 
formula that refers to a deleted cell displays the #REF! error value.

Tip To delete a workbook, go to the workbook list and highlight the workbook 
you want to delete. Press Menu (right softkey) and select Delete. Select Yes 
to confirm.

To delete a worksheet, open the workbook that contains the worksheet you 
want to delete. Press Menu (right softkey) and select Format > Modify 
Sheets. Highlight the worksheet you want to delete, and then select Delete. 
Select Yes to confirm the deletion, and then press OK.
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OneNote® Mobile

OneNote® Mobile lets you create digital notes that contain text, pictures, and audio and video. 
You can then synchronize these notes with Microsoft Office OneNote 2007 on your computer. 
During synchronization, all the notes you create on your Treo Pro smartphone are copied to a 
notebook called OneNote Mobile on your computer; you can then drag your notes to other 
locations on your computer. You can use OneNote Mobile to do any of the following:

� Take pictures of business cards and then insert them into OneNote. 
� Take pictures of flip charts and whiteboards in conference rooms and then insert them 

into OneNote. 
� Enter text and insert voice recordings (for example, reminders of important events, ideas 

for projects, price comparisons, recommendations, blog ideas, and so on) and 
synchronize them with your notes. 

� Prepare meeting or travel information in OneNote on your computer and then transfer it to 
your smartphone so you can access the information on the road. 

Creating a New Note
Just like in Office OneNote 2007 on your computer, OneNote Mobile continuously saves your 
note as you create, edit, and close a note.

1. Press Start  and select Office Mobile.

2. Select OneNote Mobile .

3. Press New (left softkey). 

4. Enter your note text.

5. (Optional) Do any of the following:
� Format text: Place the cursor in the middle of the word that you want to format, 

press Menu (right softkey), select Format, and select a style. To clear all formatting 
for the selected text, press Menu (right softkey), and select Format > Clear All.
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� Create a numbered list: Place the cursor where you want the list to begin, press 
Menu (right softkey), and select List > Numbered. To clear the numbered list 
formatting, place the cursor on any list item, press Menu (right softkey), and select 
List > Clear.

� Create a bulleted list: Place the cursor where you want the list to begin, press Menu 
(right softkey), and select List > Bulleted. To clear the bulleted list formatting, place 
the cursor on any list item, press Menu (right softkey), and select List > Clear.

� Create a hyperlink: Enter the Web site address for which you want to create the 
hyperlink. For example, to create a hyperlink to the Microsoft Web site, type 
http://www.microsoft.com.

� Insert a new picture: Press Menu (right softkey), select Take Picture, press Center  

to take the picture, and then press OK  to insert it into your note. 

� Insert an existing picture: Press Menu (right softkey), select Insert Picture, and then 
select the picture to insert it into your note. 

� Insert a voice note: Press Menu (right softkey), select Insert Recording, and then 
select Record  to begin recording. After you finish recording, select Stop .

6. Press Done (left softkey). (The first line of text in the note becomes the note name. You 
can rename the note later.)

Viewing or Editing an Existing Note
1. Press Start  and select Office Mobile.

2. Select OneNote Mobile .

3. In the OneNote Mobile list, select the note that you want to open. 

Tip While taking notes, you can undo a mistake by pressing Menu (right 
softkey) and selecting Undo.
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4. Do any of the following:

� Open a hyperlink: Place the cursor anywhere in the link, and then press Center .

� View picture detail: Highlight the picture, press Center , press Menu  (right 
softkey), and then select Zoom In. To zoom in further, press Menu (right softkey) and 
select Zoom In again. Use the 5-way to view different parts of the picture. To zoom 
out, press Menu (right softkey) and select Zoom Out; you can also select Actual Size 

or Fit to Screen. To close the picture, press OK . 

� Play a voice note: Highlight the voice note and press Center . To close the voice 

note, press OK 

5. Press Done (left softkey) to close the note.

Renaming a Note
1. In the OneNote Mobile list, select the note that you want to rename. 

2. Press Menu (right softkey) and then select Rename.

3. Enter the new name.

4. Press Done (left softkey) to accept the new name.

Sorting your Notes
1. From the OneNote Mobile list, press Menu (right softkey), and then select Options.

2. Select the method you want to use to sort your notes: Name or Date modified.

3. Press Done (left softkey) to sort your notes.

Deleting a Note
1. In the OneNote Mobile list, select the note that you want to delete. 

2. Press Menu (right softkey) and then select Delete.

3. Select Yes to confirm the deletion.
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Adobe® Reader® LE

Adobe® Reader® LE lets you view PDF files whether they are saved to your device, attached to 
email messages, stored on an expansion card (sold separately) inserted into your device’s 
expansion card slot, or downloaded from the Web. You can customize the document display.

Viewing a File
Adobe Reader LE supports password-protected PDF files with up to 128-bit encryption. When 
you open a password-protected PDF file, you must enter the password to open the file.

1. Press Start  and select Programs.

2. Select Adobe Reader .

3. Navigate to and select the file you want to open.

Did you know? You can use the Files sync folder to transfer PDF files between your 
computer and your Treo Pro smartphone. The process is the same as 
transferring Microsoft Office files. See “Synchronizing Microsoft® Office and 
Other Files” on page 280 for details.

Tip To open additional files, press Menu (right softkey) and select Open. Select 
the file you want from the list, or select Browse to navigate to and select the 
file.
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4. Press Down  to scroll to the next page (in Single Page 
mode) or scroll the continuous display down (in Continuous 
mode). Press Up  to scroll to the preceding page or scroll 
the continuous display up.

5. Tap any of the following to change the view and move 
around within the PDF file:

6. To open another file, press Menu (right softkey) and select 
Open. Select a recently opened file, or select Browse and 
navigate to the file you want.

Fit the full width of the page on the screen.

Fit the whole page on the screen.

Move to the next page.

Move to the previous page.

Jump to the first page of the file.

Jump to the last page of the file.

Search for a word in the document.

Zoom out.

Zoom in.
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Changing Display Options
You can change the display size, the scroll option, and more.

1. Press Tools (left softkey), select View, and then select any of the following:
� Rotate Right/Left: Rotates the page in the selected direction.

� Single Page: Displays the pages so that when you use Up  or Down  to scroll 
the file, the display jumps a page at a time.

� Continuous: Displays the pages so that when you use Up  or Down  to scroll 
the file, the display scrolls continuously up or down without jumping.

2. Press Tools (left softkey), select Zoom, and then select one of the following options:
� In: Increases the file display size to enlarge font and image size.

� Out: Decreases the file display size to fit more of the file on the screen.

� To %: Specifies a specific zoom level for the display.

� Fit screen: Sizes the display so an entire page fits on the screen from top to bottom.

� Fit width: Sizes the display so that the width of the page fills the display from side to 
side.

Finding Text in a File
1. With the file open, tap the Find  icon, or press Tools (left softkey) and select Find > 

Text.

2. Enter the text you want to find.

Tip To go to a specific page, press Tools (left softkey) and select Go To.

If the file was created with bookmarks, Adobe Reader LE displays the 
bookmarks pane on the left side of the screen. Select a heading in the 
bookmarks pane to jump to that section.

To view detailed information about the file you are viewing, press Menu 
(right softkey) and select Details.
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3. (Optional) Check the Match case box to find text that matches the capitalization in the 
text you entered.

4. (Optional) Check the Whole word box to find only full words that match the text you 
entered.

5. (Optional) Check the Backwards box to search the file backwards.

6. Press Find (left softkey).

7. To find the next occurrence of the text, press Tools (left softkey) and select Find > Next.
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Finding Information

You can find information quickly with the built-in search features on your Treo™ Pro 
smartphone by Palm:

� Lookup: Find and dial your contacts by contact name, company name, or phone number. 
(See “Dialing by Contact Name” on page 77 and “Dialing by Company Name” on 
page 78 for details.)

� Search: Look through the text in all the applications on your smartphone.
� File Explorer: Browse through the files and folders on your smartphone or on an 

expansion card.
� Global Address Lookup: Look up names in your online corporate address list.
� Live Search: Start a Web search directly from your Today screen. (See “Searching the 

Web From Your Today Screen” on page 197 for details.)

Using Search
Search for files and other items stored in the My Documents folder on your smartphone or on 
an expansion card. You can search by file name or by words located in the item. For example, 
you can search for words within notes, appointments, contacts, and tasks. 

1. Press Start  and select Programs.

2. Select Search .

3. Select Search for, and then enter the file name, word, or 
other information you want to find. 

4. Select the Type list, and then select the kind of information 
you want to find. 

5. Press Search (left softkey). 

6. Use the 5-way to select and view an item from the results.
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Exploring Files and Folders
You can use File Explorer to browse the contents of folders on your Treo Pro smartphone or 
an expansion card (sold separately). The root folder on your smartphone is named My Device. 
My Device is similar to My Computer (Windows XP) or Computer (Windows Vista®) on your 
computer.

1 Show List
2 Sort by List

1. Press Option  + Start  to open File Explorer.

2. Tap the list in the upper-left corner, and then select the folder you want to explore. 

Tip To find an item you’ve looked for before, select the Search for list and then 
select the item in the list.

 You can also open the Search screen by pressing Option + Shift.

Did you know? You can sort the contents of a folder by name, date, size, or type. Select the 
list in the upper-right corner, and then select the sort method.

2
1
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3.  Do any of the following:
� To open an item, select it. 

� To decompress a ZIP file, tap it.

� To quickly delete, rename, beam, or email an item, highlight the item, press and 
hold Center  to open the shortcut menu, and then select the appropriate 
command. 

� To move or copy a file to another folder, highlight the item, press and hold 
Center  to open the shortcut menu, and then select Cut or Copy. Open the 
destination folder, press and hold Center  to open the shortcut menu, and then 
select Paste.

� To highlight multiple items, tap and drag the stylus. 

4.  Press OK .

Installing Applications

Your Treo Pro smartphone comes with several built-in and ready-to-use applications. You can 
also install other third-party applications that are compatible with devices running Microsoft® 
Windows Mobile® 6.1 Professional edition, such as business software, games, and more.

Applications you download to your computer are likely to be in a compressed format, such as 
ZIP. If the file is compressed, you need to decompress the file before you install the 

Note To compress files, you must use a compression program, such as WinZip, 
on your computer. You cannot compress files on your Treo Pro smartphone.

Important Do not delete any files that you cannot identify. These files may be required 
for your Treo Pro smartphone to function properly.
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application on your device. You can decompress the file on your Treo Pro smartphone in File 
Explorer or on your computer in a decompression program, such as WinZip.

The following instructions tell you how to install basic files onto your Treo Pro smartphone. 
Some software uses an installer or wizard to guide you through the process. For details, 
consult the documentation that came with the software.

Purchasing Applications From the Sprint Mobile Software Store
You can use Software Store to purchase and install applications directly from the Sprint 
Mobile Software Store Web site onto your Treo Pro smartphone.

1. Make sure that your phone is on (see “Turning Your Phone On and Off” on page 34).

2. Press Start  and select Programs.

3. Select Software Store .

4. Select a category link.

5. Select the Buy Now link below the item you want to purchase.

6. Follow the onscreen prompts to complete the transaction.

Did you know? You can also send the file to yourself as an email attachment and then open 
the email message on your Treo Pro smartphone, and tap the attachment to 
automatically decompress the file.

Tip If an application does not have a Microsoft Mobile to Market certificate, a 
message appears, indicating that the application is untrusted. If this occurs, 
you can indicate whether you want to continue the installation.

Be sure to select and install applications that are compatible with Windows 
Mobile 6.1 Professional. Applications that are designed for other versions of 
Windows Mobile may not be compatible with your Treo Pro smartphone.
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Installing Applications From Other Web Sites on the Internet
You can use Internet Explorer® Mobile to install Windows Mobile applications in the CAB file 
format directly from the Internet. For files in the ZIP file format, you must unzip the files in File 
Explorer before you install them. For files in any format other than CAB or ZIP, you must first 
download the files to your computer and then install them to your Treo Pro smartphone by 
synchronizing.

1. Make sure that your phone is on (see “Turning Your Phone On and Off” on page 34).

2. Press End  to go to the Today screen, and press Internet Explorer (right softkey).

3. Go to the page that contains the link to the application you want to download.

4. Press Left  or Right  to highlight the link to the file, and then press Center  to start 
the download process.

5. If prompted, select the folder where you want to store the file.

6. When the download is complete, press Start  and select File Explorer.

7. Go to the folder you selected in step 5.

8. Select the file you downloaded to start the installation program.

Installing Applications From Your Computer
There are many applications available for your Treo Pro smartphone. To get started, check out 
the selection at palm.com/support.

1. On your computer, open My Computer or Windows Explorer (Windows XP) or Computer 
(Windows Vista). 

2. Copy the application file(s) into the  Mobile Device folder.

3. Connect your smartphone to your computer to synchronize and install the application(s) 
on your device.

Before You 
Begin

To install an application from your computer, you must first install the 
desktop sync software on your computer (see “Setting Up Your Computer 
for Synchronization” on page 44).

http://www.palm.com/support
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Installing Applications Onto an Expansion Card
1. Insert the expansion card into the expansion card slot on your smartphone (see 

“Inserting and Removing Expansion Cards” on page 324).

2. Connect your smartphone to your computer.

3. On your computer, open the ActiveSync® window (Windows XP) or Windows Mobile 
Device Center (Windows Vista).

4. Click Explore .

5. Double-click My Windows Mobile-Based Device  to open the Mobile Device folder.

6. Copy the application file(s) into the Storage Card folder inside the Mobile Device folder.

Getting Help With Third-Party Applications
If you encounter a problem, such as an error message, with a third-party application, contact 
the application’s author or vendor. For general troubleshooting of third-party applications, see 
“Third-Party Applications” on page 402.

Make sure that the third-party application supports 320 x 320 screen resolution. Some older 
applications have screen-size limitations. Third-party applications should also be written for 
Windows Mobile version 6.1 or later. Programs written for earlier versions may not support 
5-way navigation or softkeys and can have performance problems.

Tip Before purchasing a third-party program, try the free version (if available) to 
make sure the program works properly with Windows Mobile 6.1 and your 
Treo Pro smartphone.
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Removing Applications

To free up storage space on your smartphone, you can remove 
applications that you no longer use. You can remove only 
applications, patches, and extensions that you install; you cannot 
remove the built-in applications that reside in the 
Read-Only-Memory (ROM) portion of your device.

1. Press Start  and select Settings.

2. Select the System tab, and then select Remove 
Programs .

3. Highlight the application that you want to remove.

4. Select Remove.

5. Select Yes to confirm the deletion.

Sharing Information

Your Treo Pro smartphone comes equipped with a variety of options for sharing information, 
so that you can choose the quickest, most convenient way to send your information or to 
receive information from another device.

� In many applications, you can send a file or an entry by email or beaming. Open the 
application to the file or entry list and highlight the item you want to send. Press Menu 
(right softkey) and select the Send or Beam option.

� In the Messaging application, you can insert a picture or attach a note or other file to an 
email. You can also receive pictures and attachments (see “Sending and Receiving Email 
Messages” on page 137).

Tip Some applications are factory-installed on your Treo Pro smartphone and 
cannot be deleted. These are not included on the Remove Programs list.
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� You can attach a picture, video, or sound file to a multimedia message (see “Creating and 
Sending a Multimedia Message” on page 161).

� You can synchronize to share info between your device and your computer or between 
your device and Microsoft Exchange Server 2003 or 2007 (see “Synchronizing 
Information” on page 331).

� If you are near someone, you can beam files and applications between your device and 
your neighbor’s device using the IR port or Bluetooth® wireless technology (see “Beaming 
Information” on page 218).

� You can also store files on an expansion card and share the expansion card (see the next 
section, “Using Expansion Cards”).

Using Expansion Cards

The expansion card slot on your Treo Pro smartphone enables you to add microSDTM cards to 
extend the storage capacity of your device. (Expansion cards are sold separately.) For 
example, expansion cards can store the following, and more:

� Documents (Microsoft Office, text, and PDF).
� Email attachments.
� Pictures.
� Videos.
� Audio and music files.
� Games.
� Applications.

Tip We recommend that you purchase preformatted expansion cards. To format 
a card on your own, you may need to connect a card reader (sold 
separately) to your computer.
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Inserting and Removing Expansion Cards
1. Remove the back panel (see “Removing the Back Panel” on page 25).

2. Insert the card with the label facing up and the notch pointing toward the Wi-Fi button.

3. Push the card into the slot until you feel the card click into place. To remove a card, push 
the card in to release it.

1 Notch
2 Wi-Fi Button

4. Slide the back panel back into place.

Tip Your Treo Pro smartphone has a push-push mechanism: push in gently to 
insert a card; push in gently to remove it.

21
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Opening Applications on an Expansion Card
After you insert an expansion card into the expansion card slot, you can open any of the 
applications stored on the expansion card.

1. Insert the expansion card into the expansion card slot. 

2. Press Option  + Start  to open File Explorer.

3. Select the list in the upper-left corner, and then select Storage Card.

4. Select the application you want to open. 

Saving Files to an Expansion Card
You can save space on your smartphone by saving files to an expansion card. For example, 
when you create new Word Mobile documents, notes, Excel® Mobile workbooks, pictures, 
videos, and audio files, you can save them directly to an expansion card. (Some applications 
may not support this feature.)

1. Insert an expansion card into the expansion card slot. 

2. Open the application that contains the information you want to save.

3. Press Menu (right softkey) and select Options or Tools (depending on the application).

4. Select the Save to list, and then select Storage Card.

5. Press OK .

Tip To run an application on an expansion card, your Treo Pro smartphone must 
have enough free space in the internal memory.

Tip If you don’t see the Save to list on the Options screen, look on the other 
tabs (if present). If you still can’t find a Save to list, the application may not 
support this feature.

Did you know? You can create folders on your expansion card so that it’s easy to find your 
files when you need them.
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Moving Information Between Your Treo™ Pro Smartphone by Palm and 
an Expansion Card

1. Insert an expansion card into the expansion card slot. 

2. Open the application that contains the information you want to move.

3. Go to the list view and highlight the item(s) you want to move.

4. Press Menu (right softkey) and select Rename/Move.

5. Select the Location list, and then select where you want to move the information: 
Storage Card or Main Memory.

6. Press OK .

Copying or Moving Applications and Files Between Your Treo Pro Smartphone 
and an Expansion Card

1. Insert the expansion card into the expansion card slot. 

2. Press Option  + Start  to open File Explorer.

3. Select the file or application that you want to copy or move (see “Exploring Files and 
Folders” on page 317).

4. Press Menu (right softkey) and select Edit > Copy or Edit > Cut.

5. Go to the folder where you want to place the selected item.

6. Press Menu (right softkey) and select Edit > Paste.

7. Press OK .

Tip Your applications are usually located in the My Device/Program Files folder.
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Viewing Available Expansion Card Memory
You can view how much space is available on the expansion card that is currently in the 
expansion card slot.

1. Insert the expansion card into the expansion card slot. 

2. Press Start  and select Settings.

3. Select the System tab, and then select Memory .

4. Select the Storage Card tab.

5. After you finish viewing the information, press OK .

Exploring Files on an Expansion Card
1. Insert the expansion card into the expansion card slot. 

2. Press Option  + Start  to open File Explorer.

3. Tap the list in the upper-left corner, and then select Storage Card.

4. Select the folder or files you want to view. 

5. After you finish viewing the information, press OK .

Renaming Files on an Expansion Card
If you change the contents of an expansion card, you may at some point want to rename the 
files or folders to better match their contents.

1. Insert the expansion card into the expansion card slot. 

2. Press Option  + Start  to open File Explorer.

3. Tap the list in the upper-left corner, and then select Storage Card.

4. Highlight the file or folder you want to rename.

5. Press Menu (right softkey) and select Rename.
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6. Enter the new name, and then press Center .

7. Press OK .

Encrypting an Expansion Card
When you encrypt an expansion card, the info on the card can be read only by your Treo Pro 
smartphone—so no one can see what’s on the card if it is lost or stolen.

1. Insert the expansion card into the expansion card slot.

2. Press Start  and select Settings.

3. Select the System tab, and then select Encryption .

4. Check the Encrypt files placed on storage cards box.

5. Press OK .

Accessing Information on a Remote Computer

Remote Desktop Mobile is a technology that allows you to use your device to connect to a 
remote computer in a different location. For example, you can connect to your work computer 
and have access to all of your applications, files, and network resources as though you were 
in front of your computer at work. You can leave applications running at work and then see 
your work computer’s desktop displayed on your device, with the same applications running.

Tip Before copying information to or renaming the files or folders on an 
expansion card, make sure the card is not write-protected. For details, see 
the instructions that came with your card.

Note If your organization enforces an encryption policy, you can see that the box 
is checked but you cannot uncheck it.
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Accessing a Remote Computer
1. Press Start  and select Programs.

2. Select Remote Desktop Mobile .

3. Enter the name of the computer you want to access. (If you are accessing a computer 
you’ve already entered, select the computer name from the list.)

4. Enter the user name, password, and domain you use to access the remote computer.

5. Press OK .

Customizing Remote Desktop Mobile
1. Press Start  and select Programs.

2. Select Remote Desktop Mobile .

3. Press Menu (right softkey) and select Options.

4. On the Display tab, select any of the following options:
� Colors: Set how to display colors from the remote computer on your device screen.

� Full screen: Set whether you want the remote computer display to take up your 
entire device screen.

� Fit remote desktop to screen: Set whether you want to resize the remote computer 
display so that the entire display fits on your device screen.

5. Select the Resources tab, and then select one or both of the following options:
� Device storage: Set whether to map your device’s storage memory to the remote 

computer.

� Remote desktop sound: Set whether sounds from the remote computer are muted 
completely, played on the remote computer, or played on your device.

6. Press OK .

Before You 
Begin

The remote computer must be set up for remote control. Ask the remote 
computer administrator for your computer user name, password, and 
domain if you don’t know them.
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Synchronizing Information

Sect ion 6B

In This Section

� Setting Up Wireless Synchronization

� Other Ways to Synchronize

� Changing Which Applications Synchronize

� Stopping Synchronization

When you synchronize, the information you enter on your Treo™ Pro smartphone by Palm, 
your computer, or your corporate server is automatically updated in the other location. There’s 
no need to enter the information twice. This is true whether you sync with your computer 
using desktop synchronization software (see “Setting Up Your Computer for Synchronization” 
on page 44) or you sync wirelessly with your company’s Exchange server (see “Setting Up 
Wireless Synchronization” on page 332).
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Setting Up Wireless Synchronization

If your company uses Microsoft Exchange Server 2007 or Exchange Server 2003 upgraded 
to Service Pack 2, you may be able to take advantage of Microsoft Direct Push technology. 
Direct Push technology is a two-way wireless delivery method that keeps your Microsoft® 
Outlook® information up-to-date by providing efficient communication between the server and 
your Treo Pro smartphone. You may also have access to other features such as Global 
Address List; Tasks Over The Air (OTA); and IP-based push updating of Calendar, Tasks, and 
Inbox.

1. Work with your system administrator to gather the following information for your 
Exchange Server account:

� Mail server address and domain name.

� The user name and password you use to access your corporate mail server.

� Security connection: Does your server use an encrypted (SSL) connection?

2. Press Start  and select Programs.

3. Select ActiveSync .

4. Press Menu (right softkey) and select Add Server Source. 

Did you know? Because your desktop copy of Outlook also syncs with the server, whatever 
syncs to the server from your Treo Pro smartphone also shows up in 
Outlook; and whatever you enter or change in Outlook on your computer 
syncs to the server and then shows up on your smartphone.

Before You 
Begin

If you installed ActiveSync desktop software on a Windows XP computer, 
you may have already set up your Treo Pro smartphone to synchronize 
wirelessly with the server. To check, on your smartphone, press Start, select 
Programs, and then select ActiveSync. Press Menu (right softkey). If 
Configure Server appears instead of Add Server Source, wireless sync is 
already set up, and you can skip this procedure.
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5. Enter the email address that you want to set up.

6. Uncheck the box to detect the Exchange server settings, and then press Next (right 
softkey).

7. If prompted, enter the Server address and check the box if the server requires SSL 
encryption, and then press Next (right softkey).

8. Enter the user name and password that you use to access your corporate mail server, 
and enter the Exchange server domain. 

9. Ask your system administrator if it is OK to store your corporate email password on your 
smartphone, and then do either of the following:

� If it is OK, check the Save password box and press Next (right softkey).

� If it is not OK, do not check the Save password box, and press Next (right softkey). 
(You must synchronize manually; see “Initiating a Wireless Sync Manually” on 
page 335 for details.)

Tip The Exchange Server settings are case-sensitive. Be sure to enter 
uppercase and lowercase letters properly. Be especially careful when 
entering the password, because it does not appear on the screen as you 
enter it. See “Entering Lowercase and Uppercase Letters” on page 62 and 
“Entering Numbers, Punctuation, and Symbols” on page 63.
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10. Check the boxes for the types of information you want 
to sync with the Exchange server.

11. (Optional) Highlight an item and select Settings to change 
the synchronization settings for that type of information. 
(Settings are not available for all items.) 

12. (Optional) Press Menu (right softkey) and select Advanced 
to set the rules for fixing sync conflicts.

13. Press Finish (left softkey). (Synchronization with 
your Exchange server begins automatically and onscreen 
messages indicate sync progress.)

Setting the Synchronization Schedule
You can set a synchronization schedule in either of the following situations:

If you use Microsoft Exchange Server 2007, or Microsoft Exchange Server 2003 upgraded to 
Service Pack 2: By default, wireless sync takes place anytime info is updated on either your 
device or the server using Microsoft Direct Push. To save battery life, however, you can set 
synchronization to take place at intervals that you specify.

If you use Microsoft Exchange Server 2003 that is not upgraded to Service Pack 2: By 
default, wireless sync does not take place automatically. Set a synchronization schedule to 
have synchronization take place either anytime info is updated on your device or the server, 
or at certain intervals.

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu (right softkey) and select Schedule. 

Tip To automatically download more of an incoming email message than the 
default setting, select E-mail in step 10, select Settings, and select a higher 
number from the Download size limit list. If you don’t increase this setting, 
you can manually download the rest of the message at your convenience.
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4. Set any of the following options:
� Peak times: Set the frequency for high-traffic time 

periods, such as when you are at work or when email 
volume is high.

� Off-peak times: Set the frequency for low-traffic time 
periods, such as late at night. 

� Use above settings when roaming: Set the frequency 
while you are roaming outside the Sprint network. You 
should keep this box checked to ensure that wireless 
sync works properly.

� Send/receive when I click Send: Set whether items are 
sent as soon as you select Send in the Messaging 
application, or whether they are held until the next 
synchronization. 

5. (Optional) To customize your high-traffic periods, select 
the peak times link at the bottom of the screen and adjust 
the days and times. (For example, if you work Thursday 
through Tuesday, you can select those days as your peak 
times instead of Monday through Friday.)

6. Press OK .

Initiating a Wireless Sync Manually
If you want to control exactly when a wireless sync takes place, or if it is not OK to store your 
corporate email password on your Treo Pro smartphone, you can initiate sync manually.

1. To set up manual sync, follow the preceding procedure, “Setting the Synchronization 
Schedule” on page 334. In the Peak times and Off-peak times lists, select Manually.

2. To initiate a manual sync, press Start  and select Programs.

3. Select ActiveSync .

4. Press Sync (left softkey).



336 Section 6B: Synchronizing Information

Other Ways to Synchronize

Synchronizing Over a Bluetooth® Wireless Technology Connection
If your computer is equipped with Bluetooth® wireless technology, you can use a Bluetooth 
connection to synchronize your computer and Treo Pro smartphone.

1. Do one of the following:

� Windows XP: On your computer, right-click the ActiveSync  icon in the taskbar in 
the lower-right corner of the screen, and select Connection Settings.

� Windows Vista®: Click Start > All Programs > Windows Mobile Device Center. Select 
Connect without setting up your device, and then select Connection settings.

2. Check the Allow connections to one of the following box, and then select the Bluetooth 
COM port you set up on your computer.

3. On your smartphone, press Start  and select Settings.

4. Select the Connections tab, and then select Bluetooth .

5. Select the Mode tab and check the Turn on Bluetooth box.

6. Press Start  and select Programs.

7. Select ActiveSync .

8. Press Menu (right softkey) and select Connect via Bluetooth.

9. If this is the first time you’re making a Bluetooth connection to this computer, follow the 
onscreen prompts to set up a Bluetooth partnership with this computer. (See 
“Connecting to Devices With Bluetooth® Wireless Technology” on page 214 for more 
information on partnerships.)

Before You 
Begin

Make sure your computer is set up for synchronization (see “Setting Up 
Your Computer for Synchronization” on page 44).
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10. Select Sync.

11. When synchronization is complete, press Menu (right softkey) and select Disconnect 
Bluetooth.

Synchronizing Over an Infrared Connection
If your computer has an IR (infrared) port, you can synchronize with your computer wirelessly 
using the IR port on your smartphone.

1. Turn on the IR feature on your Treo Pro smartphone (see “Beaming Information” on 
page 218).

2. Set up your computer to receive infrared beams. See Windows Help on your computer 
for details.

3. On your smartphone, press Start  and select Programs.

4. Select ActiveSync .

5. Press Menu (right softkey) and select Connect via IR.

6. Point the IR port on your smartphone directly at your computer’s IR port.

Synchronizing With Multiple Computers
You can set up your Treo Pro smartphone to synchronize with up to two computers as well as 
with Exchange Server 2007 or Exchange Server 2003 upgraded to Service Pack 2. When 
synchronizing with multiple computers, the items that you sync appear on all the computers.

For example, if you set up to sync your smartphone with two computers, named C1 and C2, 
when you sync Contacts and Calendar on your smartphone with both computers, you get the 
following results: 

� The contacts and calendar appointments that were on C1 are now also on C2. 
� The contacts and calendar appointments that were on C2 are now also on C1. 
� The contacts and calendar appointments from both computers are on your smartphone. 

Note Microsoft® Office Outlook® E-mail can sync with only one computer.
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Changing Which Applications Synchronize

On your Treo Pro smartphone, you can choose which applications you want to sync.

1. Press Start  and select Programs.

2. Select ActiveSync . 

3. Press Menu (right softkey) and select Options.

4. Do any of the following: 
� Check the box next to any items you want to 

synchronize. If you cannot check a box, you may 
need to uncheck a box for the same information 
type elsewhere in the list. 

� Uncheck the boxes next to any items you want to stop 
synchronizing. 

� Select an item and then select Settings to customize 
the settings for that item. (Settings are not available 
for all items.)

5. Press OK .

Tip For information on synchronizing Microsoft Word documents, Microsoft® 
Excel® spreadsheets, Microsoft® PowerPoint® presentations, and Microsoft® 
OneNote notes, see “Synchronizing Microsoft® Office and Other Files” on 
page 280. For information on synchronizing pictures, videos, and music 
files, see “Synchronizing Your Media Files” on page 225.
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Stopping Synchronization

If you ever need to manually stop synchronization, follow these steps:

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Stop (left softkey).

Tip To end the sync relationship between your Treo Pro smartphone and a 
computer, so that items are no longer synchronized with that computer, 
select the computer name on the ActiveSync screen, and then select 
Delete.
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Customizing Your Treo™ Pro 
Smartphone by Palm

Sect ion 6C

In This Section

� Today Screen Settings

� System Sound Settings

� Display and Appearance Settings

� Application Settings

� Locking Your Treo Pro Smartphone and Information

� Entering Owner Information

� System Settings

� Connection Settings

� Purchasing Accessories for Your Treo Pro Smartphone
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Today Screen Settings

Selecting Your Today Screen Background
1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. On the Appearance tab, check the Use this picture as the 
background box.

4. Select Browse.

5. Select the picture you want to use.

6. Press OK .

Changing the System Color Scheme
1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. On the Appearance tab, select a theme in the list.

4. Press OK .

Tip For phone settings, see “Customizing Phone Settings” on page 96.

Tip To adjust the transparency of your background picture, see “Using a Picture 
as the Today Screen Background” on page 241. 
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Selecting Which Items Appear on Your Today Screen
1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. Select the Items tab.

4. Check the boxes next to the items that you want to appear 
on your Today screen, and uncheck any items you want to 
hide.

5. (Optional) Highlight an item and select Move Up or Move 
Down to change the order in which items appear on the 
Today screen.

6. (Optional) Highlight an item and select Options (if available) to configure the settings for 
the item, and then press OK  to return to Today Settings.

7. Press OK .

System Sound Settings

In certain situations, such as meetings and theaters, you need to turn off all sounds on your 
Treo Pro smartphone. You can immediately silence all sounds on your device, including 
phone ringtones, Calendar notifications, and system sounds. This does not mute the speaker 
during phone calls. 

Did you know?  Lots of third-party plug-ins are available for your Today screen. For clocks, 
calculators, MP3 players, weather guides, and much more, visit 
palm.com/support.

http://www.palm.com/support
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Setting the Ringer Switch
1. Slide the Ringer switch to Sound Off . 

2. To hear all sounds again, slide the Ringer switch to Sound On .

1 Sound On
2 Sound Off

If the Ringer switch is set to Sound Off , the Ringer setting overrides the sound settings and 
all sounds are turned off, including any music you may be playing. When you slide the Ringer 
switch back to Sound On , it restores the previous sound settings. All sounds are as loud 
or as soft as they were before you turned them off.

Selecting Sounds & Notifications
1. Press Start  and select Settings.

2. On the Personal tab, select Sounds & Notifications .

Did you know? Your Treo Pro smartphone includes a silent alarm that can vibrate even 
when the Ringer switch is set to Sound Off.

1 2
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3. On the Sounds tab, set any of the following options:
� Events: Turn sounds on and off for system warnings 

and error messages.

� Programs: Turn sounds on and off that are specific to 
the applications on your smartphone. 

� Notifications: Turn alarms and reminders on and 
off in all the applications on your smartphone.

� Screen taps: Set whether tapping the screen generates 
a sound, and set the volume level when this sound is 
turned on.

� Hardware buttons: Set whether pressing buttons generates a sound, and set the 
volume level when this sound is turned on.

4. Select the Notifications tab and set any of the following options:
� Event: Select which action you want to change the 

settings for. (The remaining options vary based on the 
action you select.)

� Play sound: Turn the sound on and off for the selected 
event. (To select a different sound, select the list to the 
right of this setting, and then select a different sound. To 
preview the sound, select Play .)

� Repeat: Set whether a Reminder tone plays more than 
once, if Play Sound is turned on.

� Display message on screen: Set whether a notification message appears onscreen 
for the selected event.

� Vibrate: Set whether your smartphone vibrates to notify you about the selected 
event.

5. Select the Manage tab and do any of the following:
� To record a sound, press Menu (right softkey) and select New Sound.

� To preview a sound, select it and then press Play (left softkey).
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� To delete a sound, highlight it and then press Backspace .

� To send a sound, highlight it, press Menu (right softkey), and then select Send 
Sound. 

6. Press OK .

Display and Appearance Settings

Adjusting the Brightness
1. Press Option  and then press P . 

2. Press Left  and Right  to adjust the brightness.

3. Press OK .

Changing the Text Size
1. Press Start  and select Settings.

2. Select the System tab, and then select Screen .

3. Select the Text Size tab. 

4. Press Left  and Right  to adjust the text size.

5. Press OK .

Tip You can turn the clock screen saver on and off. See “Viewing and 
Optimizing Power Settings” on page 364 for details.

Tip If text looks rough around the edges, open the Screen Settings screen and 
select the ClearType tab. Check the Enable ClearType box, and then press 
OK.
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Aligning the Screen to Correct Tapping Problems
Occasionally, your screen can move out of alignment, activating the wrong feature when you 
tap the screen. If this occurs, you need to align your screen.

1. Press Start  and select Settings.

2. Select the System tab, and then select Screen .

3. On the Alignment tab, select Align Screen. 

4. Tap the screen where indicated.

Setting Display Formats
1. Press Start  and select Settings.

2. Select the System tab, and then select Regional Settings .

3. On the Region tab, select a region from the list. (The region selection sets the default 
format settings.)

4. (Optional) Select any of the following tabs to customize the 
format settings:

� Number: Set the decimal symbol and number of 
decimal places, the digit-grouping symbol and group 
size, list separators, negative number sign symbol and 
format, leading zero display, and measurement system 
(metric versus U.S.).

� Currency: Set the currency symbol and position, the 
decimal symbol and position, the digit-grouping 
symbol and group size, and the negative number 
format.

� Time: Set the time style, separators, and AM and PM symbols.

� Date: Set the short date style, separators, and long date style.

5. Press OK .
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Application Settings

Arranging the Start Menu
You can select which applications appear on the Start menu. You 
can still access the remaining applications by selecting Programs 
from the Start menu, and then selecting the application’s icon.

1. Press Start  and select Settings.

2. On the Personal tab, select Menus .

3. Check the boxes next to the applications that you want to 
see in the Start menu. 

4. Press OK .

Reassigning Buttons
Buttons Settings lets you select which applications are associated 
with many of the buttons and key combinations on your Treo Pro 
smartphone.

1. Press Start  and select Settings.

2. On the Personal tab, select Buttons .

3. On the Program Buttons tab, highlight the button or key 
combination that you want to change in the Select a button 
list.

4. Select the Assign a program list, and then select the 
application you want to assign to the button or key combination you selected in step 3.

5. Press OK .

Did you know? You can also change the system color scheme (see “Changing the System 
Color Scheme” on page 342).
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Setting Up Voice Commands
Voice commands enable you to use speech to execute some commands on the Start menu 
and the Programs screen. 

1. Assign the Hold Side button to Microsoft® Voice Command. (See “Reassigning Buttons” 
on page 348 for details.)

2. Press Start  and select Settings.

3. On the Personal tab, select Voice Command .

4. Check the Enable box.

5. Select the items you want to enable. (If an item is highlighted and the Options box is 
active, select the Options box to choose the features you want enabled for the 
highlighted item.)

6. (Optional) Check the Password Protected box to password protect the Voice Command 
feature. 

7. Select Notifications and select the options for how you want to receive voice command 
notifications.

8. Press OK .

Using Voice Commands

1. Set the Ringer switch at the top of your Treo Pro smartphone to Sound On .

2. Hold your device about nine inches away from your mouth, and then press and release 
the Voice Command button. (A tone plays and a microphone icon appears at the top of 
your screen.) 

Tip You can also adjust the settings for the Up and Down buttons on the 5-way. 
From Buttons settings, select the Up/Down Control tab.

Important Do not use voice commands in your car until you read the End User Notice 
about this kind of usage; see “End User Notice” on page 3.
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3. In a clear voice say the command. For example:
� To access Help, say, “Help.” 

� To access your Calendar, say, “Start Calendar.”

� To access your music, say, “Start Windows Media®.”

4. After Voice Command finishes speaking, a microphone icon appears at the top of your 
screen; say your answer. (For example, say, “General” to access general Help topics.)

Using Voice Command to Make Calls
You can call contacts and dial numbers with voice commands.

Say:
� “Call <Contact>” to call a contact whose phone number is stored on your device.
� “Call <Contact> at/on <Location>” to call a contact at a specific phone number.
� “Dial <Number>” to dial a phone number.
� “Callback” to return the last call received.
� “Redial” to repeat the last call made.

Examples:
� “Call Karen Archer.”
� “Call Karen Archer on mobile.”
� “Call City, Light, and Power.”
� “Dial 555-0100.”
� “Dial 1-800-555-0100.”
� “Dial +46 555 1212 555.”
� “Dial 411.”

Tip You can interrupt during a question by pressing the Voice Command 
button. As soon as the microphone icon is visible you may say your answer.
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The information that follows describes how to define <Contact>, <Location>, and <Number>.

You can use the following name formats for <Contact>:
� Nickname.
� First Last.
� First Last Suffix.
� First Middle Last.
� First Middle Last Suffix.
� Company (if it is shown in contacts list view).

<Location> can represent one of these phone numbers:
� Home.
� Home2.
� Work.
� Work2.
� Mobile.
� Cell.
� Cellular.
� Car.
� Radio.
� Pager.
� Assistant.

<Number> can represent one of the following digit sequences:
� nnn-nnnn.
� nnn-nnn-nnnn.
� 1-nnn-nnn-nnnn.
� n-1-1.
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When you make a verbal request to make a call, Voice Command asks for a confirmation. 
When confirming, say:

� “Yes” or “Correct” to call.
� “No” or “Incorrect” to try again.

Setting Onscreen Input Options
1. Press Start  and select Settings.

2. On the Personal tab, select Input .

3. From the Input Method list, select which onscreen input method you want to set options 
for.

4. Set any of the following Keyboard options:
� Large/Small keys: Select whether to use large or small onscreen keys. 

� If you selected Large keys, check the box to choose whether or not to use the 
indicated gestures for the Space, Backspace, Shift, and Enter keys.

5. If you selected Letter Recognizer, select Options and select the options you want.
� Quick Stroke: Allows you to make a letter such as a t without lifting your stylus from 

the screen to cross it. 

� Right to left crossbar: Cross a letter by lifting your stylus and crossing from right to 
left.

Tip Don’t take long pauses during digit dialing. Voice Command will attempt to 
recognize the incomplete number.

Speed up dialing by including a location: “Call Karen Archer at home.”

Did you know? There’s a lot more information on Voice Command in Help on your 
smartphone. Press Start > Help. Tap Contents and scroll down to Help for 
Added Applications. Select Voice Command from the list.
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� Allow accented characters: Allows you to write a letter and then write above it to add 
an accent.

6. If you selected Transcriber, select Options and set any of the following. (For Transcriber 
options to display, Transcriber must be selected as the input method. See “Selecting 
Onscreen Input Methods” on page 67.)

� Writing Direction: Sets the orientation at which you normally make letters. 

� Intro screen: Displays the Transcriber Intro screen every time you select Transcriber.

� Sound: Enables sound with Transcriber. (Transcriber plays a beep as it inserts its 
interpretation of what you’ve written.)

� Inking tab: Set the recognition delay, automatic space after, and pen width and 
color. (Tap Match Letter Shapes to your writing to match your writing style to 
Transcriber letter shapes. This improves the accuracy of your Transcriber writing.)

� Advanced tab: Use the Shorthand screens to create shorthand writing expressions 
and define what they mean. Use the Dictionaries settings to enable or disable the 
dictionary.

7. Select the Word Completion tab and set any of the following options:
� Suggest words when entering text: Set whether word 

suggestions appear as you enter text. (You can also 
specify how many letters you want to enter before a 
suggestion appears, how many suggestions you want 
to see, and whether a space appears after you insert a 
suggested word.)

� Clear Stored Entries: Delete the database of word 
suggestions.

� Enable Auto Correct: Set whether the text you type 
adds to existing text or replaces it. (This is similar to the 
Insert function on a computer keyboard.)
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8. Select the Options tab and set any of the following options:
� Voice recording format: Set the format in which you save voice notes.

� Default zoom level for writing: Set the initial size of text entered using onscreen 
writing methods.

� Default zoom level for typing: Set the initial size of text 
entered using the keyboard.

� Capitalize first letter of sentence: Set whether the first 
letter of a sentence automatically appears in 
uppercase, without pressing the Shift key.

� Scroll upon reaching the last line: Set whether the 
display automatically scrolls when you select the last 
line of visible information.

9. Press OK .

Locking Your Treo Pro Smartphone and Information

Your Treo Pro smartphone includes several features that help you protect your device from 
inadvertent use and keep your information private. The built-in security software lets you use 
your smartphone for emergency calls, such as dialing 911, even if the phone feature is locked.

� Keyguard: Manually disable all buttons and the screen’s touch-sensitive feature to prevent 
accidental presses.

Tip To enter a suggested word, press Down to highlight the suggestion, and 
then press Center to accept it.
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� Auto-Keyguard and touchscreen lockout: Automatically enable Keyguard after a period 
of inactivity and set whether the screen’s touch-sensitive feature is enabled during calls.

� System password lock: Require a password before any information is accessible on your 
Treo Pro smartphone.

Using Keyguard
By default, your keyboard locks when you are on a call so that you don’t accidentally press 
buttons or activate screen items. It also locks when your smartphone turns off after a period of 
inactivity. You can manually enable Keyguard when you are not on a call.

� Press Center  to dismiss Keyguard.
� From the Today screen when you are not on a call, press End  to manually enable 

Keyguard. (Keyguard turns on, and after a short delay, the screen turns off.)
� From any other screen when you are not on a call, press and hold End  or press 

Option  + End  to manually enable Keyguard. (Keyguard turns on, and after a short 
delay, the screen turns off. The screen wakes up to the application you were using.)

� Press Power . (The screen turns off immediately, with Keyguard turned on. The screen 
wakes up to the Today screen or to the application you were using.)

Tip To avoid accidentally pressing onscreen buttons while you’re holding your 
Treo Pro smartphone up to your ear to speak, you can disable the screen’s 
touch-sensitive feature during active calls. When the screen’s 
touch-sensitive feature is disabled, you must use the 5-way navigator to 
access items on the screen.
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Using Auto-Keyguard and Touchscreen Lockout
Auto-Keyguard lets you automatically lock the keyboard after a 
period of inactivity.

1. Press Start  and select Settings.

2. On the Personal tab, select Keyguard .

3. Set either of the following options:
� Auto-Keyguard: Set the period of inactivity that passes 

before the keyboard automatically locks or before the 
auto-keyguard feature is disabled.

� Disable touchscreen: Set whether the screen’s 
touch-sensitive feature is enabled during a call.

4. Press OK .

Using System Password Lock
To protect your personal information, you can lock the system so that you need to enter your 
password to access any of your information or to use other features of your Treo Pro 
smartphone. 

Did you know? If you’re using a headset or hands-free device, you can manually turn on 
Keyguard during a call to prevent accidental key presses. Press and hold 
End to manually turn on Keyguard.
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1. Press Start  and select Settings.

2. On the Personal tab, select Lock .

3. On the Password tab, check the Prompt if device unused for 
box to turn on the password feature.

4. Select the first list, and then select how long a period of 
inactivity must pass before you are prompted to enter a 
password to unlock the system.

5. Select the Password type list, and then select a format for 
your password:

� Strong alphanumeric: A strong alphanumeric password must contain at least 7 
characters and must contain a combination of letters, numerals, and punctuation. 
You must press Option or Alt before entering numerals or punctuation.

� Simple PIN: A simple PIN must contain at least 4 characters and includes numerals 
only. You do not need to press Option before entering the PIN numerals.

Important If you lock your system, you must enter the exact password to unlock it. If 
you enter an incorrect password, you are given another chance. Each time 
an incorrect password is entered, you are given progressively longer time 
periods between your chances to enter the password. If you forget the 
password, you need to perform a hard reset to resume using your Treo Pro 
smartphone. Performing a hard reset deletes all the entries on your 
smartphone. However, you can restore all previously synchronized 
information the next time you sync (see “Connecting to Your Computer” on 
page 39). In addition, your device might not reestablish a data session after 
a hard reset. To manually establish a new data session, open the browser to 
access a Web site.
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6. Select Password, and enter your password.

7. Select Confirm, and enter the password again.

8. (Optional) Select the Hint tab and enter a hint to help you recall your password.

9. Press OK .

Entering Owner Information

You can enter personal information that you want to associate with your Treo Pro smartphone, 
such as your name, company name, and phone number. You can also set whether you want 
this information to appear when you turn on your smartphone. If you lose your device, this 
feature can help the person who finds it return it to you.

Note You can't see your password as you enter it, so be careful. Be sure Caps 
Lock and Option Lock are not on unless you need them. For information on 
how to enter characters, see “Entering Lowercase and Uppercase Letters” 
on page 62 and “Entering Numbers, Punctuation, and Symbols” on 
page 63.

Tip If you lock your Treo Pro smartphone and use a Simple PIN as the 
password format, you can dial an emergency number by entering the 
number in the password field and pressing Phone/Talk. You do not need to 
press Option before entering the number. However, if you select Strong 
alphanumeric as the password type, you must first press Option twice 
before entering an emergency number in the password field.
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1. Press Start  and select Settings.

2. On the Personal tab, select Owner Information .

3. On the Identification tab, enter any of the contact 
information you want to include.

4. Select the Notes tab and then enter any additional text you 
want to include.

5. Select the Options tab and check the boxes to indicate 
which information (if any) you want to appear on the screen 
when you turn on your smartphone. 

6. Press OK .

System Settings

Setting the Date and Time
Clock & Alarms Settings lets you set the time zone, time, and date for your home location and 
a location that you visit.

1. Press Start  and select Settings.

2. Select the System tab, and then select Clock & Alarms .

3. On the Time tab, select Home.

Tip You can also display your Owner Information on your Today screen. See 
“Selecting Which Items Appear on Your Today Screen” on page 343 for 
details.
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4. Select the first list, and then select the time zone for your 
home location.

5. Select the hour, and then press Up  or Down  to 
increase or decrease the hour setting. (Repeat this process 
for the minutes, seconds, and AM/PM settings.)

6. (Optional) Select Visiting and set the information for a 
location that you visit often.

7. Press OK .

8. If prompted, select Yes to accept your changes.

Synchronizing the Date, Time, and Time Zone With the Network
By default, your Treo Pro smartphone synchronizes the date, time, and time zone with your 
wireless service provider’s network whenever your phone is on and you are inside a coverage 
area.

1. Press Start  and select Settings.

2. Select the System tab, and then select Clock & Alarms .

3. Select the More tab.

4. To enter the date and time manually, uncheck the Enable local network time box.

5. If you want to use the Home or Visiting settings (see “Setting the Date and Time” on 
page 359) regardless of the network time, uncheck the Use network time zone box.

6. Press OK .

7. If prompted, select Yes to accept the changes.

Tip To display the time in all your applications, select the More tab and check 
the Display the clock on the title bar in all programs box. To set the display 
format for the date and time, see “Setting Display Formats” on page 347.
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Setting System Alarms
System alarms let you set alarms that are not associated with a 
task or appointment. For example, you can use your Treo Pro 
smartphone as an alarm clock when you travel, or set alarms to 
remind you when it’s time to take medication or pick up the kids. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Clock & Alarms .

3. Select the Alarms tab. 

4. Check a box to turn on that alarm.

5. Select the description next to the box you checked, and 
enter a description for the alarm.

6. Select the days of the week you want the alarm to go off. (You can select multiple days 
for each alarm.)

7. Select the time you want the alarm to go off, and then press OK .

8. Select the Alarm Sound , icon, and then check the boxes to indicate how you want 
the alarm to go off. (You can choose a flashing light, a single sound, a repeating sound, 
or a vibration.)

9. Press OK  twice.

10. If prompted, select Yes to accept your changes.

Note If you turn off the Use network time zone setting and later turn it on again, 
you need to turn your phone off and then on for this setting to take effect.

Tip To change the alarm sound, select the Alarm Sound icon, select the 
Play Sound list, and then select the alarm sound you want to use.
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Managing Identity Certificates
Your Treo Pro smartphone may include preinstalled certificates. Certificates are digital 
documents that are used to authenticate and exchange information on networks. Certificates 
can be issued for a user, a device, or a service. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Certificates .

3. Select any of the following:
� Personal: Display certificates that establish your identity when you log in to a 

secured network, such as a corporate network. 

� Intermediate: Display certificates issued from a root certificate whose purpose is to 
then issue personal certificates.

� Root: Display certificates that identify the computers, such as servers, that you 
connect to. (These certificates help prevent unauthorized users from accessing your 
smartphone and your information.)

4. Press OK .

Enabling Error Reporting
Error Reporting sends information that helps diagnose application errors for devices running 
Windows Mobile® software. When an error is detected, a text file is created. You can review the 
file and choose whether you want it delivered to Microsoft Support. The information is used by 
programming groups at Microsoft for quality control and is not used for tracking individual 
users or installations for any marketing purpose. The information that is collected is technical 
information about the state of your system when the error occurred. No documents (or any 
information contained in them) are intentionally sent with the report. To ensure further security, 

Tip To delete a certificate, tap and hold the certificate in the list, and then select 
Delete from the shortcut menu.



Section 6C: Customizing Your Treo™ Pro Smartphone by Palm 363

C
ustom

izing

the report is transmitted by means of a secure connection and is kept confidential and 
anonymous in a limited-access database. 

If your Treo Pro smartphone is connected to your computer when you send the error report, 
you are not billed for sending error reports—provided your computer is connected to the 
Internet. If you use the Sprint network to send an error report, data transfer charges apply. 

1. Press Start  and select Settings.

2. Select the System tab, and then select Error Reporting .

3. Select whether you want to enable or disable error reporting.

4. Press OK .

Viewing Memory Usage
1. Press Start  and select Settings.

2. Select the System tab, and then select Memory .

3. Select either of the following tabs:
� Main: View the total amount of memory available for 

your information (Storage) and applications (Program), 
as well as the amount in use and still available.

� Storage Card: View the amount of memory available on 
an expansion card that is inserted into the expansion 
slot on your smartphone.

4. Press OK .

Tip This error-reporting method meets the privacy regulations of the European 
Union (EU) as well as the Fair Information Practice Principles of the Federal 
Trade Commission. To view the Fair Information Practice Principles, visit the 
Federal Trade Commission Web site at ftc.gov.

http://www.ftc.gov/reports/privacy3/fairinfo.htm
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Viewing and Optimizing Power Settings
1. Press Start  and select Settings.

2. Select the System tab, and then select Power .

3. On the Battery tab, check the Battery Power Remaining 
indicator to see how much power remains in your battery. 

4. Select the Advanced tab and set whether your smartphone 
turns off automatically after a specified period of inactivity. 
(You can assign various intervals for battery power and 
external power.)

5. Select the Screen Saver tab and set whether the clock 
screen saver appears when the phone is turned on and the screen is turned off.

6. Press OK .

Tip If you are running short of storage space (memory) on your smartphone or 
storage card, delete or remove large files that you no longer need. To find 
large files, tap Find at the bottom of the screen.

For more information about how to save space on your smartphone, see 
“Making Room on Your Treo Pro Smartphone” on page 403).

Tip To conserve additional battery power, adjust the display backlight setting. 
Press Start and select Settings. Select the System tab, and then select 
Backlight. On the Battery Power tab, set whether the display backlight 
turns off automatically after a period of inactivity.
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Connection Settings

Managing ISP Settings
Your Treo Pro smartphone is already set up to connect to the Internet using a high-speed 
data connection on the Sprint network. To connect to the Internet, simply start Internet 
Explorer® Mobile. 

For special situations, such as connecting to your ISP (Internet service provider) or a remote 
access server (RAS), you can set up another connection. Before you begin, obtain the 
following information from your ISP or system administrator: 

1. Press Start  and select Settings.

2. Select the Connections tab, and then select Connections .

3. On the Tasks tab, select Manage existing connections.

4. Select the Modem tab. 

5. Highlight the connection you want to view or change, and then select Edit, or to create a 
new connection, select New.

6. Follow the onscreen instructions for editing or creating the connection.

7. Press OK  when finished.

Before You 
Begin

Obtain the following information from your ISP or system administrator:
• ISP server phone number or access point.
• User name.
• Password.
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Connecting to a VPN
If you want to use your Treo Pro smartphone to access your corporate email account or other 
files on your corporate server, you may need to set up a VPN (virtual private network). A VPN 
enables you to log in to your corporate server through the company’s firewall (security layer). 

You need to set up a VPN to access a corporate server in either of the following situations:
� Your company’s wireless local area network (LAN) is outside the firewall.
� Your company’s wireless LAN is inside the firewall, but you are accessing the network 

from outside the firewall (for example, from a public location or at home). 

1. Install your third-party VPN client (see “Installing Applications” on page 318). 

2. Press Start  and select Settings.

3. Select the Connections tab, and then select Connections .

Before You 
Begin

Check with your company’s system administrator to see if a VPN is required 
for accessing the corporate network. If you need a VPN, you must purchase 
and install a third-party VPN client in order to use this feature. Before you 
begin setting up a VPN, ask your system administrator for the following 
information:
• Your user name and password.
• Your server’s domain name.
• Your server’s TCP/IP settings. 
• Your server’s host name or IP address.

Did you know? A common cause of sync problems is the presence of protective software, 
such as VPNs or firewalls, on your computer or network. See “The Desktop 
Sync Software Does Not Respond to a Sync Attempt” on page 389.
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4. On the Tasks tab, select Add a new VPN server connection.

5. Follow the onscreen instructions for entering the settings provided by your corporate 
system administrator.

Setting Up a Proxy Server
1. Press Start  and select Settings.

2. Select the Connections tab, and then select Connections .

3. On the Tasks tab, select Set up my proxy server.

4. Check both of the boxes near the top of the screen. 

5. Select Proxy server and enter the proxy server name. 

6. Press OK .

Tip To manually start a data connection on the Sprint network or another 
network, go to Connections Settings. On the Tasks tab, select Manage 
existing connections. Tap and hold the connection you want to start, and 
then select Connect from the shortcut menu. 

Tip To change settings such as the port number, proxy server type, or 
credentials, select Advanced.

Note Setting a proxy server may prevent you from accessing some Web pages.
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Ending a Data Connection
If your service plan includes minutes-of-use fees for data connections, you can reduce costs 
by ending the data connection after you finish browsing the Web.

1. Tap the signal strength  or  icon on the title bar and select Comm Manager.

2. Highlight Data Connection and press Center . 

3. Press Exit (left softkey).

Enrolling a Domain
If your company uses Microsoft System Center Mobile Device Manager, you may need to use 
the Domain Enroll settings to register your Treo Pro smartphone within your company’s 
network.

1. Press Start  and select Settings.

2. Select the Connections tab, and then select Domain Enroll .

3. Press Enroll (right softkey).

4. Follow the onscreen instructions to complete the enrollment process.

Note You can turn other wireless services on and off and manage them with 
Comm Manager (see “Using Comm Manager to Turn Wireless Services On 
and Off” on page 221).

Important After you enroll your device in your company’s network, your system 
administrator can turn various features on your Treo Pro smartphone on and 
off. If a feature, such as the camera or messaging, worked previously and 
this feature no longer works after enrollment, contact your system 
administrator to find out if this feature is disabled on your smartphone.
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Purchasing Accessories for Your Treo Pro Smartphone

These accessories and others are available from palm.com. 
� Vehicle Power Charger: A charger that enables you to charge your smartphone in your 

vehicle using a 12V power outlet.
� Replacement Battery: A backup battery that you can use if your primary battery becomes 

drained, is charging, or has reached the end of its useful life.
� USB Cable: A replacement or spare cable (your smartphone comes with one USB cable).
� Cradle: A cradle to dock your smartphone, charge it, and transfer data to your computer.
� Extra AC Charger: A 100-to-240-volt AC charger for your smartphone.
� Palm Travel Charger Multiconnector: International travel charger featuring automatic 

voltage and frequency adjustment, 5-foot (1.5m) cable, and plug adapters for the U.K., 
Europe, Australia, Argentina, and the U.S.

� Leather Side Case With Belt Clip: A case that you can clip to your belt or bag that 
provides quick access to and protection for your smartphone.

� Stylus: A replacement or spare stylus for your smartphone.

http://www.palm.com
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Although we can’t anticipate all the situations that might arise, this chapter provides helpful 
information and answers to some of the most commonly asked questions. For additional 
information and technical support, visit palm.com/support.

Transferring Information From Another Device

For information on transferring your information from a previous Windows Mobile® device or 
from a Palm OS® by ACCESS device to your new Treo™ Pro smartphone by Palm, visit 
palm.com/support.

If you have questions about Windows Mobile, you can also go to windowsmobile.com and 
search for information on Palm devices. 

Trouble Installing the Desktop Software on a Windows XP 
Computer?

The desktop synchronization software lets you synchronize with Microsoft® Outlook® 2003 or 
later. You must have Outlook 2003 or later (sold separately) installed on your computer, and 
you should install and open Outlook before you install or use Microsoft® ActiveSync®.

Important To prevent your Treo Pro smartphone from malfunctioning, do not use a 
backup utility to transfer your information from another device to your new 
smartphone. In addition, do not use a backup utility to back up and restore 
your information if you update the operating system on your smartphone.

Tip If you don’t have Outlook 2003 or later installed on your computer, you can 
download a trial version of Microsoft Outlook 2007. Put your smartphone in 
Setup Mode and connect it to your computer. There’s a link on the setup 
screen (see “Switching Between Sync Mode and Setup Mode” on page 46).

http://www.windowsmobile.com
http://www.palm.com/support
http://www.palm.com/support
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If you want to synchronize with a different personal information manager (PIM), you must 
install a third-party solution. Contact the PIM’s author or vendor to find out whether software 
is available for your Treo Pro smartphone.

1. Shut down your computer, and then turn it on again.

2. On your computer, click Start > Control Panel > Add or Remove Programs.

3. Remove ActiveSync if it is on your computer.

4. Quit any active applications, including virus scanners and Internet security applications.

5. Make sure you’re installing the version of the software that came with your Treo Pro 
smartphone. (Other versions may not work with this smartphone.)

6. Make sure your computer profile includes administrator rights to install software. 
(In large organizations, these are usually granted by the system administrator.)

7. To reinstall the software, switch your Treo to Setup Mode, connect to your computer, and 
follow the onscreen instructions (see “Switching Between Sync Mode and Setup Mode” 
on page 46).

Resetting Your Treo™ Pro Smartphone by Palm

Performing a Soft Reset
A soft reset is similar to restarting a computer. If your Treo Pro smartphone is not responding 
or you have trouble synchronizing with your computer, a soft reset may help.

1. If your Treo Pro smartphone responds to key presses, press and hold Power  to 
turn off your phone.

2. If the screen display is on, press Power  to turn off the screen.

3. Remove the back panel from your device (see “Removing the Back Panel” on page 25).

4. Slide the stylus out from its slot.
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5. Use the stylus tip to gently press the RESET button.

6. Wait for the progress bar on the Palm® logo screen to fill before continuing to use your 
device.

7. Replace the stylus and slide the back panel into place.

Tip You can also do a soft reset by removing the battery and reinserting it.

Did you know? If the phone or the Bluetooth® wireless technology feature was on before a 
reset, these automatically turn on after the reset.
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Performing a Hard Reset
A hard reset erases all personal information, such as appointments, contacts, and tasks, as 
well as programs you have added, such as third-party software, on your Treo Pro smartphone. 
Never do a hard reset without first trying a soft reset. You can restore previously synchronized 
information the next time you sync. 

Review the following important information before performing a hard reset:
� After a hard reset, synchronize to restore your Outlook data, such as Outlook email, 

Calendar, Contacts, Notes, and Tasks. You can also use the included Sprite Backup utility 
to restore previously backed up configurations and preferences such as speed-dials, SMS 
entries, call log information, and personal settings.

� Some third-party applications do not create a backup on your computer when you 
synchronize. If you do a hard reset, you may lose information in these applications and 
you need to reinstall the application on your smartphone after the hard reset. Please 
contact the developer to find out if your information is backed up during synchronization.

� When you synchronize after a hard reset, the Files sync folder reverts to the default folder 
name.

� Your smartphone might not reestablish a data session after a hard reset. To manually 
establish a new data session, open the Web browser to access a Web site.

A hard reset can tell you whether a problem stems from your smartphone or from an 
application installed on it. If you do not experience the problem after you perform a hard reset, 
the problem may be related to software you installed. See “Third-Party Applications” on 
page 402 for suggestions on diagnosing third-party software issues.

1. If possible, synchronize your device with your computer so that your device applications 
and info can be restored by synchronizing again after you perform the hard reset.

2. Remove the back panel from your device.

3. Slide the stylus from its slot.

4. While pressing and holding End , use the stylus to press and release the RESET 
button.
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5. Continue to press and hold End  until the Erase all data? prompt appears.

6.  Press Up  to confirm the hard reset.

7. Wait for the progress bar on the Palm logo screen to fill again and for the Windows 
Mobile screen to appear. 

8. Follow the onscreen instructions to align the screen before continuing to use your 
smartphone.

9. Replace the stylus and slide the back panel back into place.

10. (Optional) Synchronize your smartphone with your computer to restore your previously 
synchronized information. (If you use Sprite Backup or another compatible backup 
utility, you may also need to restore a backup to recover additional information and 
settings.)

Replacing the Battery
Your Treo Pro smartphone comes with a replaceable battery. Be sure to use a replacement 
battery from Palm that is compatible with the Treo Pro smartphone. See “Protecting Your 
Battery” on page 418 for information on handling the battery safely.

WARNING Use only batteries and chargers that are approved by Sprint or Palm with 
your Treo Pro smartphone. Failure to use an approved battery or charger 
may prevent your smartphone from turning on or charging, may void your 
smartphone warranty, and may increase the risk of your smartphone 
overheating, catching fire, or exploding, which may also result in serious 
bodily injury, death, or property damage. 

Did you know? Your Treo Pro smartphone stores all your information even when you 
remove the battery.
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1. Press Power  to turn off the screen.

2. Remove the back panel from your device (see “Removing the Back Panel” on page 25).

3. Place a fingernail behind the small tab at the upper-left corner of the battery and pull the 
end of the battery up and out of the compartment, and then remove the battery.

1 Battery Contacts
2 Device Contacts

4. Align the metal contacts on the new battery with the contacts of the battery 
compartment, and then press the battery into place.

5. Slide the back panel into place.

Tip For long trips or heavy use, buy a spare battery that is approved by Sprint 
and is compatible with your Treo Pro smartphone. Visit palm.com.

Be sure to dispose of your old battery in an environmentally responsible and 
legal way. In some areas, disposal in household or business trash is 
prohibited. Visit palm.com/environment for more information.

2

1

http://www.palm.com/environment
http://www.palm.com
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Performance

The Applications Are Running Slower Than Usual

1. Press End  to go to the Today screen.

2. Tap the Running Programs  icon in the upper-right corner of the screen to open the 
Quick Menu. 

3. Note how many applications you have running and what the memory usage is. (Having 
many applications open makes applications run slowly.)

4. In your open applications, save any unsaved information you want to keep. (Tap the 
application name in the Quick Menu to go to it.)

5. Close applications you are not using. (Tap the X in the upper-right corner of the 
application, or tap the  by the application name in the Quick Menu.)

If the previous steps don’t fix the problem, try a soft reset (see “Performing a Soft Reset” on 
page 375). If the problem persists, follow these steps to turn off the Microsoft® Voice 
Command setting, if it is enabled:

1. Press Start  and select Settings. 

2. Select the Personal tab, and then select Voice Command .

3. Uncheck the Enabled box.

4. Press OK .

Tip Be sure that third-party applications are compatible with Windows Mobile 
Professional version 6.1 or later. Applications written for earlier versions can 
have performance problems. If you can try a free version of the software 
before purchasing it, you can test it first to make sure it works properly.
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I Can’t Beam or Receive Information Via Infrared or Bluetooth® Wireless 
Technology

1. Press Start  and select Settings.

2. Select the Connections tab, and then select Beam . 

3. Check the Receive all incoming beams box.

4. Press OK .

5. If beaming still does not work and your company uses Microsoft System Center Mobile 
Device Manager, contact your system administrator to find out whether infrared or 
Bluetooth® wireless technology features are disabled on your Treo Pro smartphone.

I Can’t Save or Access Files on an Expansion Card
� Make sure the card is not locked or copy-protected.
� If your company uses Microsoft System Center Mobile Device Manager, contact your 

system administrator to find out whether removable storage features are disabled on 
your smartphone.

I Can’t Charge the Battery
� If you’re using a new battery or a new charger, make sure the battery and charger are 

approved by Sprint or Palm for use with your smartphone. Failure to use an approved 
battery or charger may prevent your device from turning on or charging.

� If the battery is completely drained, the red charging indicator in the front of your 
smartphone may not light for up to 30 minutes.

� If you’re using an existing, approved battery, the battery may have reached the end of its 
useful life and needs to be replaced. See “Replacing the Battery” on page 378 for details. 
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Screen

The Screen Appears Blank
1. If this is the first time you are turning on your device, you need to take out and reinsert 

the battery to turn on the screen (see “Replacing the Battery” on page 378). Alternately, 
connect your device to a wall outlet using the USB AC charger (see “Charging the 
Battery” on page 26).

2. If you’re on a call, when the time period specified in Backlight Settings expires, the 
screen dims. (Press any key except End  to turn on the screen. Pressing End  
hangs up the call.)

3. Look closely at the screen, and if you can see a dim image, try adjusting the 
screen brightness (see “Adjusting the Brightness” on page 346).

4. If that doesn’t work, perform a soft reset (see “Performing a Soft Reset” on page 375).

5. If that doesn’t work, connect your smartphone to the USB charger (see “Charging the 
Battery” on page 26) and perform a soft reset again.

6. If you’re using a third-party application, make sure that the application supports 
320 x 320 screen resolution.

7. If that doesn’t work, perform a hard reset (see “Performing a Hard Reset” on page 377).

The Screen Doesn’t Respond Accurately to Taps or Activates Wrong Features
1. Make sure there is no debris trapped under the edges of the screen.

2. Press Start  and select Settings. 

3. Select the System tab, and then select Screen . 

Tip Make sure that third-party applications support 320 x 320 screen resolution. 
Some older applications have screen-size limits. 
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4. On the Alignment tab, select Align Screen.

5. Follow the onscreen instructions to align the screen.

6. Press OK .

Network Connection

Signal Strength Is Weak
� If you’re standing, move about 10 feet (3 meters) in any direction.
� If you’re in a building, move near a window. Open any metal blinds.
� If you’re in a building, move outdoors or to a more open area.
� If you’re outdoors, move away from large buildings, trees, or electrical wires.
� If you’re in a vehicle, move your smartphone so that it’s level with a window.
� Try using a hands-free Bluetooth headset to see if that improves the signal strength.

My Smartphone Won’t Connect to the Wireless Network
1. Try the preceding suggestions for weak signals.

2. Turn off your phone and turn it on again (see “Turning Your Phone On and Off” on 
page 34).

3. Perform a soft reset (see “Performing a Soft Reset” on page 375).

Tip To find carrying cases that protect the screen, and other useful accessories, 
visit palm com/support

Tip Become familiar with low coverage areas where you live, commute, work, 
and play, so you know when to expect signal-strength issues.

http://www.palm.com/support


384 Section 7A: Help

My Smartphone Seems to Turn Off by Itself
If a system error and reset occur, the phone automatically turns on if it was on before the 
reset. However, if your smartphone can’t determine if your phone was on before the reset, it 
does not automatically turn on the phone (see “Turning Your Phone On and Off” on page 34).

I Can’t Tell If Data Services Are Available

The following icons appear in the title bar to indicate whether data services are available. If 
you don’t see one of these icons, you cannot open a data connection:

Key term 1xRTT (single-carrier [1x] radio transmission technology): A wireless 
technology that can provide fast data transfer and Internet access, with 
average speeds of 60-to-80Kbps and bursts of up to 144Kbps. 

Key term EVDO (Evolution Data Optimized): A wireless broadband technology that is 
designed for very high-speed data transfer, with average download speeds 
of 400-to-600Kbps, and capable of reaching speeds up to 3.2Mbps and 
upload speeds up to 1.8Mbps.

 or The Sprint Mobile Broadband (EVDO) or Sprint 1xRTT network is within 
range. You can make or receive calls or open a data connection.

Your smartphone is connected to a Wi-Fi network. You can open a data 
connection.



Section 7A: Help 385

H
elp

My Smartphone Won’t Connect to the Internet
Your Treo Pro smartphone supports Sprint Mobile Broadband (EVDO), Sprint 1xRTT, and 
Wi-Fi wireless data networks. To connect to the Internet, you must either subscribe to data 
services with Sprint or be within range of a Wi-Fi network. 

� Contact Sprint to verify that your subscription plan includes data services and that these 
services have been correctly activated. Sprint should also be able to tell you if there are 
any outages in your location. 

� If your company uses Microsoft System Center Mobile Device Manager and you’re 
attempting to make a Wi-Fi connection, contact your system administrator to find out 
whether Wi-Fi features are disabled on your smartphone.

� Press and hold Power  to turn off your phone. Then press and hold the same button 
to turn it back on again.

� Perform a soft reset (see “Performing a Soft Reset” on page 375).
� Confirm that data services are correctly configured on your smartphone:

1. Press Start  and select Settings. 

2. Select the Connections tab, and then select Connections . 

3. On the Tasks tab, select Manage existing connections.

4. If Power Vision appears in the list, press OK . If not, contact Sprint for assistance.

I Can’t Send or Receive Text Messages
� Make sure that your phone is on (see “Turning Your Phone On and Off” on page 34).
� Contact Sprint to verify that your plan includes messaging services, that these services 

have been correctly activated, and that they are available at your location (Sprint should 
be able to tell you if messaging services have been experiencing transmission delays).

� If possible, contact the recipient of the message, and make sure the receiving device can 
handle the type of message you’re sending.

� If a text message arrives but does not display a notification, perform a soft reset 
(see “Performing a Soft Reset” on page 375).
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� If your company uses Microsoft System Center Mobile Device Manager, contact your 
system administrator to find out whether messaging features are disabled on your 
smartphone.

I Can’t Make or Receive Calls Using a Bluetooth Hands-Free Device
Verify all of the following:

� The Turn on Bluetooth box is checked in Bluetooth Settings.
� Your Bluetooth device is charged and turned on.
� Your smartphone is within range of the hands-free device. Bluetooth range is up to 30 feet 

(10 meters) in optimum environmental conditions, which include the absence of 
obstacles, radio interference from nearby electronic equipment, and other factors.

� The Bluetooth Settings screen is closed.
� The Wi-Fi feature is off. If Wi-Fi is on, press and hold Wi-Fi  to turn this feature off, and 

then try to use your Bluetooth device again.
� You are away from other devices using the 2.4GHz radio frequency, such as cordless 

phones and microwaves. If this is impossible, move the phone closer to the hands-free 
device.

� The device specifications are compatible with your Treo Pro smartphone.
� If your company uses Microsoft System Center Mobile Device Manager, contact your 

system administrator to find out whether Bluetooth features are disabled on your 
smartphone.

I Lost the Connection Between My Smartphone and My Bluetooth Headset
1. Press Start  and then select Settings. 

2. Select the Connections tab, and then select Bluetooth. 

3. On the Devices tab, select Add New Device.

4. Select your headset name from the list.

5. In Partnership Settings, make sure the Hands Free box is checked.

6. Select Save.
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7. Highlight the headset name.

8. Press and hold Center  to open the shortcut menu, and then select Set as 
Hands-Free. 

9. Test your headset by making or receiving a call.

If the headset still doesn’t work, delete the existing partnership and create a new one. To 
delete the partnership, do the following:

1. Press Start  and then select Settings. 

2. Select the Connections tab, and then select Bluetooth. 

3. On the Devices tab, highlight the headset device name.

4. Press and hold Center  to open the shortcut menu, and then select Delete.

5. Create a new partnership (see “Setting Up a Bluetooth Connection” on page 214).

Synchronization

Synchronization enables you to back up the information on your Treo Pro smartphone onto 
your computer or your server. If you ever need to perform a hard reset or otherwise erase all 
your information on your smartphone, you can synchronize your smartphone with your 
computer to restore the information. To make sure you always have an up-to-date backup of 
your information, synchronize frequently.

You can synchronize email and other information directly with Exchange Server 2007 or 
Exchange Server 2003 upgraded to Service Pack 2, using Microsoft Exchange ActiveSync, or 
you can synchronize your smartphone with your computer, using the desktop sync software 
(see “Setting Up Your Computer for Synchronization” on page 44).

Did you know? You can go to the Windows Web site for more information at 
windowsmobile com. 

A common cause of sync problems is the presence of protective software, 
such as VPNs or firewalls, on your computer or network.

http://www.windowsmobile.com
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Desktop Sync Software
This section covers issues with synchronizing using the desktop sync software that came with 
your Treo Pro smartphone. If you have a Windows XP computer, the desktop sync software is 
called ActiveSync® desktop software. If you have a Windows Vista® computer, the desktop 
sync software is called Windows Mobile Device Center.

My Smartphone Does Not Sync When I Connect to My Computer With the USB Cable. Instead, I See 
a Treo Setup Screen

Your connection is not in Sync Mode.

1. On your device, press Start  and select Settings.

2. Select the System tab, and then select PC Setup .

3. Select Synchronize.

4. Connect your smartphone to your computer with the USB cable. (Synchronization 
should start automatically.)

5. If you still cannot synchronize, go to palm.com/support for synchronization support.

I Am in Sync Mode, But Synchronization Isn’t Working

Even if you are in sync mode, synchronization cannot take place unless you have the desktop 
sync software installed on your computer. If you did not install the software during initial setup 
but want to synchronize, switch to setup mode so that you can install the software.

1. On your device, press Start  and select Settings.

2. Select the System tab, and then select PC Setup .

3. Select Set up my PC.

4. Connect your smartphone to your computer with the USB cable. (Setup should start 
automatically.)

5. Follow the onscreen prompts to complete setup, and then select the option to 
synchronize.

6. If you still cannot synchronize, go to palm.com/support for synchronization support.

http://www.palm.com/support
http://www.palm.com/support
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The Desktop Sync Software Does Not Respond to a Sync Attempt

If you can successfully sync at any point during the following procedure, you do not need to 
complete the remaining steps.

1. Make sure you are using the USB cable that came with your Treo Pro smartphone or a 
replacement cable that has been approved by Palm for use with a Treo Pro smartphone.

2. Make sure the USB cable is securely connected at all points (see “Synchronizing With a 
USB Connection” on page 48).

3. If your company uses Microsoft System Center Mobile Device Manager, contact your 
system administrator to find out whether desktop synchronization features are disabled 
on your smartphone.

4. Make sure that all the files you’re trying to sync are closed on both your computer and 
your smartphone.

5. Do one of the following:

� Windows XP computer: Look for the ActiveSync  icon in the taskbar on your 
computer to make sure the ActiveSync software is running on your computer, and 
look for the ActiveSync  icon at the top of your smartphone screen. 

� Windows Vista computer: Look for the connection  icon at the top of your 
smartphone screen.

6. If you did not see the correct icons, do the following:

� On your Treo Pro smartphone: Press Start , select Programs, select 

ActiveSync , and then press Menu (right softkey), select Connections, and make 
sure the Synchronize all PCs using this connection box is checked and that USB is 
selected from the list.

� Windows XP computer: Click Start > All Programs > Microsoft ActiveSync.

� Windows Vista computer: Click Start > All Programs > Windows Mobile Device 
Center.
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7. Do one of the following:

� Windows XP computer: Double-click the ActiveSync  icon in your taskbar, and 
then from the File menu, select Connection Settings, make sure the Allow USB 
connections box is checked, and then click Connect.

� Windows Vista computer: Click Start > All Programs > Windows Mobile Device 
Center. Select Connect without setting up your device, and then select Connection 
settings. Make sure the Allow USB connections box is checked, and then click 
Connect.

8. On your smartphone, press Start , select Settings, select the Connections tab, and 
then select USB to PC  If the Enable advanced network functionality box is checked, 
uncheck it. If this box is currently unchecked, then check it.

9. Perform a soft reset (see “Performing a Soft Reset” on page 375).

10. Restart your computer and make sure the desktop sync software is running.

11. If problems persist and you’re synchronizing through a USB hub, try connecting the 
USB cable to a different USB port on the hub or directly to your computer’s built-in USB 
port. 

12. If you’re synchronizing through a built-in USB port on the front of your computer, move 
the USB cable to a USB port on the back of your computer (if your computer has USB 
ports in both places). 

13. For a Windows XP computer only: On your computer, uninstall Microsoft ActiveSync 
(Start > Settings > Control Panel > Add or Remove Programs). Then put your 
smartphone in Setup Mode and reinstall the software (see “Switching Between Sync 
Mode and Setup Mode” on page 46).

14. For a Windows XP computer only: Delete the existing partnership between your Treo Pro 
smartphone and your computer, and create a new one by doing the following steps in 
turn:

� Disconnect your smartphone and your computer from the USB cable.

� Right-click the gray ActiveSync  icon in the taskbar in the lower-right corner of 
your computer screen, and then select Open Microsoft ActiveSync.
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� Click File and then click Delete Mobile Device. When asked to confirm, click Yes.

� Connect your smartphone and your computer to the USB cable.

� When the Synchronization Setup Wizard appears, follow the steps to establish a sync 
relationship between your smartphone and your computer.

15. If your organization uses a firewall or a VPN connection, synchronizing with ActiveSync 
may not work. For a Windows XP computer only, go to microsoft.com and search for the 
following topics to help with specific firewall setup situations:

� ActiveSync USB Connection Troubleshooting Guide.

� ActiveSync with Sygate Personal Firewall.

� ActiveSync with Trend Micro PC-cillin Internet Security.

� ActiveSync with Norton Personal Firewall.

16. Verify with your computer hardware vendor that your operating system supports your 
internal USB controller.

Synchronization Finishes But Information Doesn’t Appear Where It Should

� With the included software, your Treo Pro smartphone can synchronize with the root 
folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize with a global 
Exchange Address Book, you must copy the addresses to your local Contacts list in 
Microsoft Office Outlook. Right-click the addresses and select Add to Personal Address 
Book. 

� Microsoft Office Outlook subfolders and public folders are not accessible with the 
included software. You may want to use a third-party solution instead.

Did you know? A common cause of sync problems is the presence of protective software, 
such as VPNs or firewalls, on your computer or network.

Tip If you are synchronizing to an Exchange server and you’re unable to change 
your lock settings, check with your system administrator to find out if a 
systemwide locking policy is in place.

http://www.microsoft.com
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� If you’re trying to sync offline, be sure to set your Microsoft Office Outlook Calendar, 
Contacts, Notes, and Tasks to be available offline.

� For music files, update the library in Windows Media Player Mobile (see “Working With 
Libraries” on page 251).

� For pictures and videos, see “Synchronizing Your Pictures, Videos, and Music” on 
page 226 for information on the location of synchronized items.

� For Office Mobile files, see “Synchronizing Microsoft® Office and Other Files” on page 280 
for information on the location of synchronized files.

� If you’re still having problems, try the following:

1. Make sure you’re synchronizing with the intended desktop personal information 
manager (PIM). The software installed during setup lets you synchronize with Microsoft 
Office Outlook for Windows. If you use a different PIM, you need to install third-party 
software to synchronize. For more information, consult the company that makes the PIM.

2. Open the desktop sync software on your computer, and make sure the Files 
synchronization option is selected (“Changing Which Applications Synchronize” on 
page 338).

3. For a Windows XP computer only: On your computer, uninstall Microsoft ActiveSync 
(Start > Settings > Control Panel > Add or Remove Programs). Then put your 
smartphone in Setup Mode and reinstall the software (see “Switching Between Sync 
Mode and Setup Mode” on page 46).

Synchronization Starts But Doesn’t Finish

1. Make sure that you installed the desktop software that came with your Treo Pro 
smartphone. If you’re not sure whether this software is installed, reinstall it. 

2. If you’re trying to sync offline, be sure to set your Microsoft Office Outlook Calendar, 
Contacts, Notes, and Tasks to be available offline.

My Windows Media® Player Library Won’t Sync

1. Make sure you have Windows Media® Player 10 or later installed on your computer.

2. For a Windows XP computer only: Reinstall your synchronization software. Media file 
synchronization fails if you installed the synchronization software before you installed 
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Windows Media Player 10 or later. On your computer, uninstall Microsoft ActiveSync 
(Start > Settings > Control Panel > Add or Remove Programs). Then put your 
smartphone in Setup Mode and reinstall the software (see “Switching Between Sync 
Mode and Setup Mode” on page 46).

My Appointments Show Up in the Wrong Time Slot After I Sync

1. Make sure the appointments are assigned to the correct time zone. (If not, change the 
time zone. If yes, then continue to the next step.)

2. Make sure that you installed the desktop software that came with your Treo Pro 
smartphone. If you're not sure whether this software is installed, reinstall it. 

3. Open Microsoft Office Outlook and correct the wrong entries.

4. Manually enter any information you’ve added to your smartphone since the last time 
you synchronized.

5. Synchronize your smartphone and your computer.

I Can’t Synchronize Using a Bluetooth Connection

1. Do one of the following: 

� Windows XP computer: Right-click the gray ActiveSync  icon in the taskbar, and 
select Connection Settings.

� Windows Vista computer: Click Start > All Programs > Windows Mobile Device 
Center. Select Connect without setting up your device, and then select Connection 
settings.

Before You 
Begin

Do the following:
• Make sure your computer is equipped with Bluetooth wireless 

technology, either built-in or through a Bluetooth card. 
• Make sure that your computer’s Bluetooth setting is discoverable.
• Make sure your computer is set up for synchronization (see “Setting 

Up Your Computer for Synchronization” on page 44).
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2. Check Allow connections to one of the following, and then select the Bluetooth COM port 
you set up on your computer. 

3. On your smartphone, press End  to go to your Today screen, and then tap the 
Bluetooth  icon.

4. Press Settings (right softkey) and select Bluetooth.

5. Select the Mode tab, and then check that the Turn on Bluetooth and Make this device 
visible to other devices boxes are selected.

6. Press OK .

7. Press Start  and select Programs.

8. Select ActiveSync .

9. Press Menu (right softkey) and select Connect via Bluetooth.

10. If this is the first time you’re making a Bluetooth connection to this computer, follow the 
onscreen prompts to set up a Bluetooth partnership with the computer. 

11. Select Sync.

12. When synchronization has finished, press Menu (right softkey) and select Disconnect 
Bluetooth. 

Exchange ActiveSync (Wireless Synchronization)
I Can’t Synchronize With My Company’s Exchange Server

If you’re unable to change your lock settings, check with your system administrator to find out 
if a systemwide locking policy is in place.

My Scheduled Sync Doesn’t Work

� If your company uses Microsoft System Center Mobile Device Manager, contact your 
system administrator to find out whether synchronization frequency settings are restricted 
on your smartphone.
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� By default, a scheduled sync does not work while you are roaming. This is to prevent 
roaming charges on your account. If roaming charges are not a concern, follow these 
steps to continue your sync schedule while roaming:

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu (right softkey) and select Schedule.

4. Check the Use above setting when roaming box.

5. Press OK .

An Alert Tells Me That ActiveSync Encountered a Problem on the Server

There is a temporary problem with the server, or the server may be temporarily overloaded. 
Try again later, and if the problem persists, contact your system administrator.

An Alert Tells Me That There Is Not Enough Free Memory to Synchronize

ActiveSync ran out of storage space. Try the following:

1. Go to Task Manager and close all running programs (see “Closing Applications” on 
page 70 for details).

2. If the problem persists, see “Making Room on Your Treo Pro Smartphone” on page 403 
for suggestions of other ways to free up space on your smartphone.

An Alert Tells Me That the Server Could Not Be Reached

Your smartphone had to wait too long to connect to the Exchange server. The connection 
may have been lost, the server may be temporarily overloaded, or the server may have 
encountered an internal error. Check your Exchange server name and proxy server settings 
(see “Setting Up Wireless Synchronization” on page 332), and try again later.

An Alert Tells Me That ActiveSync Encountered a Problem With [Item Type] [Item Name]

There is an error while synchronizing a single item. This error can usually be corrected only 
by removing the item that caused the error. If you sync again to see if the error persists, be 
aware that items causing this type of error are skipped and do not show up again. 
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An Alert Tells Me That My Account Information Could Not Be Detected

When you set up the Exchange server sync options, the credentials page was left blank. 
Correct the credentials (see “Setting Up Wireless Synchronization” on page 332), or set up 
your smartphone to sync only with a computer, and try to sync again. 

An Alert Tells Me that My Device Timed Out While Waiting For Credentials

The Exchange server credentials screen was left open too long. Reenter the Exchange server 
credentials, and try to sync again.

My Today Screen Settings Are Not Restored After a Hard Reset

Settings such as the background image and plug-in choices are not backed up during 
synchronization, so they can’t be restored after a hard reset. If you use a backup utility, such 
as the included Sprite Backup, you may be able to restore a backup to recover your Today 
screen settings and other additional information.

When I Sync With My Exchange Server, My Information Is Not Downloaded to My Smartphone 

Check with your system administrator to obtain the name of the mail server that offers you 
wireless access to the corporate mail system. If you cannot obtain the name of this server 
(some companies do not give it out, because they do not want wireless access to their 
servers), you cannot use ActiveSync to synchronize with the Exchange server. You can also 
check the following setting:

1. Press Start  and select Programs. 

2. Select ActiveSync . 

3. Press Menu (right softkey) and select Configure Server. 

4. Make sure the SSL box is checked.
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Email

I Have Problems Using My Account
Occasionally you may experience problems using an email account after you set it up. If you 
followed the account setup procedure and are experiencing problems using the account, 
verify that the account complies with your email provider’s requirements:

� Verify both your password and your user name for your email account.
� Some wireless service providers require you to be on their network to use your email 

account. If this is the case, be sure to use your provider’s network as the connection type 
for the account.

� Some wireless service providers have other requirements specific to their service. Check 
with your service provider to find out whether any provider-specific requirements exist.

� Service provider settings frequently change. If your email account was working but you 
are currently experiencing problems, check with your service provider to find out whether 
any of the account settings have changed.

I Have Problems Sending and Receiving Email
� Short periods of time when email is unavailable are common, due to server problems or 

poor wireless coverage. If you have problems sending or receiving mail for an extended 
period of time, check with your ISP or email service provider to verify that the service is 
working properly, and check with Sprint Customer Service for outage information in your 
area.

� If your company uses Microsoft System Center Mobile Device Manager, contact your 
system administrator to find out whether email features are disabled on your smartphone.
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Scheduled Email Synchronization Is Not Working
If email synchronization is occurring and you turn your smartphone off, or if the connection to 
your email service provider is disconnected, the sync fails. 

1. Check the synchronization schedule to make sure that email sync is set to occur at the 
expected day and time (see “Setting the Synchronization Schedule” on page 334 for 
details).

2. Press Start , select Programs, and then select ActiveSync . 

3. Press Menu (right softkey) and select Configure Server. 

4. Press Next (right softkey), and make sure the Save password box is checked. (This is 
required for wireless synchronization.)

I Have Problems Sending Email (IMAP and POP Accounts)
If you are able to receive email messages but cannot send them, try the following:

� Make sure your ISP or email provider allows you to access email on a Treo Pro 
smartphone. (Some providers do not offer this option at all; other providers require an 
upgrade for you to access email on a smartphone.)

� Turn on authentication (see “Setting Up an IMAP or POP Email Account” on page 129). 
(Many service providers require authenticated access, or ESMTP, to use their SMTP 
servers.) 

� Enter the name of a different outgoing mail server for sending mail (see “Setting Up an 
IMAP or POP Email Account” on page 129). (Many ISPs, such as cable companies, 
require that you have an Internet connection to their network to send email through their 
servers. In this case, you can almost always receive email from these accounts, but if you 
want to send email, you must send it through another server. Contact Sprint for an 
outgoing mail server option based on your Sprint account settings. In other cases, your 
ISP may be able to provide you with the outgoing mail server settings required to send 
mail from your smartphone.)
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I Have Problems Sending Email (Exchange Server Account)
If you are able to receive email messages but cannot send them, check that encryption is 
enabled:

1. Press Start , select Programs, and then select ActiveSync . 

2. Press Menu (right softkey), and select Configure Server. 

3. Press Next (right softkey), and make sure the This server requires an encrypted (SSL) 
connection box is checked.

I Have Problems Synchronizing Messages on My Smartphone With Messages 
on My Computer
Make sure you have chosen the same settings for the account on both your Treo Pro 
smartphone and your computer. For example, if the account is set up on your smartphone to 
use the POP protocol, check the ActiveSync settings on your computer to make sure that POP 
is selected as the protocol for that account.

My vCard or vCal Email Attachment Isn’t Forwarding Correctly
Microsoft Office Outlook provides several features that work with email client software on a 
Windows computer. For these features to work correctly, the email client software must be 
properly set up. Follow these steps to check the settings:

1. On your computer, click Start > Control Panel.

2. Select Internet Options, and then click the Programs tab.

3. Make sure that the email field is set to the correct email client software. 

4. Click OK.

5. Start the email client software and make sure it is configured as the default MAPI client. 
(Consult the documentation for the email application for more information.)
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Web

I Can’t Access a Page
1. Make sure you have Internet access: 

� Open Internet Explorer® Mobile and try to view a Web page you’ve loaded before. 

� To ensure that you’re viewing the page directly from the Internet, press Menu (right 
softkey) and select Refresh. 

� After confirming your Internet connection, try to view the page in question again. If it 
comes up blank, press Menu (right softkey) and select Refresh.

� If you’re still having trouble, the page may contain elements that are not supported 
by Internet Explorer Mobile, such as Flash, Shockwave, VBScript, WML script, and 
other plug-ins.

2. Some Web sites use a redirector to their true home page (for example, if you enter the 
address http://palm.com/support, it may resolve to http://palm.com/us/support. If 
Internet Explorer Mobile can’t follow the redirect, try using a desktop browser to see the 
landing page of the redirector, and enter that address in Internet Explorer Mobile.

3. If your company uses Microsoft System Center Mobile Device Manager and you’re 
attempting to connect to the Internet with a Wi-Fi connection, contact your system 
administrator to find out whether Wi-Fi features are disabled on your smartphone.

An Image or Map Is Too Small on My Smartphone Screen
With Internet Explorer Mobile you can zoom in and out on a Web page. In Mobile view mode 
you can view pages optimized for a mobile device. See “Viewing a Web Page” on page 184 
for details.

A Secure Site Refuses to Permit a Transaction
Some Web sites don’t support certain browsers for transactions. Please contact the site’s Web 
master to make sure the site allows transactions using Internet Explorer Mobile.

http://palm.com/us/support
http://palm.com/support
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Camera

Here are some tips for taking good pictures with the built-in camera:
� Clean the camera’s lens with a soft, lint-free cloth.
� Take pictures in bright lighting conditions. Low-light images may be grainy, due to the 

sensitivity of the camera.
� Hold the camera as still as possible. Try supporting your picture-taking arm against your 

body or a stationary object, such as a wall.
� Keep the subject of the pictures still. Exposure time is longer with lower light levels, so you 

may see a blur.
� For best results, position the brightest light source behind you, lighting the subject’s face. 

Avoid taking indoor pictures with the subject in front of a window or light.
� Make sure the subject is at least 18 inches (.5 meters) away from the camera to ensure 

good focus.

My Camera Won’t Take Pictures
If your company uses Microsoft System Center Mobile Device Manager, contact your system 
administrator to find out whether the camera features are disabled on your smartphone.

The Camera Preview Image Looks Strange
Some third-party applications overwrite the color settings of your Treo Pro smartphone with 
their own 8-bit color settings. This can affect the Camera Preview Mode. Delete third-party 
applications one by one until the preview image improves.

Did you know? Pictures are 16-bit color. Resolution settings range from 1600 x 1200 to 
160 x 120 pixels. Video resolution settings range from 320 x 240 to 176 x 
144 pixels. You can change the resolution setting by pressing Menu (right 
softkey) and selecting Resolution (still images) or Quality (video).
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Third-Party Applications

Sometimes, third-party applications can cause conflicts on your Treo Pro smartphone. 
Third-party applications that modify wireless features may affect the performance of your 
device and may require extra troubleshooting. Use caution when installing the following types 
of applications:

� Ringtone managers.
� Caller ID applications.
� Instant messaging.
� Applications that modify when your phone or data connections turn on or off and how 

your phone behaves.

If you recently installed an application and your Treo Pro smartphone seems to be stuck, try 
the following: 

1. Perform a soft reset (see “Performing a Soft Reset” on page 375).

2. Make sure the third-party application is compatible with the Windows Mobile version 6.1 
operating system on your Treo Pro smartphone.

3. Delete the most recently installed application from your smartphone (see “Removing 
Applications” on page 322).

4. If the problem persists, perform another soft reset.

5. If possible, synchronize or use the included Sprite Backup utility to back up your most 
recent information.

6. Perform a hard reset (see “Performing a Hard Reset” on page 377).

Tip Remember that not all third-party applications were written with the Treo Pro 
smartphone keyboard and 5-way navigator in mind. You may encounter 
strange behavior or errors in these applications if you use the keyboard and 
5-way navigator.
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7. Synchronize or restore your backup to refresh the information in your built-in 
applications.

8. If the problem is resolved, begin reinstalling your third-party applications one at a time.

9. If the problem recurs, delete the last application you installed and report the problem to 
its developer.

Getting More Help
Contact the author or vendor of any third-party software if you require further assistance. 
Sprint does not provide technical support for applications that are not built into your Treo Pro 
smartphone.

Making Room on Your Treo Pro Smartphone

If you store a large number of records, or install many third-party applications, the internal 
memory on your Treo Pro smartphone may fill up. Here are some ways to clear space on your 
device:

� Camera: Large images take up a lot of memory. Move images to an expansion card, or 
delete images from your smartphone (see “Synchronizing Your Media Files” on 
page 225).

� Email: Email attachments can consume excessive memory. Move attachments to an 
expansion card, or delete large files from your smartphone (see “Managing Your 
Messages” on page 170). You may also want to empty the deleted items folder.

� Internet: If you save links to pages you’ve visited in Internet Explorer Mobile, you may want 
to clear all recent pages (see “Customizing Your Internet Explorer® Mobile Settings” on 
page 190).

� Third-party applications: You can delete infrequently used applications or move them to 
an expansion card (see “Copying or Moving Applications and Files Between 
Your Treo Pro Smartphone and an Expansion Card” on page 326). 
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Also, remember that your Treo Pro smartphone includes an expansion card slot, and that you 
can store applications and information on expansion cards. However, you still need free 
memory on the device itself to run applications from an expansion card.

Voice Quality

Is the Other Person Hearing an Echo?
� Try decreasing the volume on your smartphone to avoid coupling or feedback on the 

other person’s end. This applies to both the speakerphone and the handset earpiece.
� Position the smartphone closer to your ear to prevent sound leaking back to the 

microphone. Keep your hand away from the microphone hole in the lower-left corner of 
your device.

� If you’re using Speakerphone mode with your smartphone lying on a flat surface, try 
turning the device face-down (screen facing the surface). 

Are You Hearing Your Own Voice Echo?
Ask the other person to turn down the volume or to hold the smartphone closer to his or 
her ear.

Is Your Voice Too Quiet on the Other End?
Be sure to hold the bottom of the Treo Pro smartphone, or the hands-free microphone, close 
to your mouth. 

Check the signal-strength indicator. If the signal is weak, try to find an area with 
better coverage.
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1xRTT: A standard of wireless Internet connectivity that allows for persistent data connections 
as long as you are actively using your data connection. The average data transmission rate is 
about 70Kbps, although theoretical limits are 153.6Kbps. With data services plans, you pay a 
monthly rate for unlimited data transfer and you don’t pay for connection time.

ActiveSync®: The software on your Treo™ Pro smartphone by Palm that exchanges and 
updates the information on your smartphone with the information on your computer.

ActiveSync Desktop Software: The software on your Windows XP computer that exchanges 
and updates the information on your computer with the information on your Treo Pro 
smartphone. To open ActiveSync on your computer, double-click the ActiveSync icon in the 
taskbar in the lower-right corner of your screen. If the icon does not appear, click Start > All 
Programs > Microsoft ActiveSync. See “Installing Desktop Sync Software: Windows XP and 
Windows Vista” on page 44.

Auto-off interval: The time of inactivity that passes before the screen on your Treo Pro 
smartphone turns off. The wireless features on your device are unaffected by this setting.

Beam: The process of sending or receiving an entry or application using the infrared port on 
your Treo Pro smartphone or using Bluetooth® wireless technology. 

Bluetooth® wireless technology: Technology that enables devices such as the Treo Pro 
smartphone, wireless phones, and computers to connect wirelessly to each other so that they 
can exchange information over short distances. 
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Desktop software: A PIM application for computers, such as Microsoft® Outlook®, that helps 
you manage your personal information and keep your personal information synchronized 
with your Treo Pro smartphone.

Direct Push technology: A two-way wireless delivery method used between Microsoft 
Exchange Server 2007, or Exchange Server 2003 upgraded to Service Pack 2, and a Treo Pro 
smartphone with Windows Mobile® 6.1 with MSFP (Messaging and Security Feature Pack). 
Microsoft Direct Push technology enables features such as Tasks Over The Air (OTA), and 
IP-based push updating of Outlook information (Inbox, Calendar, Contacts, and Tasks).

EVDO (Evolution Data Optimized): A wireless broadband technology that is designed for 
very high-speed data transfer with average download speeds of 400 to 700Kbps and that is 
capable of reaching speeds up to a theoretical maximum of 3.2Mbps, and upload speeds up 
to 1.8Mbps. The Sprint Mobile Broadband Network uses EVDO technology. Your Treo Pro 
smartphone supports EVDO Rev 0 and Rev A technologies. 

Global Address List (GAL): An online address book for Microsoft Exchange Server 2007 or 
Exchange Server 2003 upgraded to Service Pack 2. The GAL contains names, email 
addresses, and other information, and is created and maintained by your Exchange server 
administrator. 

Infrared (IR): A way of transmitting information using light waves. The IR port on 
your Treo Pro smartphone lets you transfer information between other IR devices within a 
short radius.

Lithium-ion (li-ion): The rechargeable battery technology used in your device. 

Microsoft System Center Mobile Device Manager: A security management platform that 
enables system administrators to set and implement security policies by remotely controlling 
mobile devices. This platform also enables users to access corporate information on 
networks with firewalls.

Mobile Broadband Network: An advanced wireless data network using the fastest 
commercially available wireless network technology (EVDO) to deliver broadband-like transfer 
speeds for your data connections. 
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Partnership: Two Bluetooth devices—for example, your Treo Pro smartphone and a 
hands-free device—that can connect because each device finds the same passkey on the 
other device. Once you form a partnership with a device, you don’t need to enter a passkey to 
connect with that device. Partnership is known on some devices as paired relationship, 
pairing, trusted device, or trusted pair.

Phone as Modem: The feature that enables your device (when connected to the mobile 
broadband network) to be used as a high-speed modem for your computer, using a wired 
(USB cable) connection.

Phone Off: The icon that indicates when the phone feature is not connected to any wireless 
phone network. You can still use the organizer and other features.

PIM (personal information manager): A category of software that includes applications such 
as Microsoft Outlook, Palm® Desktop software, Lotus Notes, and ACT!. PIMs generally store 
contacts, schedules, tasks, and memos. 

SMS: The service that exchanges short text messages almost instantly between wireless 
devices. These messages can usually include up to 160 characters. Your Treo Pro 
smartphone can send and receive text messages while you are on a voice call.

Sprint 1xRTT: The next generation of wireless Internet access that enables you to check your 
email and browse the Web.

SSID: The name that identifies a Wi-Fi network. If a network does not broadcast its SSID, you 
must get the SSID from the system administrator in order to connect to the network.

Synchronization: The process in which information that is entered or updated on your 
Treo Pro smartphone, your computer, or a server is updated in one of the other locations 
either wirelessly or by means of a cable connection. See “Synchronizing Information” on 
page 331.

User name: The name associated with your Treo Pro smartphone that distinguishes it from 
other Windows Mobile devices. When you first synchronize your device, you are asked to give 
it a user name. 

Wi-Fi access point: A network device with an antenna that provides wireless connections to a 
larger network. Also called a hotspot.
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Windows Mobile®: The operating system of your Treo Pro smartphone. Your device uses the 
Windows Mobile 6.1 Professional edition of this operating system. 

Windows Mobile Device Center: The software on your Windows Vista® computer that 
enables you to synchronize content and manage music, pictures, and videos between your 
device and your computer. To open Windows Mobile Device Center on your computer, click 
Start > All Programs > Windows Mobile Device Center.
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FCC Statements

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

� Reorient or relocate the receiving antenna.
� Increase the separation between the equipment and receiver.
� Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected.
� Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

This phone meets the FCC Radiofrequency Emission Guidelines and is certified with the FCC 
as: 

FCC ID: O8F-SKYC.

The FCC ID on your Palm smartphone is located on a label inside the battery compartment. 
The battery must be removed as shown below to view the label.

WARNING This guide contains important operational and safety information that helps 
you safely use your Treo™ Pro smartphone by Palm. Failure to read and 
follow the information provided in this guide may result in serious bodily 
injury, death, or property damage.
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Use only the supplied integral antenna. Unauthorized antenna modifications or attachments 
could damage the unit and may violate FCC regulations.

Industry Canada

Operation is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference 
that may cause undesired operation.

This Class B digital apparatus complies with Canadian ICES-003.

The term “IC” before the equipment certification number only signifies that the Industry 
Canada technical specifications were met.

IC: 3905A-SKYC

L’ utilisation de ce dispositif est autorisée seulement aux conditions suivantes : (1) il ne doit 
pas produire de brouillage et (2) l’ utilisateur du dispositif doit étre prêt à accepter tout 
brouillage radioélectrique reçu, même si ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif. 

Cet appareil numérique de la classe [*] est conforme à la norme NMB-003 du Canada.

Caution Changes or modifications not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment.
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RF Safety Exposure

General statement on RF energy: Your smartphone contains a transmitter and a receiver. 
When it is ON, it receives and transmits RF energy. When you communicate with your 
smartphone, the system handling your call controls the power level at which your smartphone 
transmits.

Specific Absorption Rate (SAR): Your mobile device is a radio transmitter and receiver. It is 
designed not to exceed the limits for exposure to radio waves recommended by international 
guidelines. These guidelines were developed by the independent scientific organization 
ICNIRP and include safety margins designed to assure the protection of all persons, 
regardless of age and health.

In order to certify this unit for sale to the public, this unit has been tested for RF exposure 
compliance at a qualified test laboratory and found to comply with the regulations regarding 
exposure to RF Energy under the recommendations of the International Commission on 
Non-Ionizing Radiation Protection (ICNIRP). The tests are performed in positions and 
locations as required by the FCC and IC for each model. 

As SAR is measured utilizing the device’s highest transmitting power, the actual SAR of this 
device while operating is typically below that indicated below. This is due to automatic 
changes to the power level of the device to ensure it only uses the minimum power required 
to communicate with the network.

The SAR limit for mobile devices set by FCC/IC is 1.6 W/kg averaged over 1 gram of tissue for 
the body or head (4.0 W/kg averaged over 10 grams of tissue for the extremities—hands, 
wrists, ankles, and feet). 

The highest reported SAR values of the Palm smartphone are:

Maximum Scaled SAR Values (FCC)

Head 1.4 W/kg

Body 1.29 W/kg
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In order to comply with FCC and IC RF exposure safety guidelines, users MUST use one of 
the following types of body worn accessories:

1. A Palm® brand body-worn accessory that has been tested for (specific absorption rate) 
SAR compliance and is intended for use with this product.

2. An accessory that contains NO metal (snaps, clips, etc.) and provides AT LEAST 1.5 cm 
(0.6 in.) of separation between the user’s body and the unit.

Do NOT use the device in a manner such that it is in direct contact with the body (i. e., on the 
lap or in a breast pocket). Such use will likely exceed the FCC RF safety exposure limits. See 
www.fcc.gov/oet/rfsafety for more information on RF exposure safety.

To view the most recent SAR values of the Treo Pro smartphone, visit palm.com/55058.

Body Worn Operation: Important safety information regarding radio frequency radiation (RF) 
exposure: To ensure compliance with RF exposure guidelines the smartphone must be used 
with a minimum of 1.5 cm (0.6 in.) separation from the body. Failure to observe these 
instructions could result in your RF exposure exceeding the relevant guideline limits.

Limiting Exposure to Radio Frequency (RF) Fields: For individuals concerned about limiting 
their exposure to RF fields, the World Health Organization (WHO) provides the following 
advice:

Precautionary Measures: Present scientific information does not indicate the need for any 
special precautions for the use of mobile phones. If individuals are concerned, they might 
choose to limit their own or their children’s RF exposure by limiting the length of calls, or 
using ‘hands-free’ devices to keep mobile phones away from the head and body.

Further information on this subject can be obtained from the WHO home page 
http://www.who.int/mediacentre/factsheets/fs193/en/index.html WHO Fact sheet 193: 
June 2000.

http://www.fcc.gov/oet/rfsafety
http://palm.com/55058
http://www.who.int/mediacentre/factsheets/fs193/en/index.html 
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Hearing Aid Compatibility (HAC)

Using Your Phone With a Hearing Device

Your smartphone is compliant with the FCC Hearing Aid Compatibility (HAC) requirements. 
For additional HAC information, including the HAC rating of this product, please refer to 
http://www.palm.com/treopro-t850-hac.

Your device has been tested for hearing aid compatibility. When some wireless phones are 
used near some hearing devices (hearing aids and cochlear implants), users may detect a 
buzzing, humming or whining noise. Some hearing devices are more immune than others to 
this interference noise, and phones also vary in the amount of interference they generate.

The wireless telephone industry has developed ratings for some of their mobile phone, to 
assist hearing-device users in finding phones that may be compatible with their hearing 
devices. Not all phones have been rated. Phones that have been rated have a label on the 
box. Your Treo™ Pro smartphone by Palm has an M3/T3 rating. Your smartphone has not 
been HAC rated with respect to its Wi-Fi operation because currently no HAC standards exist 
for Wi-Fi.

These ratings are not guarantees. Results will vary, depending on the level of immunity of your 
hearing device and the degree of your hearing loss. If your hearing device happens to be 
vulnerable to interference, you may not be able to use a rated phone successfully. Trying out 
the phone with your hearing device is the best way to evaluate it for your personal needs.

M-Ratings: Phones rated M3 or M4 meet FCC requirements and are likely to generate less 
interference with hearing devices than phones that are not labeled. M4 is the better/higher of 
the two ratings.

T-Ratings: Phones rated T3 or T4 meet FCC requirements and are likely to be more usable 
with a hearing device's telecoil (“T switch” or “Telephone Switch”) than unrated phones. T4 is 
the better/higher of the two ratings.

The more immune your hearing aid device is, the less likely you are to experience 
interference noise from your wireless phone. Hearing aid devices should have ratings similar 

http://www.palm.com/treopro-t850-hac
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to those of phones. Ask your hearing health-care professional for the rating of your hearing 
aid. Add the rating of your hearing aid and your phone to determine probable usability:

� Any combined rating equal to or greater than six offers the best use.
� Any combined rating equal to five is considered normal use.
� Any combined rating equal to four is considered usable.

Thus, if you pair an M3 hearing aid with an M3 phone, you will have a combined rating of six 
for “best use.” This is synonymous for T ratings.

Palm further suggest that you experiment with multiple phones (even those not labeled M3/T3 
or M4/T4) while in the store to find the one that works best with your hearing aid device. If you 
experience interference or find the quality of service unsatisfactory after purchasing your 
device, promptly return it to the store within 30 days of purchase. With the Palm 30-day 
Risk-Free Guarantee, you may return the device within 30 days of purchase for a full refund, 
and you will only be responsible for charges based on your actual usage.

Getting the Best Hearing Device Experience With Your Device

To further minimize interference:
� Set the phone's screen and keyboard backlight settings to ensure the minimum time 

interval.
� Move the phone around to find the point with the least interference.

Battery Handling

� Do not disassemble or open, crush, bend or deform, puncture or shred.
� Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse 

or expose to water or other liquids, or expose to fire, explosion, or other hazard. 
� Only use the battery for the system for which it is specified. 
� Only use the battery with a charging system that has been qualified with the system per 

the IEEE/CTIA-1725 standard. Use of an unqualified battery or charger may present a risk 
of fire, explosion, leakage, or other hazard. 
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� Do not short circuit a battery or allow metallic conductive objects to contact battery 
terminals. 

� Replace the battery only with another battery that has been qualified with the system per 
IEEE/CTIA-1725. Use of an unqualified battery may present a risk of fire, explosion, 
leakage or other hazard. 

� Promptly dispose of used batteries in accordance with local regulations.
� Battery usage by children should be supervised. 
� Avoid dropping the phone or battery. If the phone or battery is dropped, especially on a 

hard surface, and the user suspects damage, take it to a service center for inspection. 
� Do not handle a damaged or leaking Lithium-Ion (LI-ion) battery as you can be burned.
� Improper battery use may result in a fire, explosion or other hazard. 

Based on DOT rules, spare batteries must not be transported in checked luggage on 
commercial flights. Spare batteries can only be transported in carry-on luggage. For more 
information: http://safetravel.dot.gov/whats_new_batteries.html.

Protecting Your Battery
The guidelines listed below help you get the most out of your battery’s performance.

Recently there have been some public reports of wireless phone batteries overheating, 
catching fire, or exploding. It appears that many, if not all, of these reports involve counterfeit 
or inexpensive, aftermarket-brand batteries with unknown or questionable manufacturing 
standards. Use only manufacturer-approved batteries and accessories found at Carrier Stores 
or through your device’s manufacturer. Buying the right batteries and accessories is the best 
way to ensure they're genuine and safe.

� In order to avoid damage, charge the battery only in temperatures that range from 32° F to 
122° F (0° C to 50° C).

� Don’t use the battery charger in direct sunlight or in high humidity areas, such as the 
bathroom.

� Never dispose of the battery by incineration.
� Keep the metal contacts on top of the battery clean.
� Don't attempt to disassemble or short-circuit the battery.

http://safetravel.dot.gov/whats_new_batteries.html
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� The battery may need recharging if it has not been used for a long period of time.
� It’s best to replace the battery when it no longer provides acceptable performance. It can 

be recharged hundreds of times before it needs replacing
� Don’t store the battery in high temperature areas for long periods of time. It's best to follow 

these storage rules:
� Less than one month: 14° F to 140° F (–10° C to 60° C)

� More than one month: 14° F to 113° F (–10° C to 45° C)

Power Specifications

Use only Palm-approved power accessories such as AC-power adapters and batteries. 
Unauthorized and non-approved batteries will NOT operate with the Palm smartphone.

AC Power Adapter source: Foxlink
Model: 5890-712V-02K0
Part Number: 157-10108-00
Input Rating: 100–240 Vac, 50/60Hz, 0.2A
Output Rating: 5Vdc, 1000mA

Battery Source: Palm
Type: Rechargeable Li-ion Polymer
Model: 157-10105-00
Rating: 3.7Vdc, 1500mAh (minimum)

Recycling and Disposal

This symbol indicates that Palm products should be recycled and not be disposed 
of in unsorted municipal waste. Please return Palm products to the electrical and 
electronic equipment collection points in your municipality or county. These 
collection points are available free of charge. For detailed information please refer to 
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your municipality or county. For information on Palm’s environmental programs, visit 
www.palm.com/environment.

Hazardous substances that may be included in electronic products can potentially affect 
human health and the environment. Recycling benefits the environment by diverting waste 
from landfills and by recovering materials that may be recycled into other products. 
Responsible recycling ensures materials are properly collected and disposed. Palm is 
committed to support the European Union WEEE directive (2002/96/EC) and the protection of 
the environment for future generations. 

As part of Palm’s corporate commitment to be a good steward of the environment, we strive to 
use environmentally friendly materials, reduce waste and collaborate with our channel 
partners to raise awareness and help keep Palm handheld devices, smartphones and mobile 
companions out of landfills through evaluation and disposition for reuse and recycling.

Visit www.palm.com/recycle for additional details and information about how you can help 
reduce electronic waste.

User Safety

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT OPERATION. Read this information 
before using your smartphone. For the safe and efficient operation of your smartphone, 
observe these guidelines.

Potentially explosive atmospheres: Turn off your smartphone when you are in any areas with a 
potentially explosive atmosphere, such as fueling areas (gas or petrol stations, below deck on 
boats) storage facilities for fuel or chemicals, blasting areas and areas near electrical blasting 
caps, and areas where there are chemicals or particles (such as metal powders, grains and 
dust) in the air.

Interference to medical and personal Electronic Devices: Most but not all electronic 
equipment is shielded from RF signals and certain electronic equipment may not be shielded 
against the RF signals from your smartphone.

http://www.palm.com/environment
http://www.palm.com/recycle
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Pacemakers: The Health Industry Manufacturers Association recommends that a minimum 
separation of 15 centimeters (6 inches) be maintained between a smartphone and a 
pacemaker to avoid potential interference with the pacemaker. These recommendations are 
consistent with the independent research by the recommendations of Wireless Technology 
Research.

Persons with pacemakers should:
� ALWAYS keep the smartphone more than 6 inches (15 centimeters) from their pacemaker 

when the smartphone is turned ON. 
� Not carry the smartphone in a breast pocket.
� Use the ear opposite the pacemaker to minimise the potential for interference.
� Turn the smartphone OFF immediately if you have any reason to suspect that interference 

is taking place.

Other Medical Devices, Hospitals: If you use any other personal medical device, consult the 
manufacturer of your device to determine if it is adequately shielded from external RF energy. 
Your physician may be able to assist you in obtaining this information. Turn your smartphone 
OFF in health care facilities when any regulations posted in these areas instruct you to do so. 
Hospitals or health care facilities may be using equipment that could be sensitive to external 
RF energy.

Repetitive Motion Injuries: When using the keyboard or playing games on your smartphone, 
you may experience discomfort in your neck, shoulders, hands, arms, of other parts of the 
body. To avoid any injury, such as tendonitis, carpal tunnel syndrome, or other 
musculoskeletal disorder, make sure to take necessary breaks from use, take longer rests 
(such as several hours) if discomfort or tiring begins, and see a doctor if discomfort persists. 
To minimize the risk of Repetitive Motion Injuries, when Texting or playing games with your 
phone:

� Do not grip the phone too tightly.
� Press the buttons lightly.
� Make use of the special features in the handset which minimize the number of buttons 

which have to be pressed, such as message templates and predictive text.
� Take lots of breaks to stretch and relax.
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Audio Safety: This smartphone is capable of producing loud noises which may damage your 
hearing. When using the speakerphone feature, it is recommended that you place your 
smartphone at a safe distance from your ear. 

Blackouts and Seizures: Blinking lights, such as those experienced with television or playing 
video games may cause some people to experience blackout or seizure, even if never 
experienced before. In the event a smartphone user should experience any disorientation, 
loss of awareness, convulsion, eye or muscle twitching or other involuntary movements, stop 
use immediately and consult a doctor. Individuals with personal or family history of such 
events should consult a doctor before using the device. To limit the possibility of such 
symptoms, wherever possible every hour take a minimum of 15 minutes, use in a well lighted 
area, view the screen from the farthest distance and avoid exposure to blinking lights if you 
are tired.

Operating Machinery: Do not use your smartphone while operating machinery. Full attention 
must be given to operating the machinery in order to reduce the risk of an accident.

Aircraft: While in aircraft, follow all instructions regarding the operation of your smartphone. 
Use of your smartphone while on board an aircraft must be done in accordance in 
compliance with airline instructions and regulations.

Vehicles With Air Bags: Your smartphone should not be placed in a position that would affect 
the operation of air bag deployment or in a position that, should the air bag inflate, could 
propel the smartphone. Air bags will inflate with great force and care should be taken to 
protect within a vehicle that has air bags. Do not place a phone in the area over an air bag or 
in the air bag deployment area. Store the phone safely before driving the vehicle.

Hearing Aids: People with hearing aids or other cochlear implants may experience interfering 
noises when using wireless devices or when one is nearby. The level of interference will 
depend on the type of hearing device and the distance from the interference source. 
Increasing the separation between them may reduce the interference. You may also consult 
your hearing aid manufacturer to discuss alternatives.

Small Children: Do not leave your smartphone and its accessories within the reach of small 
children or allow them to play with it. They could hurt themselves or others, or could 
accidentally damage the smartphone. Your smartphone contains small parts with sharp 
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edges that may cause an injury or which could become detached and create a choking 
hazard.

Keep the device away from the abdomens of pregnant women and adolescents, particularly 
when using the device hands-free.

To reduce exposure to radiation, use your device in good reception areas, as indicated by the 
bars on your phone, at least 3 to 4 bars.

Caution: Avoid Potential Hearing Loss

Prolonged exposure to loud sounds (including music) is the most common cause of 
preventable hearing loss. Some scientific research suggests that using portable audio 
devices, such as portable music players and cellular telephones, at high volume settings for 
long durations may lead to permanent noise-induced hearing loss. This includes the use of 
headphones (including headsets, earbuds and Bluetooth® or other wireless devices). 
Exposure to very loud sound has also been associated in some studies with tinnitus (a 
ringing in the ear), hypersensitivity to sound and distorted hearing. Individual susceptibility to 
noise-induced hearing loss and other potential hearing problems varies. The amount of 
sound produced by a portable audio device varies depending on the nature of the sound, the 
device, the device settings and the headphones. You should follow some common sense 
recommendations when using any portable audio device:

� Set the volume in a quiet environment and select the lowest volume at which you can 
hear adequately.

� When using headphones, turn the volume down if you cannot hear the people speaking 
near you or if the person sitting next to you can hear what you are listening to.

� Do not turn the volume up to block out noisy surroundings. If you choose to listen to your 
portable device in a noisy environment, use noise-cancelling headphones to block out 
background environmental noise.

� Limit the amount of time you listen. As the volume increases, less time is required before 
your hearing could be affected.

� Avoid using headphones after exposure to extremely loud noises, such as rock concerts, 
that might cause temporary hearing loss. Temporary hearing loss might cause unsafe 
volumes to sound normal.
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� Do not listen at any volume that causes you discomfort. If you experience ringing in your 
ears, hear muffled speech or experience any temporary hearing difficulty after listening to 
your portable audio device, discontinue use and consult your doctor.

� You can obtain additional information on this subject from the following sources:

American Academy of Audiology
11730 Plaza American Drive, Suite 300
Reston, VA 20190
Voice: (800) 222-2336
Email: info@audiology.org
Internet: www.audiology.org

National Institute on Deafness and Other 
Communication Disorders 
National Institutes of Health
31 Center Drive, MSC 2320
Bethesda, MD USA 20892-2320
Voice: (301) 496-7243
Email: nidcdinfo@nih.gov
Internet: http://www.nidcd nih.gov/health/hearing

National Institute for Occupational Safety and Health
Hubert H. Humphrey Bldg.
200 Independence Ave., SW
Washington, DC 20201
Voice: 1-800-35-NIOSH (1-800-356-4674)
Internet: http://www.cdc.gov/niosh/topics/noise

Product Handling & Safety

General Statement on Handling and Use: You alone are responsible for how you use your 
smartphone and any consequences of its use.

http://www.audiology.org
http://www.nidcd.nih.gov/health/hearing
http://www.cdc.gov/niosh/topics/noise
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You must always switch off your smartphone wherever the use of a phone is prohibited. Use 
of your smartphone is subject to safety measures designed to protect users and their 
environment.

� Always treat your smartphone and its accessories with care and keep it in a clean and 
dust-free place.

� Do not expose your smartphone or its accessories to open flames or lit tobacco products.
� Do not expose your smartphone or its accessories to liquid, moisture, or high humidity.
� Do not drop, throw, or try to bend your smartphone or its accessories.
� Do not use harsh chemicals, cleaning solvents, or aerosols to clean the device or its 

accessories.
� Do not paint your smartphone or its accessories.
� Do not attempt to disassemble your smartphone or its accessories; only authorised 

personnel must do so.
� Do not expose your smartphone or its accessories to extreme temperatures, minimum 0 

and maximum +60 degrees Celsius (32F–140F).
� Please check local regulations for disposal of electronic products.
� Do not carry your smartphone in your back pocket as it could break when you sit down.

Battery: Your smartphone includes an internal lithium-ion polymer battery. Please note that 
use of certain data applications can result in heavy battery use and may require frequent 
battery charging. Any disposal of the smartphone or battery must comply with laws and 
regulations pertaining to lithium-ion or lithium-ion polymer batteries. 

Demagnetisation: To avoid the risk of demagnetisation, do not allow electronic devices or 
magnetic media close to your smartphone for a long time.

Normal Use Position: When making or receiving a phone call, hold your smartphone to your 
ear, with the bottom towards your mouth or as you would a fixed line phone.

Emergency Calls: This smartphone, like any wireless phone, operates using radio signals, 
which cannot guarantee connection in all conditions. Therefore, you must never rely solely on 
any wireless phone for emergency communications.
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Smartphone Heating: Your smartphone may become warm during charging and during 
normal use.

Accessories: Use only approved accessories. Do not connect with incompatible products or 
accessories. Take care not to touch or allow metal objects, such as coins or key rings, to 
contact or short-circuit the battery terminals.

Connection to a Car: Seek professional advice when connecting a phone interface to the 
vehicle electrical system.

Faulty and Damaged Products: Do not attempt to disassemble the smartphone or its 
accessory. Only qualified personnel must service or repair the smartphone or its accessory. If 
your smartphone or its accessory has been submerged in water, punctured, or subjected to a 
severe fall, do not use it until you have taken it to be checked at an authorised service center.

Interference in Cars and to Other Electronic Devices: Please note that because of possible 
interference to electronic equipment, some vehicle manufacturers forbid the use of mobile 
phones in their vehicles unless a hands-free kit with an external antenna is included in the 
installation. RF energy may affect improperly installed or inadequately shielded electronic 
operating and entertainment systems in motor vehicles. Check with the manufacturer or 
representative to determine if these systems are adequately shielded from external RF energy. 
Also check with the manufacturer of any equipment that has been added to the vehicle.

Driving Safety

Driving Safety Tips Overview

Always obey all laws and regulations on the use of the smartphone in your driving area.

Safety—Your most important call. The Wireless Industry reminds you to use your smartphone 
safely when driving.

1. Get to know your smartphone and its features, such as speed-dial and redial.

2. Use a hands-free device.

3. Position your smartphone within easy reach.
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4. Let the person you are speaking to know you are driving; if necessary, suspend the call 
in heavy traffic or hazardous weather conditions.

5. Do not take notes, look up phone numbers, read/write e-mail, or surf the internet while 
driving.

6. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or 
before pulling into traffic.

7. Do not engage in stressful or emotional conversations that may divert your attention 
from the road.

8. Dial your national emergency number to report serious emergencies. This is a free call 
from your smartphone.

9. Use your smartphone to help others in emergencies.

10. Call roadside assistance or a special non-emergency wireless number when necessary.

Driving Safety Tips Details

1. Get to know your smartphone and its features such as speed-dial and redial. Carefully 
read your instruction manual and learn to take advantage of valuable features most 
smartphone models offer, including automatic redial and memory dial. Also, work to 
memorize the smartphone keyboard so you can use the speed-dial function without 
taking your attention off the road.

2. Use a hands-free device. A number of hands-free smartphone accessories are readily 
available today. Whether you choose an installed mounted device for your smartphone 
or a speakerphone accessory, take advantage of these devices. If driving while using a 
smartphone is permitted in your area, we recommend using a phone headset or a 
hands-free car kit (sold separately). However, be aware that use of a headset that covers 
both ears impairs your ability to hear other sounds. Use of such a headset while 
operating a motor vehicle or riding a bicycle may create a serious hazard to you and/or 
others, and may be illegal. If you must use a stereo headset while driving, place a 
speaker in only one ear. Leave the other ear free to hear outside noises, and do so only 
if it is legal and you can do so safely.



428 Section 8A: Important Safety Information

3. Make sure you place your smartphone within easy reach and where you can grab it 
without removing your eyes from the road. If you get an incoming call at an inconvenient 
time, let your voicemail answer it for you.

4. Suspend conversations during hazardous driving conditions or situations. Let the 
person you are speaking to know you are driving; if necessary, suspend the call in 
heavy traffic or hazardous weather conditions. Rain, sleet, snow, and ice can be 
hazardous, but so is heavy traffic. As a driver, your first responsibility is to pay attention to 
the road.

5. Do not take notes, look up phone numbers, read/write e-mail, or surf the Internet while 
driving. If you are reading an address book or business card while driving a car, or 
writing a to-do list, then you are not watching where you are going. It's common sense. 
Don't get caught in a dangerous situation because you are reading or writing and not 
paying attention to the road or nearby vehicles.

6. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or 
before pulling into traffic. Try to plan your calls before you begin your trip, or attempt to 
schedule your calls with times you may be temporarily stopped or otherwise stationary. 
But if you need to dial while driving, follow this simple tip: dial only a few numbers, 
check the road and your mirrors, then continue.

7. Do not engage in stressful or emotional conversations that may be distracting. Stressful 
or emotional conversations and driving do not mix—they are distracting and even 
dangerous when you are behind the wheel. Make people you are talking with aware you 
are driving and if necessary, suspend phone conversations which have the potential to 
divert your attention from the road.

8. Use your smartphone to call for help. Your smartphone is one of the greatest tools you 
can own to protect yourself and your family in dangerous situations—with your 
smartphone at your side, help is only three numbers away. Dial your national 
emergency number in the case of fire, traffic accident, road hazard, or medical 
emergencies. Remember, your national emergency number is a free call on your 
smartphone.
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9. Use your smartphone to help others in emergencies. If you see an auto accident, crime 
in progress, or other serious emergency where lives are in danger, call your national 
emergency number, as you would want others to do for you.

10. Call roadside assistance or a special wireless non-emergency assistance number when 
necessary. Certain situations you encounter while driving may require attention, but are 
not urgent enough to merit a call to your national emergency number. But you can still 
use your smartphone to lend a hand. If you see a broken-down vehicle posing no 
serious hazard, a broken traffic signal, a minor traffic accident where no one appears 
injured, or a vehicle you know to be stolen, call roadside assistance or other special 
non-emergency wireless number.

End User Notice

Microsoft® Voice Command Version 1.6 for Windows Mobile®

Microsoft makes no representations, warranties, or other determinations that ANY use of the 
Software Product is legal, safe, or in any manner recommended or intended while driving or 
otherwise operating a motor vehicle.

Note The Voice Command application is not available in all languages.

Important Do not become distracted from driving safely if operating a motor vehicle 
while using Device Software. Operating certain parts of this Device requires 
user attention. Diverting attention away from the road while driving can 
possibly cause an accident or other serious consequences. Even 
occasional, short diversions of attention can be dangerous if your attention 
is diverted away from your driving task at a critical time. Do not change 
system settings or enter data non-verbally (using your hands) while driving. 
Stop the vehicle in a safe and legal manner before attempting these 
operations. This is important since while setting up or changing some 
functions you might be required to distract your attention away from the 
road and remove your hands from the wheel.
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General Operation

Voice Command Control: Many of the functions of the Device Software can be accomplished 
using only voice commands. Using voice commands while driving allows you to initiate the 
command with a button and then operate the Device mostly without removing your hands 
from the wheel.

Prolonged Views of Screen: If you are driving, do not access any function requiring a 
prolonged view of the screen. Pull over in a safe and legal manner before attempting to 
access a function of the system requiring prolonged attention. Even occasional short scans to 
the screen may be hazardous if your attention has been diverted away from your driving task 
at a critical time.

Let Your Judgment Prevail: The Device Software is only an aid. Make your driving decisions 
based on your observations of local conditions and existing traffic regulations. The Device 
Software is not a substitute for your personal judgment.

Volume Setting: Do not raise the volume excessively. Keep the volume at a level where you 
can still hear outside traffic and emergency signals while driving. Driving while unable to hear 
these sounds could cause an accident.

Use of Speech Recognition Functions: Speech recognition software is inherently a statistical 
process which is subject to errors. It is your responsibility to monitor the speech recognition 
functions and address any errors.

Hands-Free Capability

All CTIA Certified portable products provide the consumer with a toll-free number for the 
purchase of a compatible hands-free device. 1-800-881-7256.

ESD Safety

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the 
device, so you should take steps to avoid such an occurrence.
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Description of ESD

Static electricity is an electrical charge caused by the buildup of excess electrons on the 
surface of a material. To most people, static electricity and ESD are nothing more than 
annoyances. For example, after walking over a carpet while scuffing your feet, building up 
electrons on your body, you may get a shock—the discharge event—when you touch a metal 
doorknob. This little shock discharges the built-up static electricity.

ESD-Susceptible Equipment

Even a small amount of ESD can harm circuitry, so when working with electronic devices, take 
measures to help protect your electronic devices, including your PalmTM handheld, from ESD 
harm. While Palm has built protections against ESD into its products, ESD unfortunately exists 
and, unless neutralized, could build up to levels that could harm your equipment. Any 
electronic device that contains an external entry point for plugging in anything from cables to 
docking stations is susceptible to entry of ESD. Devices that you carry with you, such as your 
handheld, build up ESD in a unique way because the static electricity that may have built up 
on your body is automatically passed to the device. Then, when the device is connected to 
another device such as a docking station, a discharge event can occur.

Precautions Against ESD

Make sure to discharge any built-up static electricity from yourself and your electronic devices 
before touching an electronic device or connecting one device to another. The 
recommendation from Palm is that you take this precaution before connecting your handheld 
to your computer, placing the handheld in a cradle, or connecting it to any other device. You 
can do this in many ways, including the following:

� Ground yourself when you’re holding your mobile device by simultaneously touching a 
metal surface that is at earth ground.

� For example, if your computer has a metal case and is plugged into a standard 
three-prong grounded outlet, touching the case should discharge the ESD on your body.

� Increase the relative humidity of your environment.
� Install ESD-specific prevention items, such as grounding mats.
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Conditions That Enhance ESD Occurrences

Conditions that can contribute to the buildup of static electricity in the environment include the 
following:

� Low relative humidity.
� Material type (The type of material gathering the charge. For example, synthetics are more 

prone to static buildup than natural fibers like cotton.)
� The rapidity with which you touch, connect, or disconnect electronic devices.

While you should always take appropriate precautions to discharge static electricity, if you are 
in an environment where you notice ESD events you may want to take extra precautions to 
protect your electronic equipment against ESD.

Owner’s Record

The model number, regulatory number, and serial number are located on a nameplate inside 
the battery compartment. Record the serial number in the space provided below. This will be 
helpful if you need to contact us about your phone in the future.

Product: Treo Pro Smartphone

Model:

Serial No.:

User Guide template version 7B (November 2007)
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Specifications

Radio � CDMA phone
� EVDO and 1X bands 

Phone features � Personal speakerphone
� Hands-free headset jack (3.5 mm, 3-barrel connector)
� Microphone mute option
� TTY-compatible 
� HAC compliant (M3/T3 rating)

Processor 
technology

� Dual-core MSM7501A processor—528MHz 

Expansion � microSD-compatible expansion card slot

Battery � Rechargeable lithium-ion
� 1500mA/hr in power capacity
� Removable
� 3.5 hours to be fully charged

Operating system � Windows Mobile® 6.1 Professional

Camera � Still-image capture resolution: 1600 x 1200, 2.0 megapixel
� Up to 8x digital zoom

Size � 4.5 in. x 2.36 in. x 0.53 in. (114mm x 60mm x 13.5mm)

Weight � 4.6 ounces (130 grams)

Connectivity � Infrared (1.0 compliant)
� Bluetooth® wireless technology (2.0 + EDR compliant)
� Wi-Fi (802.11 b/g)
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Display � Touch-sensitive LCD screen (includes stylus)
� 65,536 colors (16-bit color)
� Resolution: 320 x 320 
� User-adjustable brightness

Keyboard � Built-in 30-key keyboard plus 5-way navigator
� Backlight for low lighting conditions

Included software � ActiveSync 
� Adobe Reader LE
� Astraware Sudoku
� Bejeweled 2
� Bubble Breaker 
� Calculator
� Calendar
� Camera 
� Comm Manager
� Contacts 
� Excel Mobile 
� File Explorer 
� Get WorldMate (link)
� Instant Messaging
� Internet Explorer Mobile 
� Internet Sharing
� Kinoma FreePlay 
� Live Search
� Messaging (SMS, MMS, and email)
� Messenger
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Included software 
(continued)

� My Treo 
� Notes 
� OneNote Mobile
� PC Setup
� Phone 
� Pictures & Videos 
� Pocket Express
� PowerPoint Mobile 
� Quick Tour 
� Remote Desktop Mobile
� Search 
� Software Store
� Solitaire 
� Sounds
� Sprint Music
� Sprint Navigation
� Sprint TV
� Sprite Backup
� Tasks 
� Titan (link)
� Wall Street Journal (link)
� Windows Live
� Windows Media Player Mobile 
� Word Mobile 
� YouTube Videos (link)
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System 
requirements (for 
sync with desktop 
sync software 
using USB cable)

� Windows XP Service Pack 2, or Windows Vista® with USB port. 
Later versions may also be supported.

� 32 MB of available RAM.
� 170MB of available disk space.
� Some wireless features require Microsoft Exchange Server 2003 

upgraded to Service Pack 2, or later.

Operating and 
storage 
temperature range

� 32°F to 122°F (0°C to 50°C)
� 5% to 90% RH
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Index

Numerics
1xRTT connections 405
411 phone calls 15
5-way navigator 22, 54, 57, 402
911 phone calls 79, 354

A
accented characters 64, 353
accessories 369
accounts

See also email accounts
accessing corporate 366
accessing GPS systems and 200
accessing voicemail and 85
accessing Windows Live services and 173
connecting to Exchange servers and 125
connecting to Wi-Fi networks and 207
creating passwords for 38
downloading music and 119
enabling data services and 32, 114, 115
enabling Internet Sharing and 115
getting user names for 115
making phone calls and 90, 92
managing 15
preventing unauthorized use of 362
roaming and 104
sending error reports and 363
sending instant messages and 178, 179, 

181

activation 32, 114
ActiveSync software 405

See also synchronization software
Add new device option 215
Add Optional Attendee command 266
Add Recipient command 144, 159
Add Required Attendee command 266
Add Server Source command 126
Add to Favorites command 188
Add to Speed Dial command 93
address books

accessing online 143, 144
disabling online 144
finding names in 149, 261
removing directory services from 143
synchronizing with 391

addresses
accessing Web pages and. See URLs
adding multiple 138, 177
adding to contacts 142, 169, 258
copying 391
mapping 260
searching for 145, 261
selecting 145
sending meeting requests and 266
sending messages and 137, 159, 161
setting email options for 149
setting security options for 152
verifying 143, 159
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ad-hoc connections 208
Adobe Reader LE application 308–311
Advanced Encryption Standard. See AES 

encryption
Advanced Server Settings screen 134
AES encryption 209
Agenda view (calendar) 263
Airplane Mode 221
alarm clock 361
alarms

adding to events 265, 269
adding to tasks 271, 273
setting vibrating 345
turning on and off 345, 361

alerts 106, 236
See also notifications

Align Screen option 347
alternate characters 64–66
alternative phone numbers 79
anniversaries 265
answering the phone 83, 91, 103
appearance settings 342, 346
applications

See also third-party applications
accessing menus in 58, 59
associating with buttons 348
closing 70
copying 326
deleting 322, 403
displaying 21, 68, 74
downloading 189, 318, 320
getting help with 14
included with smartphone 435

installing 319, 320
making phone calls and 88
marking as exclusive 71
moving to expansion cards 326
opening 68, 69, 325
placing on Start menu 348
running from expansion cards 325
running multiple 70
selecting 69, 71
sending email and 124, 155
switching among 71, 87
synchronizing 41, 42, 43, 280, 338
troubleshooting 362, 380
turning sounds on or off for 345
viewing memory usage for 363

appointments
See also events
adding 264, 265
appearing in wrong time slots 393
displaying 74, 263
entering multiple 264
hiding 267
marking as private 267
scheduling repeating 265
sending 163, 267
setting options for 269

area codes 261
attachments

adding 138, 160, 164, 240
deleting 164
downloading 141, 151, 154
embedding objects in 142
freeing internal memory and 403
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opening 140, 168
receiving 140
saving 150, 167
sending 155, 177, 239
troubleshooting 399
viewing information about 167

audio. See sounds
audio files. See media files
authentication 209, 398
Auto Correct option 353
Auto Save Conversations option 180
Auto Sign In option 180
AutoFilter command 293
Auto-Keyguard 356
Automatic Prepend option 101
Automatic Send/Receive option 135, 139, 

152
auto-off interval 364, 405

B
back panel, removing 25
background colors 164
background images 241, 342
background music 250
backlights 62, 236, 364
backup utilities 49, 374, 377, 396
backups, restoring 377, 396
battery

charging 26–27, 28, 369, 381
checking status of 27, 28, 364
creating Bluetooth connections and 217
disposing of 379
maximizing 28–29, 129, 211, 364

replacing 369, 378
battery icon 27, 28
beacon 103
beaming

defined 405
sending information and 217, 218–220
troubleshooting 381

birthdays 265
blank screens 382
Block Recognizer (text) 67
blocking phone numbers 172
Bluetooth devices

accessing Web sites and 116, 117
adding 215
changing partnerships for 216
discovering 215
enabling or disabling connections to 118, 

215, 222
entering passkeys for 216
making phone calls and 95
maximizing battery and 28
sending and receiving over 217–218, 220
setting up connections to 214–216
synchronizing over 336–337
troubleshooting 218, 381, 386, 393

Bluetooth PAN connections 118
Bluetooth technology 405
bookmarks 187, 188
brightness 232, 234, 242, 346
broadband services 116
browsing files and folders 308, 317, 327
Browsing History command 193
browsing the Web 115, 183, 204, 403
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See also Web pages; Web sites
built-in applications 14, 322, 435

See also specific application
bulleted lists 284, 287, 288, 306
Burst mode 230, 233
buttons

assigning to Media Player 254
assigning voice commands to 349
changing language options for 192
disabling touch sensitivity for 355
making phone calls and 88, 355
navigating screen and 54, 57
opening applications and 68, 348
receiving voicemail and 103
turning sounds on or off for 345

C
CAB files 320
calculations 277, 296
Calculator application 276–277
calendar

adding appointments to 264, 265
adding meeting requests to 154
adding untimed events to 264
hiding appointments 267
opening 263
organizing events on 268
removing events from 269
removing meeting requests from 155
selecting default view for 269
sending items on 163, 267
setting alarms for 265, 269
setting options for 268, 269–270

troubleshooting sync problems for 393
unavailable time slots on 268
viewing appointments on 74, 263

Calendar application 263–270
Calendar button 22
call forwarding 90
Call History List 79, 82–83
Call sender command 165
call waiting 91
callback numbers 171
caller IDs 258
calling cards 16
calls. See phone calls
camera

adjusting picture settings for 232
adjusting video settings for 234
changing modes for 230–231
customizing settings for 235–236
freeing internal memory and 403
overview 230
recording videos with 233–234
setting image properties for 236
taking pictures with 231–233, 401
troubleshooting 401

Camera application 21
camera lens 24
capitalization 62, 354
Caps Lock 63
captions 163
Capture command 163
Capture Format option 235
Capture Speed option 235
car kits 94, 95, 96
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certificates 152, 187, 212, 319, 362
character sets 191
characters

See also text
addressing email and 138
beaming and 220
creating messages and 158, 160
creating passkeys and 216
creating passwords and 357
dialing phone numbers and 80, 86, 102
entering alternate 64–66
entering special 63, 294
setting input options for 353

charge indicator light 21, 26
charging the battery 26–27, 28, 369, 381
chat sessions 168, 170
chat view 167, 168
Check Names command 159
clearing

See also deleting
browsing history 193
History lists 83, 193
playlists 252
recent calls list 81
text formats 305
Wi-Fi network settings 211
word suggestions database 353

ClearType options 346
clock 360, 361, 364

See also time
Clock & Alarms Settings screen 359, 360, 

361

closing
applications 70
chat sessions 168
data service connections 222, 368
History lists 190
instant messaging sessions 181
Internet connections 187

collect calls 16
color settings

camera 401
messages 164
remote computers 329
spreadsheets 299
Today screen 342

Comm Manager 221–222
commands. See voice commands
Company Directory command 144
company names 78, 260

See also corporate address lists
compass 201
compressed files 318, 319, 320
computers

See also Windows systems
accessing remote 328–329, 365
charging battery and 27
connecting device to 40
copying files from 227, 281, 290
discovering Bluetooth devices and 215
finding synchronized files on 282
installing applications from 320
moving files to 281
retrieving email from 139, 141
retrieving Web favorites from 187
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setting up Internet Sharing for 116–117
synchronizing device with 40, 44–48, 337, 

339
conference calls 92
confidential information 268
Configure Server command 126
Configure Wireless Networks screen 206, 

207, 208
Connect via Bluetooth command 336
Connect via IR command 337
connections

See also Internet connections
accessing corporate servers and 366, 396
accessing GPS devices and 200, 201
closing data service 222, 368
customizing remote 329
device to PCs 40
making phone calls and 102
maximizing battery and 28, 29, 129
playing media files and 253
resetting device and 357, 377
retrieving email and 124, 134, 139, 152
retrieving multimedia messages and 172
roaming and 104–106
setting up Bluetooth 214–216
setting up Exchange server 125, 332–334
setting up VPN 366–367
starting manually 367
synchronizing over USB 48
synchronizing over wireless 41, 129, 335, 

336, 337
timing out 395
troubleshooting 383–387

contacts
accessing 88
adding 142, 169, 174, 258
assigning pictures 98, 242, 258
assigning ringtones 98, 258
automatically entering info for 78
changing information for 259
deleting 261
dialing phone numbers for 77, 79, 92
entering multiple 258
filtering 260
getting addresses for 143, 144, 261
looking up 77, 144, 259
saving information for 89, 142
searching messages for 145
sending information for 163, 262
sending messages to 137, 159, 161
setting display options for 261
transferring to car kits 96
viewing information about 81, 167, 259, 

260
Contacts application 258–261
Contacts list 159, 261
Contacts picture mode 230, 233
contrast 242
cookies 191, 193
copying

addresses 391
applications 326
files 227, 281, 290, 318, 326
numbers 277
phone numbers 78, 80
pictures or videos 240
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text 190, 286
copyrighted items 239
corporate address lists 144
corporate email accounts 134, 366, 396
corporate intranets 208
corporate networks 366
corporate servers 366

See also Exchange servers
Counter option 236
coupling 404
coverage areas 34, 106
cropping pictures 242
currency symbols 347
customer support 14, 15, 374, 403
customizing

calendar 269–270
camera settings 235–236
contacts 261
data services 120
display 346
email accounts 148–154
format settings 347
instant messaging 182
Internet Explorer Mobile 190–192
Media Player Mobile 253–254
message settings 171–172
notes 276
notifications 345
phone 96–104
remote connections 329
spreadsheets 304
system settings 359–364
system sounds 344–346

tasks 272–273
Today screen 342–343
Wi-Fi connections 211–214
Word documents 289

cutting. See deleting

D
data connections. See connections
data encryption. See encryption
data service icons 384
data service providers 207, 398

See also Internet service providers
data services 114–115, 120, 222, 368
dates 235, 236, 347, 359, 360

See also calendar
Day view (calendar) 263
DDTM Mode option 102
decimal symbols 347
Define Name command 299
Delete All Calls command 81, 83
Delete Appointment command 269
Delete Call command 81
Delete from Library command 251
Delete Slide command 163
Deleted folder 150
Deleted Items folder 146, 171
deleting

applications 322, 403
attachments 164
certificates 362
contacts 261
cookies 193
directory services 143
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documents 289
email accounts 135
email messages 146, 149, 150, 153
events 269
Exchange server accounts 136
files 227, 247, 281, 318
items in playlists 252
meeting requests 155
multimedia messages 170
notes 276, 307
partnerships 216, 387
pictures or videos 243
sounds 346
tasks 272
text 57
text messages 165, 170

desktop software 20, 406
Desktop view (Web pages) 185
device. See smartphone
device-to-device connections 208
diagnostic information 362
dialing 76–80
digit grouping 347
digital cameras 237

See also camera
digital certificates 152, 187, 212, 319, 362
digital notebooks 305
digital signatures 151
Direct Push technology 125, 406
directory assistance 15
directory services 143, 149

See also address books; Global Address 
Lists

display. See touchscreen
display settings 165, 346
document file types 284
documentation 13, 14, 20
documents

checking spelling in 288
copying and pasting text in 286
creating 283, 284, 285
deleting 289
displaying 139, 284, 289
finding and replacing text in 285–286
formatting 287
opening 285
organizing 288
saving 283, 284, 285, 286, 289
setting margins for 287
setting options for 289

domains 133, 368
Download Message command 140
Download messages setting 152
downloading

attachments 140, 141, 151, 154
email 135, 140, 150, 152
files 189, 320
multimedia messages 166
music 119
pictures 189, 237
ringtones 96
videos 246

drafts 160
Draw command 274
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E
EAP authentication 210
earpiece 22
echoes 404
Edit My Text Messages option 160
Edit Server Settings screen 127
editing

pictures 242
text 146, 306

email
adding attachments to 138, 240
adding contact info from 142
adding signatures to 147
changing message size 151, 153
checking for 73
creating 137–138
deleting 146, 149, 150, 153
downloading 135, 140, 150, 152
entering keyboard shortcuts for 147
entering priority settings for 138
formatting 151, 153
forwarding 146
getting started with 124
making phone calls and 78, 84
receiving 139–140, 152, 222
replying to 145, 149
saving 138
searching 145
selecting links in 145, 148
sending 138, 152, 177, 186
storing attachments to 150
synchronizing 139, 174, 175
troubleshooting 397–399

verifying addresses for 143
viewing 140, 149, 151

email accounts
accessing corporate 134, 366, 396
changing settings for 135
creating multiple 129, 133
customizing 148–154
deleting 135
displaying list of 137, 148
naming 131, 133
selecting 137, 148
setting passwords for 127, 130, 132
setting security options for 148, 151
setting up IMAP or POP 129–135
troubleshooting 397, 399

email applications 124, 399
email providers 130, 132, 398
emergency phone calls 79, 354
emoticons 163, 177
Empty Deleted Items command 146, 171
Enable Community setting 180
Enable local network time setting 360
encoding 191
encryption

email accounts 151, 399
expansion cards 328
Web pages 187
Wi-Fi networks 206, 209

End button 22
End conversation command 177
erasing. See clearing; deleting
Error Reporting feature 362–363
errors 345, 362, 384
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ESMTP authentication 398
EVDO technology 406
events

See also appointments
categorizing 268
creating 264
deleting 269
marking as sensitive 267
setting reminders for 265, 269

Excel files 293
See also spreadsheets

Excel Mobile application 292–304
Exchange ActiveSync 41
Exchange servers

accessing address books for 143, 144
connecting to 332–334
deleting accounts 136
entering settings for 127
getting information from 125
receiving email and 125, 139
setting up accounts for 125–128
synchronizing over 41, 125, 129, 334
troubleshooting sync problems with 391, 

394–396
Exclusive Programs List 71
expansion card slot 24
expansion cards

encrypting 328
formatting 323
inserting and removing 324
installing applications onto 321
moving applications to 326
moving files to 247, 288, 303, 326

opening items on 325
playing media files on 246, 251
renaming items on 327
running applications from 325
saving files to 325
searching on 316
storing attachments on 150
storing information on 323, 326, 404
storing pictures and videos on 235
troubleshooting 381
viewing available space on 327
viewing items on 241, 251, 327

Express Settings command 122
Extensible Authentication Protocol. See EAP 

authentication
External GPS settings 201
external power sources 364

F
factory settings, restoring 254
factory-installed applications 14, 322, 435

See also specific application
favorites. See Web favorites
Favorites command 188
feedback 404
File Explorer 317–318
file names 284
file types

email attachments 140
images or pictures 237
media 246
multimedia 161
ringtones 96
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spreadsheets 293
videos 237
Word documents 284

files
See also media files
beaming 220
browsing 308, 317, 327
clearing temporary 193
compressing or decompressing 318, 319, 

320
copying 227, 281, 290, 318, 326
deleting 227, 247, 281, 318
displaying 48, 237
downloading 189, 320
finding synchronized 282
freeing internal memory and 403
getting from corporate servers 366
moving 281, 288, 303, 326
opening 308, 309, 318
renaming 327
saving 325
searching for 303, 316
selecting multiple 318
sending 155, 160, 177, 217
sorting 317
synchronizing 42, 226, 247, 280
troubleshooting sync problems for 391
viewing error information and 362

Files sync folder 42, 227, 281
filtering

call lists 81, 82
contacts 260
events 268

messages 145
spreadsheets 301
tasks 272

Find/Replace command 285
finding

contacts 77, 144, 259
data in spreadsheets 302
email messages 145
information 316
synchronized files 282
text 285, 310
user names 115

firewalls 366, 387, 391
5-way navigator 22, 54, 57, 402
Flicker Adjustment option 236
flight mode 221
folders

accessing Outlook 391
browsing 308, 317, 327
copying files to 227, 281, 290, 318, 326
creating 288
displaying items in 48, 237
emptying mail 146, 150
emptying message 171
finding synchronized files in 282
moving items among 288, 303, 318
organizing items in 241, 317
receiving messages and 138
removing items from 227, 247, 281, 318
renaming 327
searching 303, 316
selecting media files and 251, 252
storing pictures or videos in 231, 233
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storing Web favorites in 187, 188, 189
synchronizing and 42, 139, 227, 391

fonts 284, 292, 299
format settings 347
formatting

charts 302
email 151, 153
expansion cards 323
passwords 357
spreadsheets 292, 299–300
text 287, 305

Formatting toolbar 288
forwarding

email 146
multimedia messages 167
phone calls 90

Full Screen mode 185, 295, 329

G
getting started 14, 35, 58
Global Address Lists 143, 144, 406

See also address books
GPS devices 200–202
Grid option (camera) 236

H
hands-free car kits 94, 95, 96
hands-free devices

See also Bluetooth devices
adding 95
disabling key presses for 356
making phone calls and 94, 95
troubleshooting 386
turning on or off 95

hard resets 377–378
hardware 20
headset jack 22
headsets

listening to media files and 246
losing connections 386
making phone calls and 94, 96, 103
troubleshooting voice quality on 404

help 14, 374, 403
hidden networks (Wi-Fi) 208
highlighting items 56–57
high-speed connections 116, 365
hints (passwords) 358
History lists 190, 193

See also Call History List
home page 190
Hotmail accounts 173, 175
hotspots 407
HTML messages 146, 151, 153
hyperlinks. See links; URLs

I
icons

Adobe Reader LE 309
battery 27, 28
calendar 263, 269, 270
camera modes 230
data services 384
media player 249
message status 170
multimedia messages 163
slide shows 238
Sprint Navigation 200
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Today screen 106
video modes 233
voicemail 85, 86
Web pages 184
Wi-Fi connections 206

IEEE network access option 210
Ignore command 84
IM messages. See instant messages
image files 161, 237

See also images; media files
image properties (camera) 236
images 142, 189, 400, 403

See also pictures
IMAP accounts 129–135, 141
Inbox 73, 139, 168, 170
indicator light 21, 26
information

backing up 374, 387
draining battery and 29
entering 61, 62–67
performing hard resets and, caution 377
protecting 38, 328, 354, 356
restoring 374, 377
searching 316
sending 217, 220
setting input options for 352–354
sharing 322–323
storing on expansion cards 323, 326, 404
transferring from previous devices 374
updating 331

infrared port 24
infrared transmissions

defined 406

sending information over 218, 220, 337
troubleshooting 381

input options 67, 352–354
Insert Recording command 306
installation

Instant Messaging application 178
Media Player 42, 246
Outlook application 41
synchronization software 40, 41, 44, 46
third-party applications 318–321, 402
Treo smartphone 20
troubleshooting 377
VPN clients 366
WorldMate Pro 194

instant messages
sending 176, 178
setting community options for 182
setting up accounts for 179
signing in to 181

Instant Messaging application 178–182
instant messaging services 179
internal memory. See memory
international dialing preferences 101–102
international travel adapters 369
Internet connections

See also Web pages; Web sites
clearing browsing history for 193
closing 187
freeing internal memory and 403
making phone calls and 88
opening 184, 365
setting privacy settings for 191
setting up 116–118, 365
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setting up Wi-Fi. See Wi-Fi networks
troubleshooting 385, 400

Internet Explorer Mobile 22, 183–193, 400
Internet Information Server (IIS) 212
Internet Message Access Protocol. See IMAP 

accounts
Internet service providers 130, 132, 365, 398
Internet Sharing 115–118
intranets 208
IP Address option 214
IR port. See infrared port
ISPs. See Internet service providers
iTunes 195

K
Keep Backlight option 236
key indexes (Wi-Fi networks) 210
keyboard

accessing alternate characters on 64
dialing from 76, 77, 78
entering information with 61, 62–67, 354
entering passwords and 358
installing third-party applications and 402
locking 355, 356
looking up contacts from 77, 259
opening onscreen 67
scrolling with 55
selecting menu items from 59
sending email and 147
setting input options for 67, 352
setting key combinations for 348

keyboard backlight 62
Keyguard 355

Keypad 80
keys (Wi-Fi networks) 210
Kinoma FreePlay application 195–196
knowledge library 14

L
language options (Internet Mobile) 191, 192
lanyards 22
LEAP options 212
LED light 21, 26
Legacy files 283, 293
lens (camera) 24
Letter Recognizer 67, 352
libraries. See media libraries
Library command 249, 251
Library screen 251, 253
light conditions (camera) 232, 234
lighted display. See backlights
Li-Ion technology 406

See also battery
links

See also URLs
accessing media files and 251
accessing web pages and 186, 187, 188
creating 306
enabling notifications for 148
freeing internal memory and 403
selecting 145, 169, 307
sending 186
viewing documents and 139

lists
See also bulleted lists; numbered lists
closing 60
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scrolling through 55
selecting items in 60, 186

Live Mail. See Windows Live Mail
Live Messenger. See Windows Live 

Messenger
Live Search application 74, 197
Live Search bar 174
location information 201, 260, 360

See also travel information
Location Privacy option 99
lock codes 35
Lock icon on Web pages 184
locking

smartphone 354
the keyboard 355, 356
the touchscreen 88

long distance phone calls 101–102
looking up contacts 77, 144, 259

M
mail. See email
Map It command 261
maps 200, 400
Match case option 285, 302, 311
Match entire cells option 302
Match whole words option 286
measurement units 347
media file types 246
media files

accessing 251
adding to playlists 252
customizing Media Player for 253–254
displaying information about 252

playing 195, 246, 249–250
removing from device 227, 247, 251
removing from libraries 251
synchronizing 42, 226–228, 247–248
troubleshooting sync problems for 392
viewing 196

media libraries 247, 249, 251
Media Player. See Windows Media Player 

Mobile
meeting invitations. See meeting requests
meeting requests 142, 144, 154, 266, 270
memory

checking usage 70, 363
downloading email and 153
freeing 70, 322, 403
mapping to remote computers 329
synchronizing and 395

memos. See messages; notes
menus 58–59, 192
message formats (email) 151, 153
message headers 151, 153
messages

See also email; notes; voice notes
adding contact info from 142, 169
blocking 167
checking spelling in 138, 160
editing 146
filtering 145
inserting appointments in 163, 267
inserting contact information in 163, 262
inserting emoticons in 163, 177
saving as templates 164
selecting 170
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sending multimedia. See multimedia 
messages

sending text. See text messages
sending to multiple recipients 138, 177
viewing partially downloaded 140, 151
viewing status of 170
viewing unread 73, 170

Messaging application
opening chat sessions from 168
receiving email from 140, 175
receiving meeting requests from 154
searching messages from 145
sending email from 137, 143
sending multimedia messages from 161
sending text messages from 158
setting email options in 148–150
setting messaging options in 171–172
setting up email accounts for 125, 129
viewing messages from 166

Messaging button 23
messaging services 158, 179, 407
Metering mode (camera) 235
microphone 23, 88
microSD cards. See expansion cards
Microsoft operating systems. See Windows 

systems
Microsoft software. See specific application
Microsoft System Center Mobile Device 

Manager. See Mobile Device Manager
microUSB connector 22
MMS video mode 230
Mobile Broadband Network 406
Mobile Device Center 408

Mobile Device folder 290
Mobile Device Manager 161, 368, 406
Mobile Favorites folder 187
Mobile to Market certificates 319
Mobile view (Web pages) 185
modems 115, 116, 407
Month view (calendar) 263
mouthpiece 23
multimedia file types 161
multimedia messages

See also messages
checking for 73, 170
creating 161–164
deleting 170
downloading 166
forwarding 167
opening 166
replying to 167
selecting links in 169
sending 164
setting options for 171–172
setting priority 164
sorting 171
viewing information about 167

music
adding to playlists 252
adjusting volume 98
downloading 119
playing 249–250
receiving phone calls and 84
repeating current song 249
synchronizing 226, 228

music files 246
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See also media files
My Device folder 251, 317
My Documents folder 227, 282, 316
My Pictures folder 231, 233, 237
My Playlists folder 252
My Storage Card folder 251
My Text phrases 138, 159, 160, 163
My Treo application 14
My Videos folder 237

N
Name Servers option 214
names

See also user names
dialing by company 78
dialing by contact 77
finding contact 77, 144, 259
searching messages for 145, 261

naming
document files 284, 286, 288
email accounts 131, 133
pictures or videos 242, 243
workbooks 294, 303, 304
worksheets 299, 300

navigator. See 5-way navigator
Network Adapters options 213
network connections. See connections
network keys 210
networks 104, 366

See also Sprint National Network; Wi-Fi 
networks

New Appointment command 265
New Sound command 98

New Task command 271
No Service message 106
nonwireless features. See organizer features
notebook 305
notes

See also voice notes
adding contacts and 258
adding tasks and 271
correcting text in 306
deleting 276, 307
displaying 276
entering 273, 305
inserting pictures in 306
making phone calls and 81, 88
opening templates for 275
renaming 307
saving 275, 276
selecting links in 307
setting options for 276
sorting 307
viewing 83, 306

Notes application 273–276
Notes list 275
notifications

beaming and 220
closing 165, 166
connecting to Wi-Fi networks and 207, 

208, 213
receiving information and 218
receiving messages and 165, 166, 168
retrieving voicemail and 85
selecting links and 148
sending messages and 164
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setting options for 345
setting ringtones for 96–97
silencing sounds for 345
troubleshooting 385
turning on and off 86, 345

Now Playing playlist 252, 253
numbered lists 284, 287, 288, 306
numbers

See also phone numbers
copying 277
entering 63, 276
formatting 299, 347

O
Office files 190, 280–282, 392

See also specific Office application
offline synchronization 392
OK button 22
OneNote files 305
OneNote Mobile application 305–307
online address books. See address books; 

Global Address Lists
online support 14
onscreen keyboard 67
open authentication 209
Open Contact command 81
open networks (Wi-Fi) 205, 206–207
Open URL command 250
opening

applications 68, 69, 325
attachments 140, 168
calendar 263
chat sessions 168

Comm Manager 221
File Explorer 317
Internet connections 184
media libraries 249, 251, 253
multimedia messages 166
PDF files 308, 309
spreadsheets 293
synchronization software 47, 48
Task Manager 70
text messages 166

operating system (device) 374, 408
operator assistance (phone) 16
Option key 22
Option Lock 63
options 21, 60
Organize Slides command 165
organizer features 28, 33, 84
orientation options 239, 291
OTA synchronization 270
Outbox 170
outgoing mail options 134
Outlook

adding contacts and 258
copying addresses to 391
disabling online address books for 144
entering appointments and 264, 267
installing 41
retrieving mail and 125, 139, 141, 222
setting download options for 150–152
setting up client software for 399
synchronizing information and 41, 332, 

391
troubleshooting sync problems 374
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Outlook Mobile. See Messaging application
overdue tasks 272
owner information 358

P
Palm online support 14
Palm OS devices 374
Panorama mode 230, 233, 235
partnerships 216, 387, 407
pass codes 37
passkeys 216
Password type list 357
passwords

accessing accounts and 38
accessing information and 356
accessing voicemail and 37, 85
accessing WorldMate Pro and 194
changing 38
connecting to Exchange servers and 127
connecting to Wi-Fi networks and 205, 

212
dialing emergency numbers and 79
enabling voice commands and 349
entering 63, 358
forgetting 357, 358
formatting 357
locking device and 358
losing 357, 358
opening PDF files and 308
opening spreadsheets and 293
receiving email and 130, 132
saving 134
sending instant messages and 180

PCs. See computers
PDF files 308–311
personal identification numbers (PINs) 357
personal information 38, 356, 358
personal information managers 392, 407
phone

adjusting volume 36, 98
answering 83, 91, 103
connecting to Internet and 88
dialing 76–80
disabling touch-sensitivity for 355, 356
enabling voice commands for 350–352
getting assistance with 15, 16
getting forwarding codes for 90
getting started with 35
maximizing battery and 29
monitoring status of 106
personalizing 96–104
playing music and 84
running applications and 87, 88
setting ringtones for 96–97
silencing ringer for 84
troubleshooting 386, 404
turning on and off 34
unlocking touchscreen for 88
waking up screen for 87

Phone application 87, 221
Phone as Modem feature 115, 407
phone calls

ending 89
forwarding 90
holding 91
making 76–80, 165
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receiving 83–84, 91, 102
setting up conference 92
transferring to hands-free devices 95
transferring to voicemail 37, 84, 102, 103
viewing info about 81, 87
viewing recently dialed 79, 81

phone headsets
connecting to 94
losing connections 386
transferring calls to 96, 103
troubleshooting voice quality on 404

phone numbers
adding callback 171
adding to contacts 89, 169, 259
assigning to speed dial 92–93
blocking 172
copying and pasting 78, 80
dialing emergency 79, 354
dialing long distance 101–102
entering from keyboard 76, 77, 78
entering from Keypad 80
entering special characters in 86, 102
getting from online address books 144
locating device 36
redialing 79
saving 81, 89
selecting 77, 78, 79, 159

Phone/Talk button 22
photos. See pictures
Pics/Video Options command 172
picture files 161, 237

See also pictures; media files
Picture Message command 161

pictures
See also images
adding captions to 163
adjusting camera settings for 232, 235, 

236
assigning to contacts 98, 242, 258
copying 240
deleting 243
displaying as backgrounds 241, 342
displaying as screen savers 239
displaying grid for 236
displaying on Web pages 192, 240
downloading 189, 237
editing 242
inserting in notes 306
moving 240
renaming 242, 243
rotating 239, 242
saving 231, 232, 235, 236
sending 162, 177, 239–240
setting messaging options for 172
setting size 239
sorting 241
synchronizing 42, 226, 228
taking 231–233, 306, 401
troubleshooting sync problems for 392
viewing 237, 238, 307

Pictures & Videos application 237–243
Pictures folder 228
PIMs 392, 407
PINs 357
plain text messages (email) 151, 153, 154
Play Slide Show command 238
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Play Sound list 361
Playback screen 253
playing

media files 195, 246, 249–250
slide shows 167, 238, 239
video clips 246, 249, 253
voice notes 274, 307

playlists 247, 248, 252
plug-ins 183, 343
Plus Code Dialing option 101
Pocket Express 120–122
Pocket Word files 283
POP accounts 129–135
Post Office Protocol. See POP accounts
Power button 24
Power Save Mode 211
power settings 364
PowerPoint Mobile application 290–291
predefined text phrases 138, 159, 160, 163
preferences, setting. See customizing
Preferred language option 192
presentations. See PowerPoint Mobile; slides
priority settings 138, 160, 164, 271
privacy settings 99, 191, 268
processor 434
Program Files folder 326
programs. See applications; software
Programs screen 68, 69
proxy servers 367
punctuation marks 63

Q
Quick Menu 71, 72

Quick Settings screen 232, 234
Quick Tour 14, 73
QuickTime Player 246

R
radio 434
RAS connections 365
Receive all incoming beams option 221
Receiving Data message 220
recent calls list 79, 81
Record with Audio option 236
recording

sounds 98, 163, 345
videos 233–234
voice commands 349–350
voice notes 177, 274, 306

recurring appointments. See repeating 
appointments

redialing 79
redirectors (Web sites) 400
Refresh command 186
regional settings 220, 347
Reject call with text message option 104
reminders

adding to calendar 265, 269
adding to tasks 271, 273
repeating tones for 345
setting alarms for 361
silencing sounds for 345

remote connections 328–329, 365
Remote Desktop Mobile 328–329
Remove Programs list 322
Rename command 307, 327
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Rename/Move command 288, 303
repeating appointments 265
repeating tasks 271
Reset button 24
resets 357, 375–378
resolution 231, 232, 234, 321
restoring

factory settings 254
information 374, 377
Today screen settings 396

Review Duration option 236
Review screen (camera) 233, 234
ring styles 97
ringer 84, 98
Ringer switch 24, 344
ringtone file types 96
ringtones

assigning to contacts 98, 258
attaching to messages 161
downloading 96
selecting 96–97
silencing 343

roaming 104–106, 153, 335, 395
Roaming message 106

S
safety information 412
Save as Template command 164
Save Image As command 189
Save to Contacts command 78, 90, 242
Save to Contacts message 89
Save to Drafts command 160
Save to list 325

Save to Notes command 81
saving

attachments 150, 167
email 138
files 325
instant messages 180
notes 275, 276
passwords 134
phone numbers 81, 89
pictures 231, 232, 235, 236
playlists 253
spreadsheets 292, 293, 294, 303, 304
text messages 160, 165
videos 233, 234, 235, 236
voice notes 354
Word documents 283, 284, 285, 286, 289

scheduling synchronization 129, 334–335, 
395

screen saver 33, 34, 239, 364
screens

See also touchscreen
accessing options on 21, 60
closing 56
enabling Keyguard from 355
highlighting items on 56–57
scrolling in 55, 354
selecting items on 57
troubleshooting 347, 382–383

scripts 191
scrolling 55, 186, 354
SD cards. See expansion cards
searching

contacts 77, 144, 259
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documents 285–286
email messages 145
expansion cards 316
information 316
My Documents folder 316
PDF files 310–311
spreadsheets 302
Web sites 74, 197

secure networks (Wi-Fi) 205, 207–210
Secure Sockets Layers. See SSL encryption
security

accessing Bluetooth devices and 215, 216
accessing Web pages and 191
accessing Wi-Fi networks and 206, 209, 

212
exchanging information and 362
logging in to corporate servers and 366
opening spreadsheets and 293
protecting information and 354
selecting links and 148

security certificates. See certificates
security software 354
Select Messages command 170
self-timer setting 232
Send as vCalendar command 267
Send button 153
Send Link command 186
Send picture message by email 

command 262
Send Sound command 98
Send Text Message command 81
Send via SMS command 164

Send video message by email 
command 262

sending
attachments 155, 177, 239
contacts 163, 262
email 138, 152, 177, 186
error reports 363
information 217, 220
instant messages 176, 178
meeting requests 154, 270
multimedia messages 164
text messages 81, 83, 160, 164

Sensitivity options 268, 271
Sent folder 138, 149
service providers. See data service providers
Set as Today Background command 241
settings. See options
Setup Mode 46
shared authentication 209
Short Messaging Service. See SMS 

messages
shortcut menus 59
Show On Map command 260
Show Reminder option 236
Shuffle/Repeat command 249
shut-off settings (backlight) 62
Shutter Sound option 236
Side button 21
Sign Out command 181
signal strength 107, 383
signal-strength icon 34
signatures (email) 147

See also digital signatures
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silent alarm 344, 345
simple PIN passwords 357, 358
skins 253
slides

deleting 163, 165
displaying PowerPoint 290–291
inserting in messages 163, 165
organizing 164
playing 167, 238, 239

smartphone
accessing support for 14, 403
activating 32, 114
connecting to PCs 40
device compatibility with 94, 219
displaying owner information on 358
enabling as modem 115
getting user names for 115
locating phone number for 36
locking 354
moving information to 42
turning on or off 32, 364
unlocking 357

SMS messages 407
See also text messages

SMTP servers 398
soft resets 375–376
softkeys 21, 22, 58
software 20, 319, 406

See also applications; synchronization 
software

songs. See music
sorting

files 317

messages 171
notes 276, 307
pictures or videos 241
spreadsheets 300
tasks 272

sound clips 161
sounds

See also specific system sound
deleting 346
playing from Web pages 192
previewing 345
recording 98, 163, 345
sending 98, 163
setting alarm 361
silencing 84
turning on and off 343–346

Sounds & Notifications screen 96, 344
speaker 23
speakerphone 88, 404
special characters 63, 64, 294
specifications 94, 434
speed dialing 78, 92–93
spell checking 138, 160, 288
Sports mode 230, 233
spreadsheet files 293, 304
spreadsheet toolbar 295
spreadsheets

adding borders to 299
adding charts to 293, 301–302
adding range of values to 298
adding worksheets to 299
creating 294
deleting items in 303–304
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displaying 293, 295
editing 292, 293
entering formulas in 292, 296, 304
entering functions in 292, 297
filtering values in 301
formatting 292, 299–300
hiding items in 293, 300
inserting cells, rows or columns in 298
locking rows or columns in 295
opening 293
organizing workbooks in 303
referencing items in 293, 296, 299
renaming worksheets 300
saving 292, 293, 294, 303, 304
searching 302
setting default template for 304
setting row or column size in 299, 300
sorting values in 300

Sprint Customer Service 14, 15
Sprint Music Store 119–120
Sprint National Network 116
Sprint Navigation application 200–201
Sprint Operator Services 16
Sprint service plans. See accounts; data 

services
Sprint Software Store 319
Sprint TV 118
Sprite Backup utility 49, 377
SSIDs 208, 407
SSL encryption 134, 187
Start menu 21, 68, 348
stereo headsets 94, 246
strong alphanumeric passwords 357, 358

stylus 24, 369
symbols 63, 64, 294

See also alternate characters
Sync Mode 46
synchronization

changing options for 128
checking status of 49
defined 407
disabling online address books for 144
enabling IR port for 337
fixing conflicts 128
getting started with 39, 40
receiving email and 139, 174, 175
restoring information and 377
scheduling 129, 334–335, 395
selecting specific applications for 41, 42, 

338
setting up Bluetooth devices for 336–337
setting up Exchange servers for 125, 332–

334
setting up PCs for 40, 44–46, 337
starting 48, 247, 335
stopping 339
transferring media files and 226–228, 

247–248
transferring Office files and 280–282
troubleshooting 227, 387–396, 398, 399
updating system information and 360

synchronization software
installing 40, 41, 44, 46
opening 47, 48
troubleshooting 374, 388, 395

system errors 384
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system password locks 356–358
system requirements 437
system settings 359–364
system sounds. See sounds

T
tabs 55
taking pictures 231–233, 306, 401
tapping 345, 347, 382
Task Manager 70
tasks

adding 270–271
deleting 272
displaying 272
marking as completed 271, 272
prioritizing 271
sending 163
setting options for 272–273
setting reminders for 271, 273

Tasks application 270–273
Tasks entry bar 273
Tasks list 272, 273
Tasks Over The Air. See OTA synchronization
TDD devices. See TTY/TDD devices
technical support 374, 403
telecommunications devices. See TTY/TDD 

devices
templates 164, 275, 285, 294
Temporal Key Integrity Protocol. See TKIP 

encryption
temporary files 193
text

aligning 287, 299

checking spelling 138, 160, 288
copying and pasting 190, 286
deleting 57
editing 146, 306
entering 62, 67, 353
finding and replacing 285, 310
formatting 287, 305
highlighting 57
indenting 287, 288
inserting predefined 138, 159, 160, 163
moving through 55, 56
resizing 185, 346
searching for 145, 316
setting default size 354
setting input options for 67, 352–354

text files 362
Text Layout command 164
text messages

See also messages
adding attachments 160
checking for 73, 170
creating 103, 158–160
deleting 165, 170
including callback numbers in 171
making phone calls and 78, 84
opening 166
replying to 165
saving 160, 165
selecting links in 169
sending 81, 83, 160, 164
setting options for 171–172
setting priority 160
sorting 171
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troubleshooting 385
verifying addresses for 159

text telephone devices. See TTY/TDD devices
third-party applications

5-way navigator and 54
accessing Outlook folders and 391
backing up information and 377
compatibility with 318, 321, 402
freeing internal memory and 403
getting help with 321, 403
installing 318–321, 402
losing 377
purchasing 321
synchronizing with 42
taking pictures and 401
troubleshooting 402

Thumbnail View 241
time 347, 359, 360
time stamps 235, 236
time zones 359, 360
timer 232
TKIP encryption 209
Today screen

accessing 73, 76
changing color settings for 342
customizing 342–343
enabling Bluetooth from 215
enabling Comm Manager from 221
enabling Keyguard from 355
enabling Windows Live services for 174
managing accounts from 15
removing Live Search bar from 174
restoring 396

retrieving voicemail from 85, 86
searching Web sites from 197
selecting items on 73
setting backgrounds for 241, 342
setting which items appear on 343
troubleshooting 396
viewing battery status on 27, 28
viewing messages on 166, 167
viewing Wi-Fi status on 206

tones. See ringtones; sounds
touch sensitivity 355, 356
touchscreen 22, 33, 54, 347
touchscreen backlight 62, 364
touchscreen lockout 88, 356
traffic information 200
Transcriber 67, 353
Transparency Level list 241
travel information 194, 200
troubleshooting 374
trusted devices. See partnerships
TTY/TDD devices 99–100

U
unauthorized users 37, 38, 362
unavailable time slots 268
Undo command 306
unlocking

device 357
touchscreen 88

untimed events 264
Update Profile option 114
updating

information 331
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media libraries 251
operating system 374
Pocket Express 122

URLs 148, 169
See also links

USB cables 22, 48
USB connections, troubleshooting 388, 389
USB hubs 46, 390
USB ports 46, 116
Use network time zone setting 360, 361
user names 38, 114, 212, 407

V
vCalendar attachments 164, 267, 399
vCard attachments 164, 399
vibrating alarm 344, 345
video files 161, 237, 246

See also videos; media files
Video Message command 161
Video mode 230
videos

adjusting camera settings for 234
adjusting volume 98
copying 240
deleting 243
downloading 246
entering captions for 163
moving 240
playing 246, 253
recording 233–234
renaming 242, 243
repeating current 249
saving 233, 234, 235, 236

sending 162, 239–240
setting messaging options for 172
sorting 241
synchronizing 42, 226, 228
troubleshooting sync problems for 392
viewing 237

View All Calls command 81
View command 185
View Note command 83
View Recording Toolbar command 274
virtual private networks. See VPN connections
Vista computers. See Windows systems
voice commands 349–352
voice notes

playing 274, 307
recording 177, 274, 306
saving 354

voice quality 404
voice recording formats 354
voicemail

accessing 86
creating pass codes for 37
retrieving 85
sending calls to 84, 102, 103
setting ringtones for 97
setting up 37, 85

voicemail beacon 103
volume 36, 98
Volume button 21
VPN connections

downloading attachments and 141
receiving email over 124, 139, 152
setting up 366–367
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synchronizing over 387
troubleshooting 391

W
waking up screen 33
weak signals 383
Web addresses. See URLs
Web browsers 42, 187

See also Internet Explorer Mobile
Web favorites

creating 187, 188
organizing 188–189
sending 163
synchronizing 42, 187
viewing 188

Web links. See links
Web pages

accessing 115, 183, 184
bookmarking 187, 188
clearing History lists for 193
copying text from 190
displaying pictures on 192, 240
downloading from 189, 320
entering information on 400
making phone calls and 78
opening History lists for 190
opening specific 184, 186
personalizing 120
refreshing 186
returning to recently viewed 185, 187, 190
scrolling in 186
sending email from 186
setting as home 190

troubleshooting 400
viewing 184, 185
working with forms on 187

Web sites
accessing over proxy servers 367
accessing secure 184, 187, 400
browsing 115, 204, 403
clearing browsing history for 193
enabling sounds for 192
playing media files from 250
searching 74, 197
setting display options for 192
setting language options for 191, 192
setting security options for 191

Week view (calendar) 263
WEP encryption 206, 209
Whole word option 311
Wi-Fi access points 407
Wi-Fi button 24
Wi-Fi networks

accessing multiple 206
checking for available 206, 211
clearing settings for 211
configuring secure 208
customizing settings for 211–214
disconnecting from 210
enabling or disabling connections to 205, 

211, 213, 222
enabling services for 207
making phone calls and 88
selecting 206, 207
setting default connection type for 213
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setting up connections to 204, 205, 206–
210

troubleshooting connections to 385, 400
Windows Live Mail 173–175
Windows Live Messenger 175, 176–177
Windows Live Search. See Live Search 

application
Windows Live services 173, 174

See also specific program
Windows Media Player Mobile 42, 246–254
Windows Mobile 374, 408
Windows Mobile Device Center. See Mobile 

Device Center
Windows systems

installing sync software for 44–48
playing media files and 246
synchronizing over 40, 280–282
transferring media and 226, 228
troubleshooting sync problems 374, 389, 

393
Wired Equivalent Privacy. See WEP encryption
wired headsets 96
wireless features 28, 84, 402
wireless modems 116
wireless networks 34, 204, 222, 383

See also Wi-Fi networks
wireless service indicator 73
wireless services 204, 214, 221

wireless settings 213
WLANs. See wireless networks
Word Completion options 353
Word files 283, 284
Word Mobile application 283–289

See also documents
workbook list 304

See also spreadsheets
worksheets. See spreadsheets
WorldMate Pro software 193–194
WorldMate Professional services 194
WPA authentication 209

Y
Year view (calendar) 263
YouTube videos 195

Z
ZIP files 318, 319, 320
zooming

PDF files 310
pictures 232, 307
PowerPoint slides 291
spreadsheets 293, 295
videos 234
Web pages 185
Word documents 286




